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Specialized Guides Overview

HH:'5.0'
This book contains a list of special topics and functionalities of SUSE Manager.

It is designed to introduce basic, routine or some advanced tasks, by explaining what you are achieving
in each step, and the various options available to you along the way.

You can read specialized guides for:

e Specialized-guides > Public-cloud-guide
e Specialized-guides > Salt
e Specialized-guides > Large-deployments

e Specialized-guides > Qs-sap

st g 50



Chapter 1. Public Cloud Guide

Updated: 2024-11-18

This guide shows you the fastest way to get SUSE Manager up and running in a public cloud environment
using on-demand, Pay-as-you-go (PAYG), or BYOS services. Additionally, it assumes that you are
installing the SUSE Manager Server on a single cloud instance. These procedures have been tested on
Amazon Web Services, Microsoft Azure, and Google Cloud Compute.

o Pay-as-you-go or PAYG services currently work on both Amazon Web Services and
Microsoft Azure.

For more information on using SUSE Manager, see the official SUSE Manager documentation at
https://documentation.suse.com/suma.

1.1. BYOS Guide

1.1.1. Bring your own subscription (BYOS)

Bring-your-own-subscription (BYOS) images are useful if you already have a support contract with SUSE
and want to move your workloads to the public cloud. An instance launched from a BYOS image is
equivalent to a physical machine that just received a SUSE Linux Enterprise Server installation from the
SUSE Linux Enterprise Server installation image.

After creation:

e use registercloudguest to register the instance with the SUSE-operated update infrastructure in the
cloud framework, or

e use the command SUSEConnect to register the system with SUSE Customer Center using the
entitlements you already have.

Connect your system to your own running RMT or SUSE Manager infrastructure in the same way you
connect systems in your data center.

BYOS instances make it easier to manage extensions such as LTSS or kernel live-patching. Extensions
for PAYG instances can only be used in conjunction with SUSE Manager.

1.1.2. Initial setup

This guide shows you the fastest way to get SUSE Manager up and running in a public cloud using on-
demand or BYOS services. We have tested using SUSE Manager on Amazon EC2, Google Compute
Engine, and Microsoft Azure, but these procedures should work with other public cloud providers as
well, with some variation.

There are three main methods of using SUSE Manager on a public cloud service.
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Bring your own subscription (BYOS)

Most public cloud providers make a BYOS image of SUSE Manager available. This means you do not
need to install SUSE Manager, just set up the server. You will need to have SUSE product
entitlements before you begin, and there are some additional setup steps required. The public cloud
documentation in the SUSE Manager documentation suite assumes you are using this method.

Virtual machine on public cloud

In this method, you subscribe to a public cloud service, and install SUSE Manager in a virtual
machine, using the Unified Installer. You will need to have SUSE product entitlements before you
begin. You can do this by following all the same instructions as you would for any local SUSE
Manager installation.

On-demand SUSE Linux Enterprise Server pay as you go (PAYG) image

Most public cloud providers make SUSE Linux Enterprise Server available as a BYOS image. This
means that SUSE Linux Enterprise Server is pre-installed, and you can install SUSE Manager on top,
using the Unified Installer. You can do this by following all the same instructions as you would for
any local SUSE Manager installation. You will need to have SUSE product entitlements before you
begin. Be careful with this method, because you might end up requiring additional product
entitlements that could drive up your costs.

If you are using the BYOS method, start by logging in to your chosen public cloud provider, and
launching a SUSE Manager instance. Depending on the public cloud you are using, you can usually
locate the SUSE Manager Server BYOS images by searching for suse manager. In EC2, you need to search

within the Community AMIs. In GCE and Azure, search the marketplace.

Select a public cloud instance type that meets the hardware and networking requirements in
Installation-and-upgrade > Pubcloud-requirements.

When you have your virtual machine ready, and the BYOS image installed, you need to set up SUSE
Manager. This is done in the same way as a local installation, using YaST. When you have completed

SUSE Manager setup, you need to activate the public cloud module. You can then complete setup in the
SUSE Manager Web Ul.

1.1.3. Register clients

When you have your SUSE Manager Server set up, you are ready to start registering clients.

For instructions on registering clients on a public cloud, see Client-configuration > Clients-pubcloud.
For instructions on connecting PAYG instances, see Installation-and-upgrade » Connect-payg.

1.1.3.1. Additional Resources

For more information on using SUSE products in the public cloud see: SUSE Linux Enterprise Public
Cloud Guide.

For more SUSE Manager product documentation, see https://documentation.suse.com/suma.

To raise an issue or propose a change to the documentation, use the links under the Resources menu on
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the documentation site.

1.2. PAYG Guide

1.2.1. PAYG Overview

PAYG does not require a long-term subscription. Users can leverage the images of SUSE Manager on a
Pay-as-you-go basis, paying only for the time of use, and the number of managed and monitored
systems. PAYG with SUSE Manager is an optimal solution for those seeking control, convenience, and
cost savings when managing and monitoring their infrastructure on AWS, Azure, and GCP. :keywords:
Payg, Pay-as-you-go, AWS, Amazon Web Services, Azure, GCP, Google Cloud Compute, cost-effective,
scaling, Cloud Services, SUSE Manager, Monitoring

1.2.1.1. Introduction to PAYG

SUSE Manager PAYG or Pay-as-you-go is a flexible and cost-effective solution that allows users to
manage and monitor their systems from several cloud services. PAYG does not require a long-term
subscription through the SUSE Customer Center. Users can leverage images of SUSE Manager on a Pay-
as-you-go basis, paying only for the time of use, and the number of managed and monitored systems.

PAYG with SUSE Manager is an optimal solution for those seeking control, convenience, and cost savings
when managing and monitoring their infrastructure on Amazon Web Services, Microsoft Azure, and
Google Cloud Compute.

1.2.1.2. Benefits of Using PAYG

The SUSE Manager PAYG instance offers a flexible solution tailored to the modern business landscape.
Key benefits include:

o Cost Efficiency: Pay only for what you use, aligning costs with the actual system management
needs.

o No Subscription Required: Eliminate the need for ongoing commitments or long-term
subscriptions, allowing for budget flexibility.

o Ease of Use: Utilize SUSE Manager’ s powerful features on a PAYG or Pay-as-you-go basis,
streamlining initial setup and ongoing systems management.

o Scalability: Easily scale the number of systems managed according to your requirements, without
worrying about subscription limitations.

o Rapid Deployment: Quickly run the image of your choice and begin managing your systems,
enhancing responsiveness to your needs.

o Integration with Cloud Services: Leverage SUSE Manager PAYG on AWS, Microsoft Azure, or GCP
taking advantage of cloud infrastructure for an agile systems management experience.

1.2.2. PAYG Limitations

1.2.2.1. Onboarded BYOS Instances without SCC Credentials

Valid SUSE Customer Center credentials are needed to manage Bring-your-own-subscription (BYOS)
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instances of SUSE products in SUSE Manager PAYG. This applies to all SUSE products except SUSE
Manager Proxy BYOS. Without any SCC credentials, SUSE Manager PAYG will not allow onboarding any of
the mentioned BYOS instances. The user will get an error.

There is a possibility that the user has valid SCC credentials set with already synced-up channels and the
BYOS onboarded, but at some point decides to delete those credentials.

In the scenario of having already onboarded BYOS instances but no SCC credentials set, the following
restrictions apply:

e A warning message will be shown to the user to let them know that they will not be able to manage
those instances.

o Non-compliant BYOS instances will not be able to be managed neither through Salt or Salt-SSH. This
applies to individual server management, SSM and action-chains. When dealing with several servers
at once, as long as there is one non-compliant BYOS instance among them, the entire action/action-
chain will be aborted for all servers.

o Non-compliant BYOS instances will not be able to access any repository hosted in SUSE Manager
PAYG as long as SCC credentials are not set. SUSE Manager PAYG will return HTTP 401 Unauthorized
until the situation is amended, that is trying to install or upgrade packages using zypper from those
machines directly will not work.

1.2.3. PAYG on AWS

1.2.3.1. AWS System Requirements

When setting up a SUSE Manager PAYG instance on AWS, it" s essential to consider system requirements
for optimal performance and functionality. The default requirements outlined below have been tailored
for smooth deployment and operation.

H 1. AWS System Requirements

Requirement Details

root storage 100 GB

spacewalk storage 500 GB

database storage 80 GB

CPU 4 cores; Use the m5a, m5i, m6a, m6i systems or
newer

Memory 32 GB (minimum 16 GB)

Network Configuration Typically configured by your organization

1.2.3.2. Obtaining the SUSE Manager Server PAYG public cloud image on AWS

Follow these step-by-step instructions to locate the SUSE Manager '5.0' PAYG image on AWS. You can
also review the latest available images for the public cloud using Pint (Public Cloud Information
Tracker).
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See: pint.suse.com

Procedure: Obtaining the SUSE Manager PAYG image on AWS

=

. Inyour browser navigate to the AWS Management Console.
. Enter your AWS credentials and login.
. From the AWS Management Console dashboard, locate the Services dropdown.

. From the menu select EC2 under the Compute section.

o A w N

. In the EC2 dashboard, in the main content section, you’ Il find the [ Launch Instance ] button. Click
it.

From the Choose an Amazon Machine Image (AMI) page. Select Browse more AMIs

1. Search for SUSE Manager
2. Depending on your location select your AMI image.

O SUSE Manager Server Family (EU and UK only)

©  SUSE Manager Server Family (non-EU and non-UK-only).
3. Click [ Select].

4. Proceed for image configuration.

1.2.3.3. Initial Preparation and Configuration of the AWS Image

This section covers initial preparation and configuration of the image on AWS.

1.2.3.3.1. The IAM Role

To ensure seamless operation, proper AWS permissions for the IAM (Identity and Access Management)
role are essential. This role must be attached to the instance, otherwise disconnection errors will be
thrown after one hour.

You can pre-create the role on your AWS account and then select it from the existing [ IAM role ] drop-
down during the instance configuration process.

If you create the role during the creation of an instance, the role will not be attached automatically. The
role should be added post setup.

A role can be assigned to a running instance through the following steps: Actions » Security » Modify

IAM-role. It needs to have the following policy attached in order to be used:

{
"AttachedPolicies": [

"PolicyName": "AWSMarketplaceMeteringFullAccess", _
"PolicyArn": "arn:aws:iam::aws:policy/AWSMarketplaceMeteringFullAccess"
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To allow the EC2 service to assume such role:

"AssumeRolePolicyDocument": {
"Version": "2012-10-17",
"S{tatement": [
"Effect": "Allow",
"Principal": {
"Service": "ec2.amazonaws.com"

"Action”: "sts:AssumeRole"

o IAM role can be attached to an EC2 instance by means of an instance profile, which
acts as a container for the role itself.

For detailed information on IAM roles, see: docs.aws.amazon.com/IAM

1.2.3.3.2. Configure SUSE Manager Instance

Procedure: Configuring your SUSE Manager instance

1. Select the AMI image and provide a meaningful name for your server. Review the details and pricing
information provided.

2. You have the option to configure additional instance details in subsequent steps, such as storage,
tags, security groups, and the required 1AM role.

a. The image automatically suggests a default CPU configuration.
b. Choose an existing key pair or create a new one to grant access to the instance.
c. Your organization should provide the necessary security groups and network configuration.

d. If an IAM role has been previously created, you can attach it by selecting it from the existing IAM
role drop-down. Otherwise, attach this role after the instance has been launched.

e. Create the following partitions
B 100 GB for the root partition
® 500 GB for spacewalk storage
¥ 80 GB for the database.

For more information see: AWS requirements

f. Follow the prompts from AWS to complete the configuration as needed.
3. After reviewing your configuration click the [ Launch instance ] dropdown.
4, Click on the [ Launch Instances ] button.

5. You will be redirected to the EC2 Dashboard.

6. Verify that the instance has successfully launched by selecting Instances on the left sidebar. The
SUSE Manager PAYG instance should be running in the main content area.
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Usage and Costs

Because this is a PAYG image, you will be billed according to your actual usage,

o including the number of systems you manage and monitor with this instance. It is
essential to regularly track and review your usage to prevent unexpected costs and
ensure alignment with your needs.

1.2.3.4. Initial setup

Procedure: Login and update the system
1. SSH into your AWS instance.

2. Switch to the root user and update the system.

sudo -i
transactional-update

3. Reboot the system.
4. Configure storage with the mgr-storage-server tool or in the case of the proxy use mgr-storage-proxy.

O For more information, see mgr-storage-server --help ormgr-storage-proxy --help.

This tool simplifies creating the container storage and database volumes.

1. Format the command in the following manner:

mgr-storage-server <storage-disk-device> [<database-disk-device>]
#For example:

mgr-storage-server /dev/nvmelnl /dev/nvme2nl

This command will create the following persistent storage volumes at
o /var/lib/containers/storage/volumes:

For more information, see Installation-and-upgrade > Container-management.
2. Runmgradm install podman <FQDN> as root.

1.2.3.5. SUSE Manager PAYG WebUI setup

1.2.3.5.1. Requirements

SUSE Manager must be setup and running on AWS. For more information on finding and setting up SUSE
Manager, see Specialized-guides > Public-cloud-guide.
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The instance-flavor-check tool and PAYG schedule check

instance-flavor-check Tool

The instance-flavor-check tool is an essential component that comes pre-
installed by default. Its presence is crucial, as it determines the status of PAYG
instances. When invoked, this tool identifies and categorizes the system as a
PAYG instance. By default this tool is configured to run on a schedule named
o update-payg-default.
update-payg-default schedule task

Navigate to the Admin > Task Schedules to find the update-payg-default task.
By default, this task is set to run at 10-minute intervals. Its primary function is to
monitor the presence of all running PAYG instances by executing the instance-
flavor-check tool.

1.2.3.5.2. Login to the Webui

Procedure: Login
Login to the SUSE Manager Server WebUI. The username is admin the password will be the Instance ID

on AWS EC2.

1. Select Admin > Setup Wizard.

1.2.3.5.3. Configure the PAYG credentials and product list

On a new server, the organization credentials table is listed at Admin > Setup Wizard

o » Organization Credentials. The Products table listed under Admin > Setup Wizard »
Products will be empty.

Procedure: Verify credentials for PAYG and refreshing the product list

1. On your new server navigate to the Admin > Setup Wizard > Pay-as-you-go tab to view and manage
PAYG credentials. Localhost should provide the description SUSE Manager Pay-as-you-go and the
status should read Credentials successfully updated.

2. Navigate to the Admin > Products tab and click [ Refresh ].
3. Once the refresh completes the following products are listed:
©  SUSE Manager Proxy
©  SUSE Manager Server

O Free products
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1.2. PAYG Guide

Ubuntu and Debian

Ubuntu and Debian are not currently supported by our RMT servers.

Red Hat Linux Enterprise Clients

SUSE Manager offers support for Red Hat Enterprise Linux clients; however it is
important to note that content still needs to be added manually and is not available
through the cloud-based RMT service.

For more information see: Client-configuration » Registration-overview-redhat.

1.2.3.6. PAYG Client connections and Client Registration

1.2.3.6.1. Managing connections and registering PAYG and BYOS images

PAYG (Pay-As-You-Go) Images

Connecting and registering PAYG images is supported and can be done without additional
prerequisites.

BYOS (Bring Your Own Subscription) Images

Registering BYOS images requires SCC (SUSE Customer Center) credentials beforehand. If a user
attempts to onboard a BYOS image without providing SCC credentials, the operation will fail, as
these credentials are required to verify your subscription.

o Always verify the type of image (PAYG or BYOS) prior to initiating the registration
process with SUSE Manager to ensure a smooth and error-free connection.

o If you have SCC credentials ensure your SCC credentials are valid and have the
necessary permissions for utilizing BYOS images.

o Do not register PAYG instances with the SUSE Customer Center. Only BYOS instances
should be registered against the SUSE Customer Center.

Registering PAYG instances with the SUSE Customer Center or your own RMT
server will create conflicts that are not easily solved. PAYG instances are
automatically registered against the correct update server when added to your cloud
service provider SUSE Manager instance.

1.2.3.6.2. Starting up additional PAYG SUSE products in AWS

For more information on using SUSE PAYG products such as SUSE Linux Enterprise in the public cloud
see: SUSE Linux Enterprise Public Cloud Guide

1.2.3.6.3. Establishing a PAYG SUSE Linux Enterprise connection with SUSE Manager
PAYG
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It is important to recognize that there is a difference between Pay-as-you-go
connections and bootstrapping. Bootstrapping is also known as client
registration.

Once you have started up your SUSE Manager PAYG instance and refreshed products

you can add Pay-as-you-go connections via the Admin > Setup Wizard > Pay-as-

you-go [ +Add Pay-as-you-go ] button. This action links your SUSE Manager PAYG
o instance with additional PAYG products on AWS.

Bootstrapping or client registration is the process of onboarding clients in SUSE
Manager. The registration process installs the appropriate client tools and provides
full management functionality.

To manage your clients, start by establishing connections and then proceed to
bootstrap your clients. These two actions are the steps required for initiating and
completing the client onboarding process.

Procedure: Connecting SUSE Linux Enterprise PAYG instances to SUSE
Manager PAYG

1. Return to the SUSE Manager Server WebUI.
2. Navigate to Admin » Setup Wizard » Pay-as-you-go and click the [ +Add Pay-as-you-go ] button.
3. Add a description.
4. Complete the instance SSH connection data:
O Host: CSP URL of the machine
©  SSH Port: 22
O User: root
O Password: <password>
O SSH Private Key
5. Click [ Create ] and wait for the sync to finish.

6. Proceed to Admin » Setup Wizard > Products to access your PAYG SUSE Linux Enterprise products.

1.2.3.6.4. Registering Clients

Now that you have established connections to the SUSE Manager PAYG instance you can register them
as clients. To learn how to register various clients see: Client-configuration > Registration-methods

1.2.4. PAYG on Azure

1.2.4.1. Azure System Requirements

When setting up a SUSE Manager PAYG instance on Microsoft Azure, it’ s essential to consider system
requirements for optimal performance and functionality. The default requirements outlined below have
been tailored for smooth deployment and operation.
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By default, certain disks are automatically generated when establishing a SUSE Manager PAYG instance
on Microsoft Azure. To complete the setup of these disks, use the mgr-storage-server tool.

H 2. Azure System Requirements

Requirement Details

root storage 100 GB

spacewalk storage 500 GB

database storage 80 GB

CPU 4 cores

Memory 32 GB (minimum 16 GB)

Network Configuration Typically configured by your organization

1.2.4.2. Obtaining the SUSE Manager Server PAYG public cloud image on
Microsoft Azure

Follow these step-by-step instructions to locate the SUSE Manager '5.0' PAYG image on Microsoft Azure.
You can also review the latest available images for the public cloud using Pint (Public Cloud Information
Tracker).

See: pint.suse.com
There are currently two offers for SUSE Manager PAYG on Microsoft Azure:

o SUSE Manager '5.0' with 24x7 Support ltd
o SUSE Manager '5.0' with 24x7 Support llc

Procedure: Obtaining the SUSE Manager PAYG image on Microsoft Azure
1. Start by logging into your Azure account at Azure Portal.

2. Once logged in, navigate to the Virtual Machines section. This can be found in the dashboard or by
using the search bar at the top of the Azure Portal.

3. Click on Create a Virtual Machine. Here, you will be asked to fill in details such as the subscription,
resource group, and virtual machine name.

4. During the creation of a virtual machine there is an option for Image. Select the correct cloud image
for your VM.

5. If you don’ t find the image you need, you can browse the Azure Marketplace. Click on See all
images or go to the Marketplace and search for the image you need.

6. After selecting your image, continue with the configuration of your virtual machine. Review all
settings, and then create your VM.
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1.2.4.3. Initial Preparation and Configuration of the Microsoft Azure Image

This section covers initial preparation and configuration of the image on Microsoft Azure.

Procedure: Configuring your SUSE Manager instance

10.

. Start by logging into your Azure account at Azure Portal.

. In the Azure Portal, find the menu:[Virtual Machines] section. This can be done either through the

dashboard or by using the search bar.

. Select menu:[Create a resource] in the top left corner of the portal.

. Choose menu:[Compute] and then select menu:[Virtual Machine].

. You will be guided through the Create a virtual machine process.

. Fill in the required details such as subscription, resource group, and VM name.

. Choose a region for your VM. Ensure it complies with any geo-fencing policies you might have.

. In the Image dropdown, select the SUSE Manager '5.0' with 24x7 Support ltd or the SUSE

Manager '5.0" with 24x7 Support llc image for your VM. If the image is not listed, select Browse all
public and private images to find the required image.

. Suggested sizes are selected by default for this VM. Configure optional features such as virtual CPUs,

memory as required.

Set up an administrator account for the VM. This can be a username and SSH public key.

Ensure the VM is connected to the appropriate virtual network (VNet) and subnet, especially if it needs to
communicate with other specific services like SUSE Manager. For network requirements, see
Specialized-guides > Public-cloud-guide.

1

2.
3.

4.

Configure additional settings such as storage, monitoring, or any extensions you may need. The
following partitions are created by default when initializing the Microsoft Azure image:

© 100 GB for the root partition

© 500 GB for spacewalk storage

O 80 GB for the database.

Once all configurations are set, review the settings.
Click "Create" to deploy your VM.

After the VM is deployed, you can access it via SSH.

Usage and Costs

Keep in mind that since this is a PAYG image, you will be billed according to your

o actual usage, including the number of systems you manage and monitor with this
instance. I’ s essential to regularly track and review your usage to prevent
unexpected costs and ensure alignment with your needs.
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1.2.4.4. Initial setup

Procedure: Login and update the system
1. SSH into your Microsoft Azure instance.
2. Switch to the root user and update the system.
sudo -i

zypper refresh
zypper update

1.2.4.4.1. Network Configuration

For SUSE Manager PAYG setup it is required, that a new Virtual Network and a new subnet is configured.
It is impossible to setup the instance in an existing network. When you setup new clients which should
be managed, take care that you put them into the private subnet which is configured with SUSE Manager
PAYG.

o If you want to manage systems in an already existing network, you must configure
peering.

Procedure: Network Configuration
1. Ensure the network configuration aligns such that hostname -f yields the identical name as the

reverse DNS lookup of the private IP address. For instance, when executing nslookup 10.0.0.X.

Insert the private IP with its Fully Qualified Domain Name (FQDN) into /etc/hosts. For example:
10.0.0.4 instancename.internal.cloudapp.net

1. Edit /etc/sysconfig/network/config and append internal.cloudapp.net to
NETCONFIG_DNS_STATIC_SEARCHLIST.
2. Execute netconfig update.

3. Subsequently, hostname -f should return the same FQDN as obtained from nslookup 10.0.0.X.

When adding new virtual machines (VMs), such as SUSE Linux Enterprise Server 15
SP5, it’ s crucial to ensure that they are configured within the same subnet as the
SUSE Manager instance. This step is essential for successful network setup and

o integration.

Additionally, be mindful of the geographical restrictions associated with your plans.
Make sure to utilize the appropriate Azure accounts which correspond to the specific
geographic zones of your project.

1.2.4.4.2. Configure Storage

1. SSH into your Microsoft Azure instance.

2. Switch to the root user and update the system.
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sudo -i
transactional-update

3. Reboot the system.

Configure storage with the mgr-storage-server tool or in the case of the proxy use mgr-storage-proxy. For
more information, see mgr-storage-server --help or mgr-storage-proxy --help. This tool simplifies
creating the container storage and database volumes.

1. Format the command in the following manner:

mgr-storage-server <storage-disk-device> [<database-disk-device>]
#For example:

mgr-storage-server /dev/nvmelnl /dev/nvme2nl

This command will create the following persistent storage volumes at
o /var/1lib/containers/storage/volumes:

For more information, see Installation-and-upgrade > Container-management.

2. Asroot runmgradm install podman <FQDN>to deploy.

1.2.4.5. SUSE Manager PAYG WebUI setup

1.2.4.5.1. Requirements

SUSE Manager must be setup and running on Microsoft Azure. For more information on finding and
setting up SUSE Manager, see Specialized-guides > Public-cloud-guide.

The instance-flavor-check tool and PAYG schedule check

instance-flavor-check Tool

The instance-flavor-check tool is an essential component that comes pre-

installed by default. Its presence is crucial, as it determines the status of PAYG

instances. When invoked, this tool identifies and categorizes the system as a

PAYG instance. By default this tool is configured to run on a schedule named
o update-payg-default.

update-payg-default schedule task

Navigate to the Admin > Task Schedules to find the update-payg-default task.
By default, this task is set to run at 10-minute intervals. Its primary function is to
monitor the presence of all running PAYG instances by executing the instance-
flavor-check tool.
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1.2. PAYG Guide

1.2.4.5.2. Login to the Webui

Procedure: Login

1. Login to the SUSE Manager Server Web Ul. The username is admin while the password is the name of
the instance with -suma appended. When the name of the instance is suma-payg-mycompany, the
password is suma-payg-mycompany-suma.

2. Select Admin > Setup Wizard.

1.2.4.5.3. Configure the PAYG credentials and product list

On a new server, the organization credentials table is listed at Admin > Setup Wizard

0 » Organization Credentials. The Products table listed under Admin > Setup Wizard »
Products will be empty.

Procedure: Verify credentials for PAYG and refreshing the product list

1. On your new server navigate to the Admin > Setup Wizard > Pay-as-you-go tab to view and manage
PAYG credentials. Localhost should provide the description SUSE Manager Pay-as-you-go and the
status should read Credentials successfully updated.

2. Navigate to the Admin > Products tab and click [ Refresh ].
3. Once the refresh completes the following products are listed:
©  SUSE Manager Proxy
© SUSE Manager Server

O Free products

Ubuntu and Debian

Ubuntu and Debian are not currently supported by our RMT servers.

o Red Hat Linux Enterprise Clients

SUSE Manager offers support for Red Hat Enterprise Linux clients; however it is
important to note that content still needs to be added manually and is not available
through the cloud-based RMT service.

For more information, see Client-configuration > Registration-overview-redhat.

1.2.4.6. PAYG Client connections and Client Registration

1.2.4.6.1. Managing connections and registering PAYG and BYOS images

PAYG (Pay-As-You-Go) Images

Connecting and registering PAYG images is supported and can be done without additional
prerequisites.
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BYOS (Bring Your Own Subscription) Images
Registering BYOS images requires SCC (SUSE Customer Center) credentials beforehand. If a user

attempts to onboard a BYOS image without providing SCC credentials, the operation will fail, as
these credentials are required to verify your subscription.

o Always verify the type of image (PAYG or BYOS) prior to initiating the registration
process with SUSE Manager to ensure a smooth and error-free connection.

e If you have SCC credentials ensure your SCC credentials are valid and have the
necessary permissions for utilizing BYOS images.

o Do not register PAYG instances with the SUSE Customer Center. Only BYOS instances
should be registered against the SUSE Customer Center.

Registering PAYG instances with the SUSE Customer Center or your own RMT
server will create conflicts that are not easily solved. PAYG instances are
automatically registered against the correct update server when added to your cloud
service provider SUSE Manager instance.

1.2.4.6.2. Starting up additional PAYG SUSE products in Microsoft Azure

For more information on using SUSE PAYG products such as SUSE Linux Enterprise in the public cloud
see: SUSE Linux Enterprise Public Cloud Guide

1.2.%.6.3. Establishing a PAYG SUSE Linux Enterprise connection with SUSE Manager
PAY

It is important to recognize that there is a difference between Pay-as-you-go
connections and bootstrapping. Bootstrapping is also known as client
registration.

Once you have started up your SUSE Manager PAYG instance and refreshed products

you can add Pay-as-you-go connections via the Admin > Setup Wizard > Pay-as-

you-go [ +Add Pay-as-you-go] button. This action links your SUSE Manager PAYG
o instance with additional PAYG products on Microsoft Azure.

Bootstrapping or client registration is the process of onboarding clients in SUSE
Manager. The registration process installs the appropriate client tools and provides
full management functionality.

To manage your clients, start by establishing connections and then proceed to
bootstrap your clients. These two actions are the steps required for initiating and
completing the client onboarding process.

Procedure: Connecting SUSE Linux Enterprise PAYG instances to SUSE
Manager PAYG

1. Return to the SUSE Manager Server WebUI.

2. Navigate to Admin » Setup Wizard > Pay-as-you-go and click the [ +Add Pay-as-you-go ] button.
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3. Add a description.
4. Complete the instance SSH connection data:
O Host: CSP URL of the machine
O SSH Port: 22
O User: root
O Password: <password>
O SSH Private Key
5. Click [ Create ] and wait for the sync to finish.

6. Proceed to Admin » Setup Wizard > Products to access your PAYG SUSE Linux Enterprise products.

1.2.4.6.4. Registering Clients

Now that you have established connections to the SUSE Manager PAYG instance you can register them
as clients. To learn how to register various clients see: Client-configuration > Registration-methods

Minion Timeouts

Inbound and outbound connections to Microsoft Azure are released after 4 minutes of being idle. This
affects minion connectivity, especially when your SUSE Manager server is in Microsoft Azure and you
have some on-premises minions. If a connection is idle for more than 4 minutes, connectivity is lost.

To resolve this issue on your minions:

Procedure:

1. Create a new configuration file at i.a. /etc/venv-salt-minion/minion.d/keepalive.conf and enable
keepalive:

tcp_keepalive: True
tcp_keepalive_intvl: 5
tcp_keepalive_idle: 10
tcp_keepalive_cnt: 3

2. Restart the venv-salt-minion service.

1.3. SUSE Manager PAYG on the Cloud: FAQ

Last updated: October 2023

Introduction

To support customers that prefer a cloud centric billing model, SUSE has recently published a new
listing to the AWS & Azure Marketplaces, SUSE Manager

This brings the value of running SUSE Manager to cloud customers, with the benefit of a new pay-
monthly pricing model via the cloud.
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Documents in this FAQ

e Specialized-guides> Public-cloud-guide
e Specialized-guides> Public-cloud-guide

e Specialized-guides > Public-cloud-guide

Specialized-guides > Public-cloud-guide

e Specialized-guides > Public-cloud-guide

Specialized-guides > Public-cloud-guide

Public Cloud Listings

Last updated: October 2023

What is the SUSE Manager PAYG listing on the cloud marketplaces?

By selecting the SUSE Manager PAYG listing from the cloud marketplace, customers can deploy SUSE
Manager to their cloud environment with the advantage of having monthly billing via the cloud provider.

Customers still have the option of using SUSE Manager BYOS (Bring-your-own-subscription), for which
subscriptions and billing is handled directly by SUSE.

Where do | find the SUSE Manager PAYG listings?

The listings can be found in the AWS & Azure Marketplaces. There are two listings:
On the AWS Marketplace, you will find the following:

o SUSE Manager Server Family (Non-EU and non-UK only)
o SUSE Manager Server Family (EU and UK only)

On the Microsoft Azure Marketplace, you will find:

e SUSE Manager with 24x7 Support
o SUSE Manager with 24x7 Support (EMEA Orders Only)

For the purposes of this FAQ, we will refer to these listings as SUSE Manager PAYG.
Why are there 2 listings and which one should I use?
We have 2 listings for SUSE Manager:

o EU and UK only / EMEA Orders Only

e non-EU and non-UK only.

You should pick the listing that reflects in which country your AWS & Azure account gets billed.
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1.3. SUSE Manager PAYG on the Cloud: FAQ

Are these listings available in all countries?

The SUSE Manager PAYG listing on the cloud is not available to purchase in all countries. In case it is not
available in your country you can still use the BYOS option.

Your billing country is based on the AWS & Azure Account ID used to do the deployment.
You can find out more about confirming your tax location as follows:

e For Amazon Web Services, it depends on the tax address of the account, see Tax help based on
location

e For Microsoft Azure, it depends on the sold to address of the account, see Azure account profile

Please see the link at the end of this FAQ for a list of countries that can and cannot transact SUSE
Manager PAYG via the cloud marketplaces.

My cloud account is in the USA, but | want to deploy SUSE Manager PAYG in
another region, a region thatis in a country where | currently cannot transact,
is this possible?

If your cloud provider account is billed to one of the allowed countries, it is possible to deploy SUSE
Manager in any region.

Is this listing available in China?

It is not possible to transact/bill SUSE Manager PAYG via AWS & Azure Marketplaces in China. It is
possible to deploy into regions in China.

This means you can deploy SUSE Manager in a region in China if your billing is performed in a country

that has the PAYG option available. Please see the addendum at the end of this FAQ for a list of countries
that can and cannot transact SUSE Manager PAYG via the cloud.

Is there still a BYOS listing for SUSE Manager in the marketplace?

Yes, for customers that wish to use an existing annual SUSE Manager subscription, the BYOS SUSE
Manager listing is available.

Is there a PAYG listing available for the SUSE Manager Proxy Server?

If a SUSE Manager Proxy is required as part of the architecture, it is suggested to use the containerized
proxy. See the SUSE documentation at: documentation.suse.com

Select » SUSE Manager >» SUSE Manager {'5.0'} > Installation and Upgrade guide > Installation » SUSE
Manager Proxy > Install Containerized Proxy

From the subscription point of view, SUSE Manager Proxy is a managed client.
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1.3. SUSE Manager PAYG on the Cloud: FAQ

The listing shows pricing information for SUSE Manager node management and
a separate price for monitoring. Do | need to subscribe twice if | nee
monitoring?

There is no need to subscribe twice. Subscribing to the listing in the cloud provider marketplace allow
the SUSE Manager PAYG instance to perform metered billing for SUSE Manager usage.

If you onboard an instance and enable SUSE Manager monitoring, there is a monthly charge for
management and another charge for monitoring.

Billing

Billing - General

Last updated: October 2023

I have an existing SUSE Manager BYOS subscription; can | use this on the cloud?

BYOS Bring-your-own-subscription SUSE Manager deployments are supported on the cloud, however,
billing will not be via the cloud marketplace.

Once the existing subscription term ends, you can purchase SUSE Manager PAYG via the cloud provider
marketplace and manage your instances with a SUSE Manager deployment that is billed via the cloud.

I have an existing deployment covered by a BYOS SUSE Manager subscription; can | use
this new listing in the cloud for a separate deployment of SUSE Manager PAYG?

Yes, the listing works independently from your existing BYOS SUSE Manager subscriptions. Please
remember that support processes may be different for deployments using your existing BYOS
subscription and those billed via the cloud and note that there is currently no process for migrating
deployments between BYOS and PAYG versions.

Tell me more about how the billing for SUSE Manager PAYG works via the cloud?
When purchasing SUSE Manager via the AWS & Azure Marketplaces, the billing is as follows:

e Billingis monthly and handled via cloud marketplace.

Managed instances are recorded hourly.

The peak usage total is recorded for the month.

e Thereisamonthly usage charge for each instance in the count.

I have existing SLES for SAP instances procured via the cloud provider marketplace, is
there a cost to manage these instance with SUSE Manager PAYG?

SLES for SAP Applications PAYG/on-demand instances, when purchased via the cloud marketplace,
include Lifecycle Management(LCM) entitlements for SUSE Manager.

The SUSE Manager PAYG billing engine recognizes the embedded LCM entitlements and does not
include them in the count. This means there are no additional charges to manage these with the SUSE
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Manager PAYG listing.

However, if SUSE Manager Monitoring is required for these instances, additional charges will apply for
this feature.

Is there a way to try SUSE Manager PAYG before purchasing?

If using the SUSE Manager PAYG listing in the cloud marketplace, billing will commence from the time of
deployment and when applicable client instances are on-boarded to SUSE Manager.

There is the SUSE Manager BYOS listing in the cloud marketplace that can be used, a trial subscription
key can be obtained via the SUSE Website. This deployment cannot be directly converted to allow billing

via cloud marketplaces.

To benefit from monthly billing via the cloud marketplace, SUSE Manager needs to be redeployed using
the version from the PAYG listing in the cloud marketplace.

How does SUSE calculate the amount of managed instances to bill for?
Billing is based on the number of managed instances.
Below are 3 examples of how the node count is calculated, check the table below for the detail.

Static usage

Using SUSE Manager with 10 instances registered for management, for 1 month with no additional
managed clients added in the month.

Bursting Model

Using SUSE Manager with 10 instances registered for management for 3 weeks in the month,
bursting to 30 managed instances for 1 week.

Transient model

Atemporary deployment of SUSE Manager with 20 managed instances, for 2 weeks (336 hours)

The total is calculated by counting number of active nodes (checked hourly). There is a monthly charge
for each managed node under management in the billing cycle.

Below are 3 examples of how the average node count is calculated.

H 3. Usage calculations for different scenarios

Managed Instances Peak Usage Billed for
Static Usage 10 10 10
Bursting Model 10 - 3 Weeks,30-1 30 30
Week
Transient Cluster 20 - 2 Weeks 20 20
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1.3. SUSE Manager PAYG on the Cloud: FAQ

Are special commercial terms available?

It is dependent on the deployment and the cloud provider, as every Cloud Service Provider (CSP) has its
own commercial terms and offers.

It may be possible to secure special commercial terms such as an annual subscription. For example, AWS
can offer SUSE Manager PAYG via a Private Offer. Please contact SUSE for more information.

Can my spending on SUSE Manager PAYG count towards my committed spend with the
cloud provider?

There are such programs at the cloud providers:

e Azure MACC Program
e AWS Enterprise Discount Program

o Google CUD

Yes, it can. Please contact your cloud provider sales team for more details.

How do | purchase SUSE Manager / LCM subscriptions for additional managed instances?

Once SUSE Manager PAYG has been deployed from the marketplace listing and billing is active, there is
no need to make a specific purchase to manage additional instances. Billing is dynamic and based on
the number of instances SUSE Manager is managing. Just on-board additional instances to SUSE
Manager as needed, this will be reflected in your cloud marketplace bill.

Is this an annual commitment, will it auto-renew?

By default, the SUSE Manager PAYG listing on the cloud is billed on a monthly cycle, based on usage.
Billing is ongoing for as long as SUSE Manager is deployed and instances are registered.

Is there a volume discount / tiered pricing built into the Cloud Listing?

Currently, there is no volume discount available.

I no longer require support; how can | end the SUSE Manager PAYG subscription?
If you no longer require support, there are 2 options:
o Unregister all systems from the SUSE Manager Server

e Terminate the SUSE Manager instance.

Billing - Technical

Last updated: October 2023
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1.3. SUSE Manager PAYG on the Cloud: FAQ
Do | need any special or additional infrastructure to set up SUSE Manager billing via the
cloud marketplaces?

No, all components needed to handle the billing are part of the SUSE Manager PAYG code base.

What is the deployment mechanism for SUSE Manager PAYG on the cloud marketplace?

The cloud marketplace listing for SUSE Manager PAYG will deploy a SUSE Manager instance, together
with the embedded billing engine.

What version of SUSE Manager is installed when using the marketplace listing?

The cloud marketplace listing for SUSE Manager PAYG is tied to a specific version of SUSE Manager (4.3.8
at launch). Future listings will typically include the latest version available at the time of product/image
creation. Please check the listing for further information.

I need a prior version of SUSE Manager installed; can I still use the listing?

No, there is no choice over the SUSE Manager version when deploying using the cloud marketplace
listing. If a prior version of SUSE Manager is required, this will need to be installed manually using the
standard documentation and BYOS billing.

How often is the listing updated (including the version of SUSE Manager etc.)?

The Marketplace listing is tied to a specific version of SUSE Manager, which is the latest version available
at the time of the listing.

Typically, the listing in the cloud marketplace is updated quarterly, or more frequently if there are
security issues.

It is worth noting that the image update process may not be fully aligned to the SUSE Manager product
maintenance releases (every 6-8 weeks), so SUSE Manager PAYG instances should be patched regularly
after deployment.

I have purchased multiple PAYG - Pay-as-you-go SUSE products from the cloud provider
marketplace (i.e. Rancher, NeuVector and SUSE Manager), does the marketplace billing
method still work?

Yes, the billing mechanism for the products is independent. Each deployment will be billed separately
via the cloud marketplace.

I already have an existing SUSE Manager deployment; how can | get this deployment to
bill via the cloud marketplace?

Existing deployments cannot be directly converted or updated to provide billing via the cloud
marketplace. To benefit from monthly billing, SUSE Manager PAYG must be deployed directly from the
cloud marketplace listing.

Billing - Products
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1.3. SUSE Manager PAYG on the Cloud: FAQ

How.do_,l migrate an existing SUSE Manager BYOS instance to the PAYG - Pay-as-you-go
version?

Currently, it is not possible to migrate an existing instance to the PAYG version.

Customers can simply deploy a new SUSE Manager PAYG instance from the cloud marketplace and re-
onboard all instances using the standard process.

Client configuration overview
How do | get support?
Itis simple to open a support case with SUSE for SUSE Manager PAYG.

Create a ‘supportconfig’ via SUSE Manager PAYG instance CLI and upload the output to the SUSE
Customer Center (SCC) at the following link:

https://scc.suse.com/cloudsupport

Providing marketplace billing is active, a support case will be opened.

Are there any differences between the SUSE Manager PAYG product on the cloud
marketplaces compared to the versions | can run in my own data center?

The SUSE Manager PAYG product available in the cloud marketplace is the same product, with similar
functionality that you would run on-premises or with a manual installation.

The only exceptions being the ability to bill via the cloud marketplace and connect to the SUSE Update
Infrastructure for SUSE Manager product updates.

Itis also worth checking the list of supported client operating systems to ensure your needs are met.

Does the SUSE Manager PAYG instance need to run 24/7?

It is recommended that the SUSE Manager instance always remains active.

How do | get fixes and updates for SUSE Manager PAYG, do | need a subscription key?

SUSE Manager PAYG, when deployed via the cloud marketplace will automatically connect to the SUSE
Update Infrastructure, no separate SUSE Manager subscription key is required.

Updates to the SUSE Manager instance can be applied from those channels using standard SUSE tooling
(i.e. zypper).

Is the use of SUSE Manager Hub supported with this listing?

Yes, SUSE Manager Hub is recommended for customers with more than 10,000 managed clients. If the
SUSE Manager Hub instance has no connected clients, there will be no charge for the SUSE Manager Hub
software components.

Billing will occur from the downstream SUSE Manager PAYG Server instance, where managed instances
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1.3. SUSE Manager PAYG on the Cloud: FAQ

are connected.

Can | manage Bring-your-own-subscription - BYOS SLES instances in the cloud with SUSE
Manager PAYG?

To manage BYOS instances, SUSE Customer Center (SCC) credentials with entitlement to valid SLES or
SLES for SAP subscriptions will be required. These credentials should be added to the SUSE Manager
configuration to enable this functionality.

I have a hybrid setup; can | manage instances (workloads) outside of the cloud?

Yes, itis possible to manage instances, in the cloud, on premises or both.

To enable management of SUSE workloads in an on-premises data center, SCC credentials with
entitlement to valid SLES or SLES for SAP subscriptions will be required.

These credentials should be added to the SUSE Manager configuration to enable this functionality.

o Egress data charges may apply when managing workloads outside of the
cloud provider's network.
Are there additional charges for using a SUSE Manager Proxy?

With a hybrid landscape, egress data charges may apply when managing workloads outside of the cloud
provider. To reduce these costs, SUSE recommend the use of the containerized proxy.

Please note: Whilst the SUSE Manger Proxy usage is included as part of the SUSE Manager PAYG

subscription, an LCM+ subscription will be billed if the proxy is also a managed workload, so in other
words it counted as a managed client.

Can | have a SUSE Manager PAYG Server on premises and bill via the Cloud Marketplace.

No, to benefit from cloud marketplace billing, the SUSE Manager PAYG instance must reside on the
cloud. Any SUSE Manager instances on premises will require their own subscriptions.

What client Operating Systems are supported with SUSE Manager PAYG?

Please refer to the product documentation for a full list of supported clients. PAYG Overview

Miscellaneous

Where can | find out more about the Cloud Marketplace listing for SUSE
Manager?

You can use the following resources to learn more about the SUSE Manager listing and how to deploy.

e New dawn for SUSE Manager

e documentation.suse.com/suma/
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Where can | find out more about SUSE Manager?

e SUSE Manager

e Training courses

Appendix

Countries that can transact SUSE Manager PAYG through the cloud
marketplace

Countries that can transact via the cloud marketplaces: Supported Country List

Public Cloud Support

BYOS and PAYG Support

Regardless of the public cloud service you use or the plan you choose, SUSE has you covered with
support. Where you get support is dependent on whether you Bring-your-own-subscription (BYOS) or
you use SUSE products on-demand Pay-as-you-go (PAYG).

BYOS

BYOS instances are supported by SUSE under the terms of your SUSE subscription. For an overview
of SUSE’ s support subscriptions, refer to https://www.suse.com/support/.

PAYG

SUSE Manager PAYG instances include support by SUSE. To open a ticket for PAYG, see
https://scc.suse.com/cloudsupport.

Public Cloud Guide

For more information on cloud products and support, see SUSE Public Cloud Guide.

Public Cloud Information Tracker (PINT)

The Public Cloud Information Tracker (PINT) provides information about the images SUSE publishes
and servers that are part of the SUSE operated update infrastructure. PINT is available at
pint.suse.com and provided as an APl and command-line tool with the python3-susepubliccloudinfo
package from the Public Cloud Module repository.

Collecting System Information with supportconfig

To create a TAR archive with detailed system information that you can hand over to Global Technical
Support, use the command supportconfig. The command-line tool is provided by the package
supportutils which is installed by default.

Depending on which packages are installed on your system, some of these packages integrate
supportconfig plug-ins. When supportconfig is executed, all plug-ins are executed as well, creating one
or more result files for the archive. This has the benefit that the only topics checked are those that
contain a specific plug-in for them. supportconfig plug-ins are stored in directory
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/usr/1ib/supportconfig/plugins/.

The following procedure shows how to create a supportconfig archive, but without submitting it to
support directly.

Procedure: Creating a supportconfig Archive

1. Run supportconfig as root. Usually, it is enough to run this tool without any options. Some options
are very common and are displayed in the following list:

£ E 1. Options:

-E MAIL, -N NAME, -O COMPANY, -P PHONE

Sets your contact data: e-mail address (-E)
Company name (-O)

Your name (-N)

Your phone number (-P)

-i KEYWORDS, -F

Limits the features to check.

The placeholder KEYWORDS is a comma-separated list of case-sensitive keywords.
Get a list of all keywords with supportconfig -F.

2. Wait for the tool to complete the operation.

3. The default archive location is /var/log, with the file name format being scc_HOST_DATE_TIME.txz

Opening a New Support Case

To open a new support case for your cloud Pay-as-you-go instance, you need to generate a
supportconfig file and then follow the steps listed on:

SUSE Customer Center Cloudsupport

Billing Services and Troubleshooting

billing-data-service

This service serves billing data from SUSE Manager for the CSP-billing-adapter. The service is reachable
at:

e http://localhost:18888/
e http://localhost:18888/metering

This service is maintained by the SUSE Manager team. This service only logs to systemd journal.

Billing services must be running or spacewalk will refuse to start.

csp-billing-adapter-service

This service reports the billing data to the cloud provider (AWS, AZURE, GCP). These logs are stored in:
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e /var/log/csp_billing_adapter.log
Additional status information can be located in:
e /var/lib/csp-billing-adapter/csp-config.json

This service is maintained by public cloud team.

mgr-check-payg.service

This service checks if billing-data-service is installed and running. It also checks if the csp-billing-
adapter-service is installed and running. If these services are not running or installed it will attempt to
install and start the service.

Consequences

If one of the previous billing services is not running and cannot be installed or started spacewalk
will refuse to start.

Check journalctl -u mgr-check-payg.service for additional issues.

Continuous Compliance Checks

Procedure: Compliance Checks
1. The payg-dimension-computation taskomatic task must be active.
2. Is the billing server running at http://localhost: 18888/ ?
3. Is the csp-billing-adapter.service running?
4. What is the status of the csp-billing-adapter located in /var/lib/csp-billing-adapter/csp-

config.json?

The following files and packages are checked for tampering
©  Billing-data-service
O Csp-billing-adapter-service
O Python3-csp-billing-adapter
O Python3-csp-billing-adapter-local
O Python3-csp-billing-adapter-amazon

O python3-csp-billing-adapter-azure

Failed Checks

Failed checks are logged in:

O /var/log/rhn/rhn_web_ui.log

O /var/log/hrn/rhn_taskomatic_daemon.log
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Consequences

©  No more actions will be executed.

O reposync will stop synchronizing channels.

Troubleshooting Public Cloud

Last updated: March 2024

This section is dedicated to some common problems you might encounter with SUSE Manager in Public
Cloud, and solutions to resolving them.

For all other troubleshooting topics, see Administration Guide > Administration > Troubleshooting.

Configure Pay-as-you-go Behind Proxy

To identify if a machine is PAYG or not, SUSE Manager needs to use sudo to run instance-flavor-
checktool.

If the customer is using a http proxy, they need to make sure this setting is correctly managed by sudo,
because by default most environment variables are disregarded.

of

mufn

23617 /3t

e

7hX| BHH2 /etce/sudoers.d/keep_proxy.conf IO CHS LB S FI}tstH= A L|CE.

#7tst ZE TEA 714 /A
Defaults env_keep += "http_proxy https_proxy no_proxy"

This ensures the proxy related environment variables are preserved during the privileges escalation.

Set up SUSE Manager with Separate Disk for BYOS

Issue

SUSE Manager setup results with an error while restarting services during setup. The setup fails on
restarting tomcat.
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Write Settings
Setup failed.
Setup script output

tting down spacewalk services that may be using DB.

vices stopped. Clearing DB.

guration.
virtual host.
host-ssl.conf has been backed up to vhost-ssl.conf-swsave

S.
ificate.
er certificate.
ting up report database.
ar-db option used. Clearing report database.

** Database tallation complete.
* Report DB Configured
onfiguration in database
up Cobbler. .
onfiguration files.
* Restarting services
Tomcat failed to start properly or the installer ran out of tries. Please check /var/log/tomcat/catalina.out or /var/log/tomcat/catalina.$(date +%Y-%m-%d).log for errors.

Reason

When SUSE Manager is set up using separate disks for cache, PostgreSQL and spacewalk, the existing
data within these partitions are covered under the new mount point.

suma:~ # 11 /etc/tomcat
total 236
Lrwxrwxrwx 1 root root 26 Oct 16 08:36 Catalina -> /var/cache/tomcat/Catalina
-rw-r--r-- 1 root tomcat 13497 Oct : catalina.policy
-rw-r--r-- 1 root tomcat 7630 Oct : catalina.properties
drwxr-xr-x 2 root tomcat 83 Dec
-rw-r--r-- root tomcat 1400 Oct : context.xml
-rw-r--r-- 1 root tomcat 1149 Oct 1€ :36 jaspic-providers.xml
root tomcat 4450 Oct : logging.properties
root root 8124 Dec : server.xml
root root 7856 Dec : server.xml.2023-12-13T18:48:12.66
root tomcat 3224 Oct 16 08:36 tomcat-users.xml
root tomcat 1829 Oct : :36 tomcat.conf
root tomcat 172577 Oct 16 08:36 web.xml

As SUSE Manager instance of cloud already has some services set up, when the data is not available
during set up it causes the service to not restart as expected. Therefore the setup fails.
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suma:~ # 11 /var/c
total 4
3 root
drwxr-xr-x 36 man
2 root

Actual data which should be present:

ache

root

root

suma:~ # umount /var/cache

suma:~ # 11 /var/cac
total 0
drwxr-x--- 2 wawwrun
drwxr-xr-x 3 root
drwxr-xr-x 2 root
drwxrwx--- root
drwxr-xr-x 2 root
drwxr-xr-x 2 root
root
man
root
drwxr-xr-x 3 wawwrun
drwxr-x--- root
drwxrwx--- root
drwxr-xr-x 5 root

he/

root
root
root
lp
root
root
root
man
root
WWW
salt
tomcat
root

24 Jan 14 18:25
man 4096 Jan 15 02:21

23
6
6

21

34

46

45

suma:~ # 11 /var/cache/tomcat/

total 0

drwxrwxr-x 2 root tomcat 6 Oct
drwxrwx--- 2 root tomcat 6 Oct
drwxrwx--- 2 root tomcat 6 Oct

o Jan 14 18:25

16 08:36
16 08:36
16 08:36

1. AWSOllM Z2H|X'JEl SUSE Manager At = BYOSE QIsl &t AMIE AHELICE

2. Separate storage for spacewalk, PostgreSQL and cache. The size of the partition depends on the

repository to be synchronized.

SUSE Manager '5.0" | | Troubleshooting Publ

ic Cloud
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Troubleshooting Public Cloud

3. Set up SUSE Manager using yast2 susemanager_setup.

Resolution

To resolve or avoid the issue, copy the data of the underlying partition into the new partition by
following the steps below:

Procedure: Resolving the issue

1. Create a backup partition

2. Unmount the affected partition for example /var/cache.

3. Check the underlying data in the partition. This should list the actual data present in the directory.

4. Copy the data onto the backup partition created in step 1.

]

. Mount the partition again using option 1 or 2:

(o)}

. Copy the backed up data from step 4 to the mounted partition

]

. Verify the data is present

8. Repeat the SUSE Manager setup

Conclusion

When using SUSE Manager in public cloud with separate data partitions, make sure that the existing
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data in those directories are copied onto the new partition.

PAYG Checks

A%

ol

o 3ol

- -

o AJRIEJ} XA

O

Y o HIStHE 23 5! Web UI0]| M ESE 2F HAIX|7} EA|=|0f0F RLICY,

o Ifthe credentials are not working, reposync should show the proper error.

Using registercloudguest

e Refreshing or changing the registercloudguest connection to the public cloud update
infrastructure should not interfere with the credentials usage.

e Running ‘registercloudguest --clean will cause problems if no new cloud connection is
registered with the cloud guest command.
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Salt Guide Overview

Updated: 2024-11-18

Salt is a remote execution engine, configuration management and orchestration system used by SUSE
Manager to manage clients.

In SUSE Manager, the Salt master runs on the SUSE Manager Server, allowing you to register and
manage Salt clients.

This book is designed to be a primer for using Salt with SUSE Manager.

For more information about Salt, see the Salt documentation at https://docs.saltstack.com/en/latest/
contents.html.

The current version of Salt in SUSE Manager is '3006.0'".

Terminology

Beacon

Beacons allow you to use the Salt event system to monitor non-Salt processes. Clients can use
beacons to connect to various system processes for constant monitoring. When a monitored activity
occurs, an event is sent on the Salt event bus that can then trigger a reactor.

To use beacons on SUSE Linux Enterprise Server Salt clients, install the python-
o pyinotify package. For Red Hat Enterprise Linux systems, install the python-
inotify package.

For more information on beacons, see https://docs.saltstack.com/en/latest/topics/beacons/

Broker

The Salt broker allows clients to pass commands to each other. The broker acts like a switch,
therefore peer communication will only work for clients on the same network, or connected to the
same proxy.

For more information on Salt and peer communication, see https://docs.saltstack.com/en/latest/
ref/peer.html.

Environment

SUSE Manager implements Salt with a single environment. Multiple Salt environments are not
supported.

Formulas

Formulas are collections of Salt States that contain generic parameter fields. Formulas are used
within SUSE Manager to assist with configuring Salt clients. Some formulas have extensive
configuration options, and use forms to help organize them in the SUSE Manager Web Ul.
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For more information about formulas, see Specialized-guides > Salt.

Grains

Grains provide information about the hardware of a client. This includes the operating system, IP
addresses, network interfaces, and memory. When you run a Salt command any modules and
functions are run locally from the system being called.

For more information on grains, see https://docs.saltstack.com/en/latest/topics/grains/.

Highstate

This term is used when you apply all outstanding states to all targeted clients at the same time. The
highstate must be applied when doing changes to systems, including enabling and disabling
formulas.

Key Fingerprints

Key fingerprints are exchanged between the SUSE Manager Server and Salt clients to verify the
identity of the server and the client. This prevents Salt clients from connecting to the wrong server.

You can see the fingerprints of your Salt clients by navigating to Salt > Keys.

Master

The Salt master issues commands to its attached clients. In SUSE Manager, the Salt master must be
the SUSE Manager Server.

Minions

Salt clients that are connected to and controlled by the Salt master on the SUSE Manager Server. In
SUSE Manager, these are sometimes referred to as Salt clients. This is a difference in terminology
only.

Modules

Functions within Salt are stored in modules. Salt modules are stored on clients and the SUSE
Manager Server within the /usr/1ib/python*/site-packages/salt/ directory. There are many types of
Salt modules, including state and execution modules. You can write your own Salt modules using
Python.

For a complete list of available Salt modules, see https://docs.saltstack.com/en/latest/ref/
index.html.

Pillars

Pillars are created on the SUSE Manager Server. They contain information about a client or group of
clients. Pillars allow you to send confidential information to a targeted client or group of clients.
Pillars are useful for sensitive data, configuration of clients, variables, and any arbitrary data.

For more information on pillars, see https://docs.saltstack.com/en/latest/topics/tutorials/
pillar.html.
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States

States are configuration templates. They allow you to describe what each of your systems should
look like, including the applications and services that are installed and running. States are applied to
the target client. This automates the process of bringing a large number of systems into a known
state, and then maintaining them.

Do not update the salt package using states. Update all other system packages
using states. You can then update the salt package from the SUSE Manager
Web Ul as a separate step.

For more information on states, see https://docs.saltstack.com/en/latest/topics/tutorials/
starting_states.html.

For more Salt terminology, see https://docs.saltstack.com/en/latest/glossary.html.

Salt Command

Salt commands have three main components: target, function, and arguments. The calls are
constructed in this format:

salt 'target' <function> [arguments]

The target defines the client, or group of clients, on which to run the function.
The function is the particular task to be run.

Arguments provide any extra data required by the function.

Salt Targets

Salt command targets allow you to specify a client or group of clients. There are several different targets
you can use.

General Targeting

List available grains on all clients:
salt "' grains.ls
Target a specific client:
salt 'webl.example.com' test.ping

Glob Targeting

Target all clients using a particular domain:
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Salt Command

Target all clients using a particular label:

List Targeting
Specify a flat list of clients, using their IDs:

Regular Expression Targeting

You can also define targets with PCRE-compliant regular expressions:

IP Address Targeting

List available client IP addresses:

Target a specific client IP address:

Target all clients on a subnet:

For more on targeting, see https://docs.saltstack.com/en/latest/topics/targeting/.

Salt Execution Modules

When you have specified a target, provide the module and function to execute on the target.

Find which modules can be executed on the target:

For a full list of callable modules, see https://docs.saltstack.com/en/latest/ref/modules/all/
index.html.
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Often Used Salt Commands

Salt Function Arguments

Functions accept arguments for any extra data.

For example, the pkg.install function requires an argument specifying which package to install:

You can provide more than one argument to a function, with spaces between them. For example:

Often Used Salt Commands

This section contains the most commonly used Salt commands. For a complete list of available Salt
commands, see https://docs.saltstack.com/en/latest/ref/cli/index.html.

salt-run

Display all clients that are running:

Display all clients that are not running:

Display the current status of all Salt clients:

Check the version of Salt running on the SUSE Manager Server and active clients:

salt-cp

Copy afile to a client or set of clients:

salt-key -l
List public keys:
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salt-key -a my-minion

Accept pending key for a minion:
salt-key -a my-minion

salt-key -A
Accept all pending keys:

salt-key -A

salt grains

List all available grains:

%1

salt "' grains.ls

List collected grain system data:

%1

salt "' grains.items

Salt States and Pillars

States are configuration templates. They allow you to describe what each of your systems should look
like, including the applications and services that are installed and running. Salt state files are referred to
as SLS (Salt State) files.

States are applied to the target systems by matching relevant state data to clients. The state data comes
from SUSE Manager in the form of package and custom states.

You can target clients at three specific levels of hierarchy and priority: individual clients, system groups,
and organization. Individual clients have priority over groups, and groups have priority over the
organization.

For example:

o The Organization requires that version 1 is installed. All clients are part of the same Organization.
e Group Arequires that version 2 is installed. Clientl, Client2, and Client3 are part of Group A.

e Group Brequires any version installed. Client4 is part of Group B.
Leading to these possible scenarios:

o Clientl wants package removed, package is removed (Client Level)
o Client2 wants version 2, gets version 2 (Client Level)
o Client3 wants any version, gets version 2 (Group Level)

Client4 wants any version, gets version 1 (Organization Level)
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FQr more information on Salt states, see https://docs.saltproject.io/en/latest/topics/states/.

You can create custom Salt states with SUSE Manager. For more information, see Specialized-guides >
Salt.

Group States

Pillar data can be used to perform bulk actions, like applying all assigned states to clients within the
group. This section contains some examples of bulk actions that you can take using group states.

To perform these actions, you will need to determine the ID of the group that you want to manipulate.
You can determine the Group ID by using the spacecmd command:

spacecmd group_details

These examples use an example Group ID of GID.

To apply all states assigned to the group:
salt -l 'group_ids:GID' state.apply custom.group_GID
To apply any state (whether or not it is assigned to the group):
salt -1 'group_ids:GID' state.apply ~ " state”
To apply a custom state:
salt -1 'group_ids:2130' state.apply manager_org_1." " customstate”
Apply the highstate to all clients in the group:
salt -1 'group_ids:GID' state.apply

Salt Pillars

SUSE Manager exposes a small amount of internal data as pillars which can be used with custom states.
Pillars are created on the SUSE Manager Server, and contain information about a client or group of
clients. For custom information in pillars, see Client-configuration » Custom-info. Pillars are useful for
sensitive data, configuration of clients, variables, and any arbitrary data.

Pillars are managed either automatically by SUSE Manager, or manually by the user.
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If you change pillar data on the server (Salt master) the actual pillar data on the client
(minion) is updated only after calling saltutil.refresh_pillar for the client.

Otherwise it could happen that pillar.items and pillar.get calls would produce
different results with different values of pillars that were not refreshed.

To avoid hard-coding organization IDs within SUSE Linux Enterprise Server files, a pillar entry is added
for each organization:

org-files-dir: relative_path_to_files

The specified file is available for all clients which belong to the organization.

This is an example of a pillar located at /etc/motd:

file.managed:
- source: salt://{{ pillar['org-files-dir']}}/motd
- user: root
- group: root
- mode: 644

For more information on Salt pillars, see https://docs.saltproject.io/en/latest/topics/pillar/.

Download Endpoint

By default, SUSE Manager assumes that the download endpoint to use is the FQDN of the SUSE Manager
Server or Proxy. However, there are some cases where you might like to use a different FQDN as the
download endpoint. The most common example is if you need to use load balancing, caching proxies, or
in environments with complicated networking requirements.

*

To change the package download endpoint, you can manually adjust three Salt npillars:
pkg_download_point_protocol, defaults to https. * pkg_download_point_host, defaults to the FQDN of the
SUSE Manager Server (or Proxy, if in use). * pkg_download_point_port, defaults to 443.

If you do not adjust these pillars directly, SUSE Manager will fall back to the default values.

Procedure: Changing the Package Download Endpoint Pillar

1. Navigate to /srv/pillar/ and create a file called top.sls with these contents:

base:

11,

- bkg_download_points

This example directs Salt to look at the pkg_download_points.sls file to determine the base URL to
use. You can adjust this file to target different clients or groups, depending on your environment.

2. Remain in /srv/pillar/ and create a file called pkg_download_points.sls with the base URLs you
want to use. For example:
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pkg_download_point_ﬁrotocol: http
pkg_download_point_host: example.com
pkg_download_point_port: 444

3. OPTIONAL: If you want to use external pillars, for example Group IDs, open the master configuration
file and set the ext_pillar_first parameter to true. You can then use Group IDs to set conditional
values, for example:

o if pillar['group_ids'] is defined and 8 in pillar['group_ids'] %
{% if pillar[' ids'] is defined and 8 in pillar(' ids'] %}
pkg_down oad_point_ﬁrotocol: http
pkg_download_point_host: example.com
g)kg_download_point_port: 444
{% else %}
pkg_download_point_protocol: ftp
pkg_download_point_host: example.com
pkg_download_point_port: 445
{%- endif %}

4. OPTIONAL: You can also use grains to set conditional values, for example:

{% if grains['fqdn'] == 'client1l.example.com' %}
ka_download_point: examplel.com
{% elif grains['fqdn'] == 'client2.example.com"' %}
ka_ ownload_point: example2.com
{%ﬁsed%} o] o l
_download_point: example.com
{0)0D e%dif %}

GPG Encrypted Pillars

Salt has support to transparently decrypt GPG-encrypted Pillar data built-in. The decryption happens on
the Salt Master.

Generate GPG keyring for Salt Master

The GPG keyring can be specified in /etc/salt/master or in its own file under /etc/salt/master.d/, for
example /etc/salt/master.d/gpg-pillar.conf.

Always create a separate keyring for the Salt Master.

Procedure: Generating key pair

1. On the Salt Master create GPG home directory and restrict its permissions:

mkdir /etc/salt/ p%keys
chmod 700 /etcfsa t/gpgkeys

2. Generate a key pair interactively.

o The password must be empty.
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gpg --gen-key --homedir /etc/salt/gpgkeys

3. Salt does not run with root permissions on SUSE Linux Enterprise and openSUSE distributions.

chown -R salt:salt /etc/salt/gpgkeys

4. Configure Salt Master to use the new GPG home directory

echo 'gpg_keydir: /etc/salt/gpgkeys' >/etc/salt/master.d/gpg-pillar.conf
systemctl reload-or-restart salt-master

Use GPG for encrypting Pillar secrets

Salt GPG renderer decrypts GPG encrypted contents that are ASCl-armored. To use the GPG renderer in a
Pillar YAML file, change

#lyaml

to

#lyaml|gpg

Encrypting pillar secrets can be done anywhere as long as the GPG and the public key generated in
Procedure: Generating key pair are available.

In this example, "SUMA Salt Master" is the GPG key’ s UID created earlier.
echo 'tOps3cr3t' | gpg --armor --batch --encrypt --recipient "SUMA Salt Master"

When the GPG encrytped contents are created and available as ASCll-armored output, this output can be
used as a multi-line string in a pillar YAML file:

#lyaml|gpg

secret:
my-secret: |
----- BEGIN PGP MESSAGE-----

hQEMA30rmRaququQf/ejBxV+nO3HVbQRCngCmt5ZjnogT++HHerXymfrlSET
XySyquIZB2N6MjZXtupOZsCmG6fzqtmnW+vRthQGSPquRtAekFquXzikifB
3383/Od [tVBtMONNKHFQ+7EP1tfJnWLCVrJ1142vGFLZf2AD1xhbjewCcoak82J4
f8u9U/dxgVON6na28WG5m6YU5Reul1Ca37PXHugA/0XZI65DY63xaMPMDHZEi1wkU
GXUT70siL1d00/sST1Awo05i99kVt/kA6DCGDuUxTNpLrauNLOKUbtwcxvavtNZGwdQ
yl9zZWVx8qerWE0aO3M7zVDJftv77faV2ENigzaadvtJHAZynW4GWT7rSuP1RXFzIB
DOAmMzdRulJwiLCIR2BKu3x+avReQb6xoz7eF7WthCOHOdz4mYakwPIVZ5yqYa/+G
83i951rqAGI=

=gt

----- END PGP MESSAGE-----

When the pillar is assigned to a system with top.sls, the GPG encrypted pillar data is available in a
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decrypted format.

The client’ sin-memory cache is only updated on startup or when running execution
module functions that trigger a cache refresh such as saltutil.refresh_pillar,
pillar.items, or state.apply.

suma-sles15spl.tf.local:

my-secret:
tOp s3cr3t!

Export the GPG key

To export the GPG key, use the command:
gpg --export 'SUMA Salt Master' --homedir /etc/salt/gpgkeys --output suma-salt-master.gpg

Here 'SUMA Salt Master' is the name used during key generation.

The suma-salt-master.gpg public key can be freely shared.

Custom Salt States

You can create your own custom Salt states with SUSE Manager as centrally managed configuration
channels. Custom states are stored as Salt state files on the SUSE Manager Server with a . s1s extension.

Create a New Custom Salt Channel

You can use the SUSE Manager Web Ul to create and edit custom Salt state files. You must create a state
channel first, with an initial state named init.sls. The init.sls file is used to reference all other state
files within the channel. The custom states that you create using the Web Ul are stored on the SUSE
Manager Server in the the /srv/susemanager/salt/<organization>/ directory.

After the channel is created with an init.sls file, you can write additional state files in the Web UI.
Alternatively, you can upload existing state files to use within your state channel, or import them from
other channels or clients.

Procedure: Creating a Custom Salt Channel and Initial State
1. In the SUSE Manager Web Ul, navigate to Configuration > Channels.
2. Click [ Create State Channel ].
3. In the Name field, type a name for your state.

4. In the Label field, type a label. Use alphanumeric characters, hyphens, and underscores. Do not use
spaces.

5. Inthe Description field, type a short description of the configuration your state performs.

6. In the SLS Contents field, type the contents of your init.sls state. If you want to reference file
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templates in this configuration channel, ensure your file starts by specifying the source of the
managed file, using this syntax:

file.managed:
- source: salt://<org_name>/<channel_name>/etc/<ID>/<filename>

Example custom state files are given later in this section.
. Click btn:[Update Channel] to save your state.

Procedure: Adding Additional Files to a Custom State Channel

1. In the SUSE Manager Web Ul, navigate to Configuration > Channels. . Click the name of the channel
you want to add files to.

2. To create a new file, click [ Create configuration file ] and type the contents of the file.
3. Toupload an existing file, click [ Upload Configuration Files ] and select the file to upload.
4. To copy an existing file, click [ Import a File from Another Channel or System ] and select the file
to copy.
Procedure: Editing a Custom Salt State
1. In the SUSE Manager Web Ul, navigate to Configuration > Channels.
2. Click [ View/Edit <filename>.sls File ].
3. Make your changes to the file.
4. Click [ Update Configuration File ] to save your state.
You can also manage revisions, compare the state to others in your organization, and download the .sls
file from this dialog.
Procedure: Assigning a Client to a Custom Salt State
1. In the SUSE Manager Web UI, navigate to Configuration > Channels.
2. Click the name of the state you want to assign a client to.
3. Navigate to the Systems > Target Systems tab.
4. Check the clients you want to assign.

5. Click [ Subscribe systems ].

For more information about Salt state modules, see https://docs.saltproject.io/en/latest/ref/states/
all/index.html.

Example Custom State Files

This section contains some example custom state files. Use these as a basis for writing your own custom
states.
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Custom Salt States

=& 2. Example: Manage a File

=& 3. Example: Package Management

=& 4. Example: Remote Command

=& 5. Example: Service Management

Custom State to Trust a GPG Key

By default, operating systems trust only their own GPG keys when they are installed, and do not trust
keys provided by third party packages. The clients can be successfully bootstrapped without the GPG
key being trusted. However, you cannot install new third party packages or update them until the keys
are trusted.

Salt clients are set to trust SUSE tools channels GPG keys when they are bootstrapped. For all other
clients and channels, you need to manually trust third party GPG keys.

If you are bootstrapping Salt clients from the SUSE Manager Web Ul, you can use a custom Salt state to
trust the GPG key.

Procedure: Trusting a GPG Key With a Custom Salt State

1. Locate the key that you need to trust. Ensure you have the correct key, and that you also have the
fingerprint used to verify the key. This information is available from the vendor or, in some cases,
from a key server.
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2. Copy the key to a file location where the client can access it. We recommend saving it in the
/srv/www/htdocs/pub/ directory, where all user public files must be saved.

3. In the SUSE Manager Web Ul, navigate to Configuration > Channels.

4. Click [ Create State Channel].

5. In the Name field, type a name for your state. For example, GPG Key Trusts.
6. In the Label field, type a label. For example, GPG_Key_Trusts.

7. In the Description field, type a short description of the configuration your state performs. For
example, Trusts GPG Keys for CentOS.

8. In the SLS Contents field, create a state to retrieve the appropriate key from the SUSE Manager
Server and trust it on the client. The exact contents of your state varies depending on your client
operating system. For example:

rpm_trust_gpg_key:
cmd.run:
- name: rpm --import httEs://{{ salt J)illar.get']('mgr_server') }/pub/<third-party-gpg>.key
- unless: rpm -q gpg-pubkey-<key_id>
deb_trust_gpg_key:
mgrcompat.module_run:
- name: pkg.add_repo_key
- path: https://{{ salt['pillar.get']('mgr_server') }}/pub/<third-party-gpg>.key

Alternatively, you can add GPG keys to a configuration channel, using a managed file to
deploy them directly on the client.

In this case, you would use a local path to the key, rather than a URL.
. Click btn:[Update Channel] to save your state.
. Navigate to menu:Configuration[Channels] and click the name of the state you want to
assign a client to.
. Navigate to the menu:Systems|[Target Systems] tab and check the clients you want to
assign.
. Click btn:[Subscribe systems].

When the configuration file is next run on the client, the GPG key is trusted.

Alternatively, you can manage your GPG keys from your own repository hosted on an external file
management system.

Apply a custom state at highstate

To apply a custom state at highstate create a mapping in /srv/salt/top.sls. This short example maps
the test state to the system group 12:

# /srv/salt/top.sls

base:
'group_ids:12":
- match: pillar
- test

Salt File Locations and Structure

There are several ways to set up the Salt file structure. This section describes how Salt is supported and
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set up as part of SUSE Manager Server. The main configuration file s
/etc/salt/master.d/susemanager.conf.

Do not edit the /etc/salt/master.d/susemanager.conf configuration file. This file
belongs to the spacewalk-setup package and is marked as %config. When SUSE
updates the spacewalk-setup package, the susemanager.conf file is overwritten, and

o any customization is lost. Instead, add your own configuration file to the
/etc/salt/master.d/ directory. This prevents the update process from deleting your
settings from the main susemanager.conf configuration file.

Some settings from /etc/salt/master.d/susemanager.conf that can help with finding configuration
options:

# Configure different file roots. Custom salt states should only be placed in
# /srv/salt.
# Users should not touch other directories listed here.
file_roots:
base:

- Jusr/share/susemanager/salt

- Jusr/share/salt-formulas/states

- /usr/share/susemanalger/formulas/states

- /srv/susemanager/salt

- [srv/salt

# Configure different pillar roots. Custom pillar data should only be placed
#in /srv/ﬁillar.

# Users should not touch other directories listed here.

pillar_roots:

base:
- [srv/pillar

When you are working with /etc/salt/master.d/susemanager.conf, be aware that:

o Files listed are searched in the order they appear

e The first matching file found is called

The SUSE Manager Server reads Salt state data from five root directories:

/usr/share/susemanager/salt

This directory is shipped and updated with SUSE Manager and includes certificate setup and
common state logic to be applied to packages and channels.

A Do not edit or add custom Salt data to this directory.

/usr/share/salt-formulas/states
/usr/share/susemanager/formulas/states

These directories are shipped and updated with SUSE Manager or additional extensions. They
include states for Salt formulas.

A Do not edit or add custom Salt data to this directory.
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/srv/susemanager/salt

This directory is generated by SUSE Manager, based on assigned channels and packages for clients,
groups, and organizations. This directory will be overwritten and regenerated. It is the Salt
equivalent of the SUSE Manager database.

A Do not edit or add custom Salt data to this directory.

Within this directory, each organization has a sub-directory.

£ E 6. Example: SLS File Directory Structure

—— ma?_z;l\ger_org_<org id>

iles
... files needed by states (uploaded by users)...
state.sls
... other SLS files (created by users)...
For example:
manager_org_TESTING
files

motd # user created

... other files needed by states ...
motd.sls # user created
... other SLSfiles ...

/srv/salt

This directory is used for custom state data, modules, and related data. SUSE Manager does not
operate or use this directory directly. The state data in this directory is used by the client highstate,
and is merged with the total state result generated by SUSE Manager. Use this directory for custom
Salt data.

The SUSE Manager Server reads Salt pillar data from two root directories:

[usr/share/susemanager/pillar

This directory is generated by SUSE Manager. It is shipped and updated together with SUSE
Manager.

A Do not edit or add custom Salt data to this directory.

[srv/pillar

By default, SUSE Manager does not operate or use this directory directly. The custom pillar data in
this directory is merged with the pillar result created by SUSE Manager. Use this directory for custom
Salt pillar data.

0 You can use the gitfs fileserver backend to serve Salt data from git repositories. For
more information, see Specialized-guides > Salt.

The gitfs Fileserver Backend

In SUSE Manager, pygit2 is the supported Python interface to git. When pygit2 is installed the gitfs
fileserver backend is available and it is a supported feature.
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Configuration options are set in the /etc/salt/master file, or in a separate configuration file in the
/etc/salt/master.d/ directory. The basic settings are:

fileserver_backend

List of fileserver backends that the Salt master checks for files in the order they are defined. Options:

e roots: Files local on the Salt master (SUSE Manager Server). roots is required to keep the product
running. You can only enable gitfs optionally. Additionally, SUSE strongly recommends to
prefer roots (local files) over gitfs. The standard backend.

e gitfs: Files stored in one or more git repositories. The repositories are defined with
gitfs_remotes.

Example:

fileserver_backend:
- roots

- git

gitfs_remotes

List of git repositories. git://, https://, file://, or ssh:// URLs can be configured. For SSH remotes,
a scp-like syntax is also supported; for example: gitlab@gitlab.example.com:universe/setup.git.
Then you can also specify options for credentials, file locations, or branches such as pubkey, privkey,
root,base.

Example:

gitfs_remotes:
- https://example.com/myformulas/formula.git
- gitlab@gitlab.example.com:universe/setup.git:
- pubkey: /var/lib/salt/.ssh/id_rsa_gitlab.pub
- privkey: /var/lib/salt/.ssh/id_rsa_gitlab
- root: srv/salt
- base: master

ext_pillar

List of external pillar interfaces. Salt can also serve pillar data from one or more git repositories. For
syntax and options, also see the gitfs_remotes setting.

Example:

ext_pillar:
- git:
- master gitlab@gitlab.example.com:universe/setup.git:
ubkey: Rariiib/salt/.ssh/id_rsa._gitlab.pub
- pubkey: /var/lib/salt/.ssh/id_rsa_gitlab.pu
- Brivkeyz /var/lib/salt/.ssh/id_rsa_gitlab P

For more information, see:

https://docs.saltstack.com/en/latest/topics/tutorials/gitfs.html
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g https://docs.saltstack.com/en/latest/ref/configuration/master.html

Install Using Yomi

Yomi (yet one more installer) is an installer for SUSE and openSUSE operating systems. Yomi is designed
as a Salt state, and can be used for installing SUSE operating systems on new systems.

In SUSE Manager, Yomi can be used as part of provisioning new clients, as an alternative to AutoYaST.
Yomi consists of two components:

e The Yomiformula, which contains the Salt states and modules required to perform the installation.
e The operating system image, which includes the pre-configured salt-minion service.

Both components can be used independently of SUSE Manager, or integrated with it. This section
describes how to use it with SUSE Manager.

e For more information about using Yomi independently, see https://github.com/openSUSE /yomi.

e For build assets, see https://build.opensuse.org/project/show/systemsmanagement:yomi.

To use Yomi for installing a client operating system, follow this process:

o Install the yomi-formula package.
e Prepare the Salt pillar for the new installation.

e Boot the new client using the PXE boot image for Yomi.

To use Yomi with SUSE Manager, ensure you have enough available memory. To boot
o from USB or DVD image, you need at least 512 MB. To boot from a PXE server, you
need at least 2 GB.

Install the Yomi Formula

Before you begin, you need to install the Yomi formula, which is available as a package in SUSE Manager.

The yomi-formula package contains the Salt states and modules that describe the Yomi state, and the
formulas with forms to create the pillar. It also contains documentation about the different sections of
the pillar, and some examples about how to parameterize installations based on openSUSE, MicroOS, or
SLE.

The formula package performs these actions:

e Adds a new configuration file called yomi-formula.conf in the /etc/salt/master.d/ directory. This
configuration file defines the Python module and Salt states required by Yomi.

o Installs the Yomi Salt states in the /usr/share/salt-formulas/states/ directory.

o Provides some example configuration files in the /usr/share/yomi/ directory.
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o Installs the required forms and sub-forms in the /usr/share/salt-formulas/metadata/ directory.

e Provides some pillar examples in the /usr/share/yomi/pillar/ directory.

Procedure: Installing the Yomi Formula

1. On the SUSE Manager Server, at the command prompt, as root, install the yomi-formula package:

zypper in yomi-formula

2. Restart services:

systemctl restart salt-master.service

For more information about the Yomi formula, see Specialized-guides > Salt.

Install the PXE Image

To provision a new client, you need an operating system image to boot from. You can use any image that
contains a salt-minion service enabled, together with a minimal set of tools that are required during the
installation, for example parted or btrfstools.

Yomi provides an already prepared image, based on openSUSE Tumbleweed, openSUSE Leap (for
Uyuni), or SLE (for SUSE Manager). For SUSE Manager, the image is packaged as an RPM. This is donein a

similar way to how pxe-default-image is distributed.

The package installs a standard PXE OEM image generated by Kiwi, the initial kernel and initrd in the
/srv/pxe-yomi-image/ directory, and the second stage kernel, initrd and image in the /srv/pxe-yomi-
image/image directory.

Procedure: Installing the PXE Image

1. On the SUSE Manager Server, at the command prompt, as root, install the pxe-yomi-image service:

zypper in pxe-yomi-image-slel5

When you have the package installed, you can register Yomi in Cobbler.

Register Yomi in Cobbler

SUSE Manager uses Cobbler to manage the PXE boot service, so you will need to register the image in
Cobbler.

Procedure: Registering the Yomi Image in Cobbler

1. On the SUSE Manager Server, at the command prompt, as root, create a directory for the Yomi
image:
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mkdir /srv/tftpboot/pxe-yomi-image

2. Define a distribution in Cobbler, including the path to install the second stage kernel and initrd, the
location of the full image, and any further kernel options. Adjust this command to include the
correct version of the product, and the TFTP server address:

cobbler distro add \
--name=pxe-yomi-image \
--kernel=/srv/pxe-yomi-image/linux \

--initrd=/srv/pxe-yomi-image/initrd \
--boot-files='/srv/tftpboot/pxe-yomi-image/image.initrd=/srv/pxe-yomi-image/image/pxe
-yomi-image-sle15.x86_64-1.0.0.initrd /srv/tftpboot/pxe-yomi-image/image.kernel=/srv/pxe-

yomi—image/ima:jge/ xe-yomi-image-sle15.x86_64-1.0.0.kernel /srv?t tpboot/pxe-yomi-
Image/image.md5=/srv/pxe-yomi-image/image/pxe-yomi-image-sle15.x86_64-1.0.0.md5
/srv/tftpboot/pxe-yomi-image/image.config.bootoptions=/srv/pxe-yomi-image/image/pxe-
yomi-image-sle15-x86_64-1.0.0.contig.bootoptions /srv/tftpboot/pxe-yomi-
|mage/image.xz=/srv/Exe-yomi-image/image/pxe-{omi-ima e-sle15.x86_64-1.0.0.xz" \
--kernel-options="rd.kiwi.install.pxe rd.kiwi.install.image=tftp://<server-address>/pxe-
yomi-image/image.xz rd.kiwi.ramdisk ramdisk_size=2097152 net.ifnames=1"'

By default, the salt-minion service in pxe-yomi-image is configured to find the Salt master under the salt
address. If the DNS server is not able to resolve this address, you need to adjust the kernel-options
parameter from the Cobbler command that register the distribution, and add a new kernel command
line of ym.master=master_address. This will override the default configuration for the salt-minion.

Procedure: Registering the Yomi Profile in Cobbler

1. On the SUSE Manager Server, at the command prompt, as root, define a profile in Cobbler based on
the image.

cobbler profile add \
--name pxe-yomi-profile \
--distro=pxe-yomi-image

2. OPTIONAL: Create a system in Cobbler. If you know the MAC address for the new client to be
provisioned, you can have it boot directly from the Yomi image.

cobbler system add \
--name=yomi \
--mac=00:11:22:33:44:55\
--profile=pxe-yomi-profile

3. When the new node has been provisioned, remove the temporary Cobbler system:

cobbler system remove --name=yomi

Example Salt Pillar Preparation

The parameters of the new installation are defined with a Salt pillar. The pillar includes parameters that
the Yomi state requires during the installation, including the partitions, file systems, repositories,
packages installed, and services enabled.
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The pillar is defined using the formulas with forms. In this example, we prepare the pillar for a minimal
openSUSE Tumbleweed installation. You can find examples for MicroOS or SLES in the example
directory /usr/share/yomi/pillar/.

To begin, boot the client that you want to provision using the Yomi PXE boot image, using the Cobbler
procedures described earlier in this section.

When the salt-minion service is running on the new client, accept the key by navigating to Salt > Keys.
When the key is accepted, you can view and manage the client by navigating to Systems > Overview.
Navigate to the Formulas tab, and add all the Yomi Installer formulas to the client. When you have added
all the formulas, complete the forms and sub-forms. This section outlines each form and provides
example settings for a minimal installation. For a detailed explanation of every option, see Specialized-

guides > Salt.

Yomi

The Yomi form contains some general configuration options. For example, the keyboard language
and layout, the locale information, and the option to perform a full reset of the system after
provisioning.

For this example, set the Reboot parameter to yes.

Yomi Storage

This sub-form provides information about the devices, partitioning, file system (including the BtrFS
subvolumes, for example), and LVM and RAID configuration.

For this example, we assume that the new client has a single device named /dev/sda, and that it belongs
to a non-UEFI system. In this case, we have only three partitions: one for the boot loader, one for swap
and one for the system. We also expect to have an ext4 file system for the root directory.

Device 1:

e Device: /dev/sda
o Label: GPT

e Initial Gap: 1 MB
Create three partitions:

e Partition 1:
O Partition Number: 1
O Partition Size: 1 MB
O Partition Type: boot
e Partition 2:
O Partition Number: 2

O Partition Size: 1024 MB
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O Partition Type: swap
e Partition 3:

O Partition Number: 3

O Partition Size: rest

O Partition Type: linux
Create two file systems:

o Filesystem 1:
O Partition: /dev/sda2
O Filesystem: swap

o Filesystem 2:
O Partition: /dev/sda3
O Filesystem: ext4

©  Mountpoint: /
Yomi Bootloader
This sub-form provides details required for GRUB.
Set these parameters:

e Device: /dev/sda

e Theme: selected
The Kernel parameter can be used for the GRUB append section.

Yomi Software

This form provides the different repositories and packages to install. You can also register the
product in this form, using SUSEConnect, and install the different modules after registering.

For this example we are going to install a very minimal openSUSE Tumbleweed distribution, using
publicly available repositories. For production deployments, you will need to provide a local repository.

Add a new repository: * Repository Name: repo-oss * Repository URL: http://download.opensuse.org/
tumbleweed/repo/oss/

Add these packages: * pattern:enhanced_base * glibc-locale * kernel-default
You can also add patterns and products, together with packages, by using the correct prefix.

Yomi Services

By default Yomi is installed with the salt-minion service, but you must enable it.
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Add a new enabled service:

e Service 1:

O Service: salt-minion

Yomi Users
This form sets out the system users. In this example, we have a single root user. To provide a
password, you must use the hashed version of the password, not the plain text. This
behavior is set to be changed in future versions of Yomi.
e Userl:

O Username: root

©  Password Hash: $1SwYJUgpM5SRXMMeASDc035eXNbYWFLO0

Monitor the Installation

You can monitor the installation as it progresses, using the monitor tool from Yomi. You can continue
monitoring as the highstate is applied to the new client. To use the tool, you will need to have enabled
Events in the Yomi formula, and have the salt-api service activated.

For more information about the salt-api service, and how to use the monitor tool, see
https://github.com/openSUSE/yomi.

Configuration Modules

Salt uses execution and state modules to define, apply, and orchestrate configuration of your devices.
SUSE Manager provides a set of modules called Uyuni configuration modules, that you can use to
configure both SUSE Manager and Uyuni Servers.

You can use the Uyuni configuration modules directly or using SLS files. They are are especially useful if
you have multiple SUSE Manager Servers, for example in Hub installations, but they are also useful for
smaller installations.

For more information about using Hub, see Specialized-guides > Large-deployments.
You can use Uyuni configuration modules to configure:

o Organizations

e Users

e User permissions
e System groups

e Activation Keys

For more information about Salt execution modules, see https://docs.saltstack.com/en/latest/topics/
tutorials/modules.html.
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For more information about Salt state modules, see https://docs.saltstack.com/en/latest/topics/
tutorials/starting_states.html.

Install Configuration Modules

The Uyuni configuration modules are available in the uyuni-config-modules package. On the SUSE
Manager Server, at the command prompt, as root, use this command:

zypper in uyuni-config-modules

This package also installs detailed API descriptions, indications on pillar settings, and examples. When
you have installed the package, navigate to /usr/share/doc/packages/uyuni-config-modules/.

Salt Formulas

Formulas are collections of Salt States that contain generic parameter fields. Formulas allow for reliable
reproduction of a specific configuration. Some formulas are supplied by SUSE, or you can install
formulas from RPM packages or an external git repository.

Formulas work best for large, non-trivial, configurations. For smaller tasks, use a state rather than a
formula. Formulas and states both act as a kind of configuration documentation. When you have written
and stored the configuration, they provide a snapshot of your infrastructure.

Formula data can be managed using the XMLRPC API.

You can use the SUSE Manager Web Ul to apply SUSE Manager formulas. The most commonly used
formulas are documented in this section.

Alternatively, you can use pre-written formulas as a starting point for your own custom formulas. Pre-
written formulas are available from https://github.com/saltstack-formulas.

For more information on custom formulas, see Specialized-guides » Salt.

Formulas Provided by SUSE Manager

Some formulas are installed by default with SUSE Manager. Other official formulas can be installed as
RPM packages. When the formula is installed, you can activate them using the SUSE Manager Web UI.

For information about writing custom formulas, see Specialized-guides > Salt.

Install Formulas with Zypper

Formulas are provided in the SUSE Manager pool software channel.

If a formula uses the same name as an existing Salt state, the two names will collide,
and could result in the formula being used instead of the state. Always check states
and formulas to avoid name clashes.
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Procedure: Installing Formulas with Zypper

1. On the SUSE Manager Server, at the command prompt, search for available formulas:

zypper se --type package formula

2. Get more information about a formula:

zypper info <formula_name>

3. On the SUSE Manager Server, at the command prompt, as root, install the formula:

zypper in <formula_name>

Activate Formulas from the Web Ul

Formulas provided by SUSE Manager, or formulas that you have installed, can be activated using the
SUSE Manager Web Ul.

Procedure: Activate Formulas from the Web Ul

1. In the SUSE Manager Web Ul, navigate to Systems > List, select the client you want to activate the
formula for.

2. Navigate to the Systems > Formulas tab, and check the formula you want to activate.
3. Click [ Save].
4. Navigate to the new subtab for the formula, and configure the formula as required.

5. Apply the highstate.

Bind Formula

The Bind formula is used to configure the Domain Name System (DNS) on the branch server. POS
terminals will use the DNS on the branch server for name resolution of Saltboot specific hostnames.

When you are configuring the Bind formula for a branch server with a dedicated internal network, check
that you are using the same fully qualified domain name (FQDN) on both the external and internal
branch networks. If the FQDN does not match on both networks, the branch server will not be
recognized as a proxy server.

o The following procedure outlines a standard configuration with two zones. Adjust it
to suit your own environment.

Zone lis a regular domain zone. Its main purpose is to resolveSaltboot hostnames such as TFTP, FTP, or
Salt. It can also resolve the terminal names if configured.

Zone 2 is the reverse zone of Zone 1. Its main purpose is to resolve IP addresses back to hostnames.
Zone 2 is primarily needed for the correct determination of the FQDNs of the branch.
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Procedure: Configuring Bind with Two Zones

1

2.

Check the Bind formula, click Save, and navigate to the Formulas > Bind tab.

In the Config section, select Include Forwarders.

. Inthe Configured Zones section, use these parameters for Zone 1:

© In the Name field, enter the domain name of your branch network
branch1.example.com).

O Inthe Type field, select master.

. Click Add itemto add a second zone, and set these parameters for Zone 2:

© In the Name field, use the reverse zone for the configured IP range
com.example.branch1).

O Inthe Type field, select master

. Inthe Available Zones section, use these parameters for Zone 1:

© In the Name field, enter the domain name of your branch network
branch1.example.org).

O IntheFilefield, type the name of your configuration file.

. Inthe Start of Authority (SOA) section, use these parameters for Zone 1:

O In the Nameserver (NS) field, use the FQDN of the branch server
branchserver.branch1.example.org).

O Inthe Contact field, use the email address for the domain administrator.

O Keep all other fields as their default values.

(for

(for

(for

(for

example:

example:

example:

example:

. Inthe Records section, in subsection A, use these parameters to set up an A record for Zone 1:

O In the Hostname field, use the hostname of the branch server (for example: branchserver).

© Inthe IP field, use the IP address of the branch server (for example, 192.168.1.5).

O Intheinput box, use the hostname of the branch server (for example: branchserver).

. Inthe Records section, subsection NS, use these parameters to set up an NS record for Zone 1:

. Inthe Records section, subsection CNAME, use these parameters to set up CNAME records for Zone 1:

O In the Key field, enter tftp, and in the Value field, type the hostname of the branch server (for

example: branchserver).

O Click Add Item. In the Key field, enter ftp, and in the Value field, type the hostname of the branch

server.

O Click Add Item. In the Key field, enter dns, and in the Value field, type the hostname of the branch

server.

O Click Add Item. In the Key field, enter dhcp, and in the Value field, type the hostname of the branch

server.

O Click Add Item. In the Key field, enter salt, and in the Value field, type the FQDN of the branch

server (for example: branchserver.branch1.example.org).
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10. Set up Zone 2 using the same parameters as for Zone 1, but ensure you use the reverse details:
O The same SOA section as Zone 1.
©  Empty A and CNAME records.
O Additionally, configure in Zone 2:

B Generate Reverse field by the network IP address set in branch server network formula (for
example, 192.168.1.5/24).

B For Zones should specify the domain name of your branch network (for example,
branch1.example.org).

11. Click [ Save Formula ] to save your configuration.

12. Apply the highstate.

Reverse name resolution on terminals might not work for networks that are inside
one of these IPv4 private address ranges:

e 10.0.0.0/8
e 172.16.0.0/12

o e 192.168.0.0/16

If you encounter this problem, go to the Options section of the Bind formula, and click
[Add item ]:

e IntheOptions field, enter empty-zones-enable.

e IntheValue field, select No.

Branch Network Formula

The Branch Network formula is used to configure the networking services required by the branch server,
including DHCP, DNS, TFTP, PXE, and FTP.

o The formula is used only for connecting SUSE Manager Proxy 4.3. with SUSE Manager
Server 5.0. Do not use this formula if you want to connect SUSE Manager Proxy 5.0.

Set Up a Branch Server Networking

The branch server can be configured to use networking in many different ways. The most common ways
provide either a dedicated or shared LAN for terminals.

Set Up a Branch Server with a Dedicated LAN

In this configuration, the branch server requires at least two network interfaces: one acts as a WAN to
communicate with the SUSE Manager server, and the other one acts as an isolated LAN to communicate
with terminals.

This configuration allows for the branch server to provide DHCP, DNS, TFTP, PXE, and FTP services to
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terminals. These services can be configured with Salt formulas in the SUSE Manager Web UI.

Procedure: Setting Up a Branch Server with a Dedicated LAN

1. In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Inthe Branch Network section, set these parameters:
O Keep Dedicated NIC checked.
O In the NIC field, enter the name of the network device that is connected to the internal LAN.
O Inthe IP field, enter the static IP address to be assigned to the branch server on the internal LAN.
O Inthe Netmask field, enter the network mask of the internal LAN.
3. Check Enable Route if you want the branch server to route traffic from internal LAN to WAN.
O Check Enable NAT if you want the branch server to convert addresses from internal LAN to WAN.
O Select the bind DNS forwarder mode.
O Check DNS forwarder fallback if you want to rely on an external DNS if the branch DNS fails.

O Specify the working directory, and the directory owner and group.

Set up a Branch Server with a Shared Network

In this configuration, the branch server has only one network interface card, which is used to connect to
the SUSE Manager server as well as the terminals.

This configuration allows for the branch server to provide DNS, TFTP, PXE, and FTP services to terminals.
These services can be configured with Salt formulas in the SUSE Manager Web Ul. Optionally, the branch
server can also provide DHCP services in this configuration.

If DHCP services are not provided by the branch server, ensure that your external
DHCP configuration is set correctly:
e Thenext-server option must point to the branch server for PXE boot to work.

o e The filename option must correctly identify the network boot program (by
default, this is /boot/pxelinux).

e The domain-name-servers option must point to the branch server for correct host
name resolution.

Procedure: Setting Up a Branch Server with a Shared Network

1. In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Inthe Branch Network section, set these parameters:
O Keep Dedicated NIC unchecked.

O Enable services on the branch server s firewall. Ensure you include DNS, TFTP, and FTP
services.
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O Select the bind DNS forwarder mode.
©  Check DNS forwarder fallback if you want to rely on an external DNS if the branch DNS fails.

O Specify the working directory, and the directory owner and group.

Set up Branch Server Terminal Naming

In this configuration it is required to fill at least Branch Identification. This identifies Branch Server in
Retail subsystem and is also used to better organize terminals with their respective branch servers.

Procedure: Setting up a Branch Server Identification

1. In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Inthe Terminal Naming section, enter the Branch Identification string.
3. Click [ Save ] to save your changes.

4. Apply the highstate.

It is also possible to set various options about terminal naming, for more information about terminal
naming see Retail > Retail-terminal-names.

DHCPd Formula

The DHCPd formula is used to configure the DHCP service on the branch server.

Procedure: Configuring DHCP

1. In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Check the Dhepd formula, and click [ Save .
3. Navigate to the Formulas > Dhcpd tab, and set these parameters:

© In the Domain Name field, enter the domain name for the branch server (for example:
branch1.example.com).

O IntheDomain Name Server field, enter either the IP address or resolvable FQDN of the branch DNS
server (for example: 192.168.1.5).

O In the Listen Interfaces field, enter the name of the network interface used to connect to the
local branch network (for example: eth1).

4. Navigate to the Network Configuration (subnet) section, and use these parameters for Network1:

O In the Network IP field, enter the IP address of the branch server network (for example:
192.168.1.0).

© In the Netmask field, enter the network mask of the branch server network (for example:
255.255.255.0).

O In the Domain Name field, enter the domain name for the branch server network (for example:
branch1.example.com).
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10.

11.

12.
13.

. In the Dynamic IP Range section, use these parameters to configure the IP range to be served by the

DHCP service:
O Inthefirst input box, set the lower bound of the IP range (for example: 192.168.1.51).

O Inthe second input box, set the upper bound of the IP range (for example: 192.168.1.151).

. In the Broadcast Address field, enter the broadcast IP address for the branch network (for example:

192.168.1.255).

. In the Routers field, enter the IP address to be used by routers in the branch server network (for

example: 192.168.1.5).

. In the Next Server field, enter the hostname or IP address of the branch server (for example:

192.168.1.5).

. In the Filename field, if you are booting a client using PXE, type the path to the PXE bootloader. There

is usually no need to change the default value of /boot/pxelinux.0.

In the Filename Efi field, if you are booting a UEFI client using PXE, type the path to the PXE
bootloader. There is usually no need to change the default value of /boot/shim.ef.

In the Filename Http field, if you are booting a UEFI client using HTTP, type http://branchserver/
saltboot/boot/shim.efi.

Click [ Save Formula ] to save your configuration.

Apply the highstate.

Image Synchronization Formula

The Image Synchronization formula is used to configure when OS images are synchronized to the branch
server, and to specify which images to synchronize.

If this formula is not enabled, synchronization must be started manually, and all images will be
synchronized.

Procedure: Configuring Image Synchronization

1

In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Check the Image Synchronize formula, and click [ Save ].

3. Navigate to the Formulas > Image Synchronize tab, and set these parameters:

O Check the Include Image Synchronization in Highstate field to have image synchronization
occur every time highstate is applied. This ensures that you do not have to perform image
synchronization manually, however it requires a high bandwidth environment.

O In the Synchronize only the listed images field, click [ Add item] to add the images you want
to have synchronized automatically. Alternatively, you can leave this list blank to have all
images synchronized.

4. Click [ Save Formula ] to save your configuration.

5. Apply the highstate.
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The Image Synchronization state does not delete cached images. If you are running
out of disk space, check the size of the Salt client cache directory, and delete it if
required. By default, the directory is located at /var/cache/salt/minion.

Liberate Formula

The liberate formula migrates systems from EL clients such as AlmaLinux, CentOS 7, Oracle Linux9,
Rocky Linux9, or even Red Hat Enterprise Linux9 to SUSE Liberty Linux. With this formula the
conversion will take place during the client onboarding on SUSE Manager.

o The Liberate Formula comes preinstalled within the server container.

Configure SUSE Manager

To provide all the software channels for SUSE Liberty Linux on the SUSE Manager Server, proceed as
follows.

Procedure: Providing SUSE Customer Center credentials
1. Sign in to SUSE Customer Center at https://scc.suse.com.
2. Navigate to My Organization, and select your organization.

3. Navigate to Users > Organization Credentials and take note of your organization username and
password.

4. In the SUSE Manager Web Ul, navigate to Admin > Setup Wizard > Organization Credentials to add
the credentials to your SUSE Manager Server.

5. Click [ Add new credential ], and enter the SUSE Customer Center username and password noted in
a previous step.

Procedure: Synchronizing the SLL/SLES-ES channels:

1. In the SUSE Manager Web Ul, navigate to Admin > Setup Wizard > Products

2. Select the SUSE Liberty Linux Channels that you will use:
O EL7LTSS:SUSE Linux Enterprise Server with Expanded Support LTSS 7 x86_64
O EL7:SUSE Linux Enterprise Server with Expanded Support 7 x86_64
O EL8:RHEL or SLES ES or Cent0S 8 Base
O EL9:RHEL and Liberty 9 Base

3. Click the top right button [ Add products ].

Initial sychronization can take considerable time. You can check progress by accessing the server
machine via SSH and monitoring the logs using:

tail -f /var/log/rhn/reposync/*
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Procedure: Creating one Activation Key per SUSE Liberty Linux parent
channel

1. Note: Activation Keys are the way to register systems and automatically assign them to the required
software and configuration channels corresponding to them.

2. In the SUSE Manager Web Ul, navigate to Systems > Activation Keys, and click the top right button [
Create key ].

3. Inthe Activation Key dialog, set the fields:

Description

Enter some text describing the activation key.

Key

Enter the identifier of the key. For example [literals119-default for EL 9 systems. Note: Keys will
have a numeric prefix depending on the organization, so that they are unique.

Usage

Leave blank.

Base Channel

Select one base channel:

O EL7LTSS: RES-7-LTSS-Updates for x86_64
O ELT:RHEL x86_64 Server 7
O EL8:RHEL8-Pool for x86_64

©  EL9:EL9-Pool for x86_64

Child Channel

Include all child channels.

Add-On system type

Leave all blank.

Contact Method

7|22k

L— HA

Universal Default

Leave unchecked.

4. Click [ Create Activation Key ].

Add Liberate formula and assign it to activation keys

When installed, the formula can be assigned to an Activation Key by creating a System Group:
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Procedure: Assigning system group and assigning liberate formula

1. In the SUSE Manager Web Ul, navigate to Systems > System Groups, and click the [ Create Group ]
button in top right corner.

2. In the dialog, fill in the following data:

Name

liberate

Description

Systems to be converted to SUSE Liberty Linux

3. From the liberate System Group page, navigate go to the Formulas tab.
4. Select the Liberate formula, and click [ Save ]. A new tab called Liberate will appear.

5. Onthe Liberate tab, you see the Reinstall all packages after conversion option. Keep it checked if
you want to reinstall all the packages during the migration. This way you ensure all the packages will
have SUSE signatures and no previous package will be kept. If you do not want to change the state
of your system during the migration, uncheck this option and click the [ Save Formula ] button. In
this case, you can re-install the packages later.

Now a system group exists that has assigned the Liberate formula. This formula will be applied only
once to migrate the system to SUSE Liberty Linux, even if you run it multiple times. With the next
procedure, assign the system group to the Activation Key.
Procedure: Assigning the system group to the Activation Key

1. In the SUSE Manager Web Ul, navigate to Systems > Activation Keys.

2. Select the Activation Key, for example s119-default for the EL 9 systems.

3. From the Activation Key page navigate to the Groups > Join tab, select the liberate group, and click

the [ Join Selected Groups ] button. The group will be assigned to the Activation Key

Procedure: Applying migrate directly during registration
1. From the Activation Key page, navigate to the Details tab.

2. Navigate to the Configuration File Deployment section, and checkb the Deploy configuration files
to systems on registrationoption.

3. Click [ Update Activation Key 1.

When you register a system with this key it will perform the migration automatically.

Register a new system and proceed to the migration

There are two ways to onboard (or register) a new client with the Activation Key:
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Client-configuration > Registration-webui

This is intended for a one-off registration or for testing purposes.

Client-configuration > Registration-bootstrap

This is intended to be used for mass registration.

For already registered clients

Software channels, system group membership, and formulas can be assigned to any already registered
client. This method makes use of the bootstrap script mentioned above.

Procedure: Creating an Reactivation key

1. In the SUSE Manager Web Ul, open the System Details page of any registered client you want to
migrate to SUSE Liberty Linux.

2. Click the Reactivation tab. If there is already a key listed, you can use it. If not, click [ Generate New
Key ], and copy the entire key. The key will start with re-.

3. SSH into this client and set the environment variable to be the key that you copied:
export REACTIVATION_KEY=re-XXXXXXXXXXXXXX

4. Run the bootstrap script from Client-configuration > Registration-bootstrap, and the system will
re-register using the same profile as before, but with the newly assigned SUSE Liberty Linux context.

Monitoring Formula

The monitoring services in SUSE Manager are configured using formulas with forms. The package is
installed by default, and contains these formulas:

e Grafana
e Prometheus

e Prometheus Exporters
For more information about using monitoring, see Administration > Monitoring.

Grafana

Procedure: Configuring the Grafana Formula

1. Navigate to the Formulas > Grafana tab, and set these parameters in the Grafana section:

O Check the Enabled box to enable Grafana visualizations.
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Initial admin password is used on the first run only, and Grafana Ul prompts

o to change it. This field cannot be used to change the Grafana password. For
more information on how to change the password, see Administration >
Monitoring.

2. For each Prometheus data source you want to use, in the Datasources > Prometheus section, click [
+], and set these parameters:

(0]

o

In the Datasource name field, type a name to identify the data source.

In the Prometheus URL field, type the used protocol, the location of the Prometheus server, and
append port 9090. For example, http://example.com:9090. In case TLS encryption is enabled in
Prometheus formula make sure to use https protocol and FQDN.

In the fields Prometheus server username and Prometheus server password, enter basic
authentication credentials for Prometheus server matching the ones in Prometheus formula.

3. In the Dashboards section, check the dashboards you want to use:

o

(0]

(0]

(0]

(©]

o

o

Uyuni server dashboard

Uyuni clients dashboard
PostgreSQL dashboard

Apache HTTPD dashboard
Kubernetes cluster dashboard
Kubernetes etcd dashboard

Kubernetes namespaces dashboard

4. Click [ Save Formula ] to save your configuration.

Prometheus

Procedure: Configuring the Prometheus Formula

1. Navigate to the Formulas > Prometheus tab, and set these parameters in the Prometheus section:

o

o

Check the Enabled box to enable Prometheus monitoring.

In the Scrape interval field, type the frequency of data scraping, in seconds. For example, 15 will
scrape data every fifteen seconds.

In the Evaluation interval field, type the frequency of rules evaluation, in seconds. For example,
15 will evaluate alerting and aggregation rules every fifteen seconds.

2. Inthe TLS section, set these parameters:

o

o

o

o

(0]

Check the Enabled box to enable the secure configuration on Prometheus server.
Inthe Server Certificate field, type the path to the TLS server certificate.

In the Server Key field, type the path to the TLS server key.

In the User field, type the user name for Prometheus server.

In the Password Hash field, type the password for Prometheus server hashed with bcrypt.

_| Salt Formulas 69 /159


http://example.com:9090

3. Inthe Uyuni Server section, set these parameters:
O Check the Enabled box to enable monitoring on this server.

O Check the Autodiscover clients box to enable Prometheus to automatically find and monitor
new clients when they are added to the server.

O Inthe Username field, type the user name of the Prometheus account on the server.

O Inthe Password field, type the password of the Prometheus account on the server.

O Inthe Targets TLS section, set these parameters:
B Check the Enabled box to enable the secure configuration for auto-discovered targets.
B IntheCA Certificate field, type the path to the Certificate Authority certificate.
B IntheClient Certificate field, type the path to the TLS client certificate for authentication.
B IntheClient Key field, type the path to the TLS client key for authentication.

4. In the Alerting section, set these parameters:
O Checkthe Enable local Alertmanager service boxto enable the alert manager service.

O ChecktheUse local Alertmanager box to use the local alert manager service.

5. For each alert manager you want to use, in the Alerting > Alertmanagers section, click [ +], and set
these parameters:

O In the IP Address:Port field, type the location of the alert manager target, including the port
number.

6. To use arule file, in the Alerting > Rule Files section, click [ +], and set these parameters:
O IntheRule Files field, type the location of the rule file you want to use.

7. To add a custom scrape configuration, in the User defined scrape configurations section, click [+],
and set these parameters:

© Inthe Job name field, type a unique job name for your configuration.

O In the Files field, type the location pattern of file service discovery files you want to use. For
more information, see the upstream documentation https://prometheus.io/docs/
prometheus/latest/configuration/configuration/#file_sd_config.

8. Click [ Save Formula ] to save your configuration.

The formula does not generate and deploy the TLS certificates and keys. Ensure the
files are present on the Salt client and readable for the user prometheus before

o applying the highstate. For more information about generating client and server
certificates, see Administration > Monitoring.

Prometheus Exporters

Procedure: Configuring the Prometheus Exporters Formula

1. Navigate to the Formulas > Prometheus Exporters tab, and set these parameters in the Node
Exporter section:
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O Check the Enabled box to enable the node exporter.

O In the Arguments field, type any customized arguments for this exporter.

--web.listen-address=":9100".
2. Inthe Apache Exporter section:

O Check the Enabled box to enable the Apache exporter.

O In the Arguments field, type any customized arguments for this exporter.

--telemetry.address=":9117".
3. Inthe Postgres Exporter section:
O Check the Enabled box to enable the PostreSQL exporter.

O IntheData source Name field, type the name of the data source to use.

O In the Arguments field, type any customized arguments for this exporter.

--web.listen-address=":9187".
4. Inthe TLS section:
O  Check the Enabled box to enable the secure configuration.
O Inthe CA Certificate field, type the path to the Certificate Authority certificate.
O IntheServer Certificate field, type the path to the TLS server certificate.
O Inthe Server Key field, type the path to the TLS server key.

5. Click [ Save Formula ] to save your configuration.

File-based service discovery

For example,

For example,

For example,

It is possible to define monitored targets using file-based service discovery provided in the Prometheus

formula. This is a basic example demonstrating the usage:

"targets": [ "<client1>:9100", "<client2>:9100" ],
"labels": {

"role": "<suma-client>",

"job": "<suma-refclient>"

}
%
"targets": [ "<server>:80"],
"labels": {
"role": "<suma-server>",

"job": "<suma-refhost>" )
"__metrics_path__": "/rFm/metrlcs“

For more information, see https://prometheus.io/docs/guides/file-sd/.

TLS certificates and keys

The formula does not generate and deploy the TLS certificates and keys. Ensure the files are present on
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the Salt client and readable for the user prometheus before applying the highstate. For more information
about generating client and server certificates, see Administration » Monitoring.

Activate Forms

When you have completed and saved all the forms, apply the highstate.

For more information about using monitoring, see Administration > Monitoring.

PXE Formula

The PXE formula is used to configure PXE booting on the branch server.

o The formula is used only for connecting SUSE Manager Proxy 4.3. with SUSE Manager
Server 5.0. Do not use this formula if you want to connect SUSE Manager Proxy 5.0.

Procedure: Configuring PXE Booting

1. In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Select the Pxe formula, and click Save.

3. Navigate to the Formulas > Pxe tab, and set these parameters:
O IntheKernel Filename field, keep the default value.
O IntheInitrd Filename field, keep the default value.

O If the terminals connecting to this branch server are running arm64 architecture, check the
Enable ARM64 UEFI boot box. Leave unchecked for x86-64.

O IntheKernel Filename for ARM64 field, keep the default value.
© IntheInitrd Filename for ARM64 field, keep the default value.

O IntheKernel Command Line Parameters field, keep the default value. For more information about
possible values, see Saltboot Kernel Command Line Parameters.

O In the PXE root directory field, enter the path to the Saltboot directory (for example,
/srv/saltboot).

4. Click Save Formula to save your configuration.

5. Apply the highstate.

Saltboot Kernel Command Line Parameters

Saltboot supports common kernel parameters and Saltboot-specific kernel parameters. All the
parameters can be entered in the Kernel Command Line Parameters field of the PXE formula.

kiwidebug=1
Starts a shell on tty2 during boot and enables debug logging in Salt.
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Do not use this parameter in a production environment as it creates a major
A security hole. This parameter should be used only in a development environment
for debug purposes.

MASTER

Overrides auto-detection of the Salt master. For example:

MASTER=myproxy.domain.com

SALT_TIMEOUT

Overrides the local boot fallback timeout if the Salt master does not apply the Saltboot state within
this timeout (default: 60 seconds). For example:

SALT_TIMEOUT=300

DISABLE_HOSTNAME_ID

If the terminal has a hostname assigned by DHCP, it is by default used as a minion ID. Setting this
option to 1 disables this mechanism, and SMBios information will be used as a minion ID.

DISABLE_UNIQUE_SUFFIX

Setting this option to 1 disables adding random generated suffix to terminal minion ID.

If you set this parameter make sure your terminal has either a unique hostname provided by DHCP
and DNS, or the terminal hardware comes with a unique serial number stored in its SMBios memory.
Otherwise there is a risk of terminal minion ID duplicity, and bootstrapping the minion will fail.

The following parameters (MINION_ID_PREFIX, salt_device, root) are usually autoconfigured and should
be used only in specific conditions such as debugging or development:

MINION_ID_PREFIX

Branch ID set in the Branch Network formula form.

salt_device

Device that contains the Salt configuration.

root

Device that contains the already deployed root file system. Used for falling back to local boot.

Saltboot Formula

The Saltboot formula is used to configure disk images and partitioning for the selected hardware type.

o The Saltboot formula is meant to be used as a group formula. Enable and configure
Saltboot formula for hardware type groups.
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o To apply changes to a terminal, terminal needs to be restarted. Applying highstate
does not have any effect on running terminals.

Procedure: Configuring the Hardware Type Group with Saltboot
1. Open the details page for your new hardware type group, and navigate to the Formulas tab.
2. Select the Saltboot formula and click [ Save ].
3. Navigate to the Formulas > Saltboot tab.
4. Inthe Disk 1section, set these parameters:
O IntheDisk symbolic ID field, enter a custom name for the disk (for example, disk1).
O IntheDevice type field, select DISK.

O In the Disk device field, select the device that corresponds to the device name on the target
machine or asterisk *, see Disk Selection in Saltboot Formula.

© IntheRAID level field, leave it empty.
O IntheDisk Label field, select gpt.
5. Inthe Partition section, set these parameters for Partition 1:
O InthePartition symbolic ID field, enter a custom name for the partition (for example, p1).
© InthePartition size use value 500.
O IntheDevice mount point use /boot/efi.
O IntheFilesystem format use vfat.
O Inthe0S Image to deploy field, leave it empty.
© InthePartition encryption password field, leave it empty.
O InthePartition flags use boot.
6. In the Partition section, set these parameters for Partition 2:
© InthePartition symbolic IDfield, enter a custom name for the partition (for example, p2).
O InthePartition size field, specify a size for the partition in Mebibytes (MiB).
O IntheDevice mount point field, select a location to mount the partition (for example, /data).
O IntheFilesystem format field, select your preferred format (for example, xfs).
O Inthe0S Image to deploy field, leave it empty.

O In the Partition encryption password field, enter a password if you want to encrypt the
partition.

O InthePartition flags field, leave it empty.
7. Inthe Partition section, set these parameters for Partition 3:
O InthePartition symbolic IDfield, enter a custom name for the partition (for example, p3).

© InthePartition size field, specify a size for the partition in Mebibytes (MiB).
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O IntheDevice mount point field, leave it empty.
O IntheFilesystem format field, select swap.
O Inthe0S Image to deploy field, leave it empty.

O In the Partition encryption password field, enter a password if you want to encrypt the
partition.

O InthePartition flags field, select swap.
8. Inthe Partition section, set these parameters for Partition 4:
O InthePartition symbolic IDfield, enter a custom name for the partition (for example, p4).

O In the Partition size field, leave it empty. This will ensure the partition uses up all remaining
space.

O IntheDevice mount point field, select /.

O IntheFilesystem format field, leave it empty.

O Inthe0S Image to deploy field, enter the name of the image to deploy.

O Inthe Image version field, leave it empty. This will ensure you use the latest available version.

O In the Partition encryption password field, enter a password if you want to encrypt the
partition.

© InthePartition flags field, leave it empty.

9. Click [ Save Formula ] to save your configuration.

Special Partition Types

The Saltboot formula helps you with setting up special partition types.

o For terminal to be able to boot locally, either BIOS grub or EFI partition must be
configured.

BIOS grub Partition

A BIOS grub partition is needed for local booting from a GPT disk on non-EFl machines. For more
information, see https://en.wikipedia.org/wiki/BIOS_boot_partition.

In the formula, enter the following options:

Partition Symbolic ID: p1
Partition Size (MiB): 50
Partition Flags: bios_grub

Leave the other fields empty.

EFI Partition

An EFI partition is needed for local booting on EFl machines, Partition Table Type must be GPT. For more
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information, see https://en.wikipedia.org/wiki/EF|_system_partition.

In the formula, enter the following options:

Partition Symbolic ID: p1
Partition Size (MiB): 500
Device Mount Point: /boot/efi
Filesystem Format: vfat
Partition Flags: boot

Leave the other fields empty.

Disk Selection in Saltboot Formula

When there is only one disk present on target hardware (including USB drives), use an asterisk * to
automatically select the disk device.

When there are multiple disks, use an asterisk * in the device path. In this example, SATA disks are
differentiated from USB disks:

/dev/disk/by-path/*-ata-1
/dev/disk/bg-gath/*usb*

If the entered value does not contain /, the entered value is automatically prepended by /dev/disk/by-
path/. For example, *usb* is the same as /dev/disk/by-path/*usb*.

If you prefer to select specific devices, you can this format in the disk device field:

e symbolic names (for example: /dev/sda)
o by-path (for example: /dev/disk/by-path/..)
o by-id (for example: /dev/disk/by-id/--")

To see a list of available devices from the command prompt, press Esc while waiting for key approval.

Troubleshooting the Saltboot Formula

msdos Disklabel Limitations

On the msdos disk label, you can create a maximum of four primary partitions. Extended partitions
are not supported. If you need more than four partitions, use the GPT disk label instead.

TFTPd Formula

The TFTPd formula is used to configure the TFTP service on the SUSE Manager for Retail branch server.

o The formula is used only for connecting SUSE Manager Proxy 4.3. with SUSE Manager
Server 5.0. Do not use this formula if you want to connect SUSE Manager Proxy 5.0.

Procedure: Configuring TFTP
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1. In the SUSE Manager Web Ul, open the details page for the branch server, and navigate to the
Formulas tab.

2. Select the Tftpd formula, and click [ Save ].
3. Navigate to the Formulas > Tftpd tab, and set these parameters:

O In the Internal Network Address field, enter the IP address of the branch server (for example:
192.168.1.5).

O In the TFTP Base Directory field, enter the path to the Saltboot directory (for example,
/srv/saltboot).

O IntheRun TFTP Under User field, enter saltboot.
4. Click [ Save Formula ] to save your configuration.

5. Apply the highstate.

Virtualization Guest Formula

The Virtualization Guest formula is used to configure settings for virtual machine.

Open the Tuning pull-down checklist and select from the following virtual machine performance tuning
settings:
e Disable IRQ balancing.

o Disable Kernel Samepage Merging (KSM). Reduces performance overhead by not sharing memory
across virtual machines.

e Optimizations for KVM passed through host CPU. Requires the KVM hint-dedicated option to be set
on the VM definition.

When configured, click [ Save Formula ] to save your configuration, and apply the highstate.

Virtualization Host Formula

The Virtualization Host formula is used to configure settings for a virtualization host.

Hypervisor

Select KVM or Xen as the hypervisor.

Create default storage pool
Create default virtual network

o Default pool: Open the pull-down list and enter the directory name of the default storage pool.

o Default net: Open the pull-down list and configure the default virtual network by setting the Mode
(NAT or Bridge) and the Bridge name.

Tuning

Enable IOMMU support (x86_64).
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When configured, click [ Save Formula ] to save your configuration, and apply the highstate.

Yomi Formula

The Yomi (yet one more installer) installer for SUSE and openSUSE operating systems is configured using
formulas with forms.

The yomi-formula package provides these formulas:

e Yomi

e Yomi Storage

e YomiBootloader
e Yomi Software
e Yomi Services

e Yomi Users

Procedure: Install the Yomi Formulas with Forms

1. On the SUSE Manager Server, at the command prompt, as root, install the yomi-formula package:
zypper in yomi-formula

2. Restart services:

systemctl restart salt-master.service

When the formula package is installed, you need to install the PXE Yomi image on the client, boot the
client you want to provision, and enable the Yomi formulas on the client. For more information on

preparing Yomi clients for provisioning, see Specialized-guides > Salt.

Procedure: Configuring the Yomi Formula

1. Navigate to the Formulas > Yomi tab, and set these parameters in the General Configuration
section:

O Check the Events box to allow monitoring.
© Inthe Reboot field, select yes to instruct the client to reboot after installation.
O Check the Snapper box if you are using the btrfs file system on the client.

O Inthe Locale field, select the region and encoding for systemd to use on the client. For example:
en_US.utf8 for US English and UTF-8.

O In the Keymap field, select the appropriate keyboard layout. For example: us for a US keyboard
layout.

O Inthe Timezone field, select the timezone for the client to use. For example: America/New_York for
EST.
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O In the Hostname field, enter the hostname for the client to use. Leave this blank if you are using
DHCP to provide the hostname.

O Inthe Machine Id field, enter a machine identification number for the client. Leave this blank to
have systemd generate one automatically.

O Inthe Target field, enter a systemd target unit.

2. Click [ Save Formula ] to save your configuration.

Procedure: Configuring the Yomi Storage Formula

1. Navigate to the Formulas > Yomi Storage tab, and set these parameters in the Partitions > Config
section:

© Inthe Labels field, select the default partition table type to use.

O IntheInitial Gap field, select the default amount of space to leave before the first partition. For
example: 1 MB, or use 0 to leave no space between partitions.

2. For each device that you want to configure, in the Partitions > Devices section, click [+], and set
these parameters:

O IntheDevice field, type the mount point for the device. For example, /dev/sda.

© Inthe Label field, select the partition table type to use, if it is different from the default label you
selected.

O In the Initial Gap field, select the amount of space to leave before the first partition, if it is
different from the default space you specified.

3. For each partition that you want to create, in the Partitions > Devices » Partitions section, click [ +],
and set these parameters:

O In the Partition Number field, enter a number for the partition. The number you enter here is
appended to the device name to identify the partition. For example, partition number 1 on
device /dev/sda can be identified as /dev/sdal.

O InthePartition Name field, enter a name for the partition. Leave this blank if you have entered a
partition number in the previous field.

O InthePartition Size field, enter a size for the partition. For example: 500 MB. Use rest to use all
the remaining free space.

4. For each file system that you want to create, in the Filesystems section, click [+], and set these
parameters:

O InthePartition field, select the partition to create the file system on. For example, /dev/sda1.
© IntheFilesystenmfield, select the file system type to create.
O Inthe Mountpoint field, type the mount point for the file system. For example: / for root.

5. Click [ Save Formula ] to save your configuration.

o If you want to use LVM or RAID on your devices, click [ +] in the appropriate sections,
and complete the details for your environment.

Procedure: Configuring the Yomi Bootloader Formula
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1. Navigate to the Formulas > Yomi Bootloader tab, and set these parameters in the Bootloader
section:

O Inthe Device field, type the path for the bootloader. For example, /dev/sda.

O Inthe Timeout field, select the number of seconds grub will wait before booting the default menu
entry.

O In the Kernel field, type any additional kernel parameters you want to use. Any kernel
parameters you add here will be appended to the GRUB_CMDLINE_LINUX_DEFAULT line during boot.

O Inthe Terminal field, type the terminal to use for both terminal input and output.

O In the Serial Command field, type parameters for using the serial port. Use this only if you are
using the serial console as the default terminal.

O In the Gfxmode field, type the resolution to use for the graphical terminal. Use this only if you are
using the graphical console as the default terminal.

O Check the Theme box to use GRUB2 default branding package.

O Check the Disable 0S Prober box to disable using the OS prober to discover other installed
operating systems.

2. Click [ Save Formula ] to save your configuration.

Procedure: Configuring the Yomi Software Formula

1. Navigate to the Formulas > Yomi Software tab, and set these parameters in the Software >
Configuration section:

O Check the Minimal box to use a minimal installation, which only installs packages listed as
Required.

2. For each repository that you want to add, in the Software > Repositories section, click [ +], and set
these parameters:

O IntheRepository Name field, type a name for the repository.

© IntheRepository URL field, type the location of the repository.

3. To add packages from each repository, in the Software > Packages section, click [ +], and set these
parameters:

O In the Software > Packages field, type the names of the packages to install, or type a pattern to

search for the appropriate packages. For example, pattern:enhanced_base glibc-locale, or
kernel-default.

4. In the Software > Image section, set these parameters:
O Inthe Image URL field, type the location of the operating system ISO image to use.
O In the Md5 field, type the MD5 hash to use to verify the I1SO.

5. In the SUSEConect > Config section, set these parameters:

O IntheRegistration Code field, type the registration code for the client you are installing. You can
obtain this code from SUSE Customer Center.

© IntheEmail field, type the administrator email address to use.
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O In the Url field, type the address of the registration server to use. For example, use
https://scc.suse.com, to register with SUSE Customer Center.

O Inthe Version field, type the version of the product you are registering.

6. For each product that you want to register, in the SUSEConnect > Products section, click [+], and
set these parameters:

© In the Product field, type each product you want to register. For example,
<product_name>/1.1/x86, for version 1.1 with x86 architecture.

In the SUSEConnect > Packages field, type the names of the packages to install, or type a
pattern to search for the appropriate packages. For example, pattern:enhanced_base glibc-
locale, or kernel-default.

7. Click [ Save Formula ] to save your configuration.

Procedure: Configuring the Yomi Services Formula
1. Navigate to the Formulas > Yomi Services tab, and set these parameters:
O Checkthe Install salt-minion box to install and configure the client as a Salt client.

2. For each service you want to enable, in the Services > Enabled section, click [+], and set these
parameters:

O Inthe Service field, type the name of the service to enable. For example, salt-minion.

3. For each service you want to disable, in the Services > Disabled section, click [+], and set these
parameters:

O Inthe Service field, type the name of the service to disable.

4. Click [ Save Formula ] to save your configuration.

Procedure: Configuring the Yomi Users Formula
1. Navigate to the Formulas > Yomi Users tab.
2. For each user you want to create, in the Users section, click [ +], and set these parameters:
O In the Username field, type the name of the new user.
© InthePassword Hash field, type the hashed version of the password to use.

3. To add a certificate for each user, in the Users » Certificates section, click [+], and add the
certificate to the Certificate field.

4. Click [ Save Formula ] to save your configuration.
When you have completed and saved all the forms, apply the highstate.
For more information about using Yomi, see Specialized-guides > Salt.

Custom Salt Formulas

This section contains information about writing custom formulas, including formulas with forms. You
can write your own custom formulas, and make them available to client systems in the SUSE Manager
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Web UI.

For information about the formulas provided by SUSE Manager, see Specialized-guides » Salt.

File Structure Overview

RPM-based formulas must be placed in a specific directory structure to ensure that they work correctly.
A formula contains two separate directories: states, and metadata. Folders in these directories need to
have exactly matching names.

The formula states directory contains anything necessary for a Salt state to work independently. This
includes .s1s files, amap.jinja file and any other required files. This directory should only be modified by
RPMs and should not be edited manually. For example, the Tocale-formula states directory is located in:

/usr/share/susemanager/formulas/states/locale/

To create formulas with forms, the metadata directory contains a form.yml file. The form.yml file defines
the forms for SUSE Manager. The metadata directory also contains an optional metadata.yml file with
additional information about the formula. For example, the locale-formula metadata directory is
located in:

/usr/share/susemanager/formulas/metadata/locale/

If you have a custom formula that is not in an RPM, it must be in a state directory configured as a Salt file
root. Custom state formula data must be in:

/srv/salt/<custom-formula-name>/
Custom metadata information must be in:
/srv/formula_metadata/<custom-formula-name>/

All custom folders must contain a form.yml file. These files are detected as form recipes and are applied
to groups and systems from the Web Ul:

/srv/formula_metadata/<custom-formula-name>/form.yml

The Salt formula directory changed in SUSE Manager 4.0. The old directory location,

o /usr/share/susemanager/formulas, will continue to work for some time. You should
ensure that you update to the new directory location, /usr/share/salt-formulas/ as
soon as possible.

Define Formula with Forms Data

SUSE Manager requires a file called form.yml, to describe how formula data should look within the
Web Ul. The form.yml file is used by SUSE Manager to generate the desired formula with forms, with
values editable by a user.
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The file contains a list of editable attributes that start with a § sign. These attributes are used to
determine how to display the formula in the SUSE Manager Web UI.

For example, the form.yml that is included with the locale-formulaisin:

Part of that file looks like this:

All values that start with a § sign are annotations used to display the Ul that users interact with. These
annotations are not part of pillar data itself and are handled as metadata.

This section lists the available attributes:

Stype
The most important attribute is the $type attribute. It defines the type of the pillar value and the

form-field that is generated. The supported types are:

o text

e password
e number

o url

e email

o date

o time

o datetime
e boolean
e color

e select

e group

e edit-group
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e Namespace

o hidden-group (obsolete, renamed to namespace)

o The text attribute is the default and does not need to be specified explicitly.

Many of these values are self-explanatory:

o The text type generates a simple text field
o The password type generates a password field
e Thecolor type generates a color picker

The group, edit-group, and namespace (formerly hidden-group) types do not generate an editable field and
are used to structure form and pillar data. All these types support nesting.

The group and namespace types differ slightly. The group type generates a visible border with a heading.
The namespace type shows nothing visually, and is only used to structure pillar data.

The edit-group type allows you to structure and restrict editable fields in a more flexible way. The edit-
group type is a collection of items of the same kind. Collections can have these four shapes:

o List of primitive items

e List of dictionaries

o Dictionary of primitive items

o Dictionary of dictionaries

The size of each collection is variable. Users can add or remove elements.

For example, edit-group supports the $minItems and §maxItems attributes, which simplifies complex and
repeatable input structures. These, and also itemName, are optional.

Sdefault

Allows you to specify a default value to be displayed. This default value will be used if no other value
is entered. In an edit-group it allows you to create initial members of the group and populate them
with specified data.

Soptional

This type is a Boolean attribute. If it is true and the field is empty in the form, then this field will not
be generated in the formula data and the generated dictionary will not contain the field name key. If
itis false and the field is empty, the formula data will contain a <field name>: null entry.

SifEmpty

This type is used if the field is empty. This usually occurs because the user did not provide a value.
The ifEmpty type can only be used when $optional is false or not defined. If §optional is true, then
$ifEmpty is ignored. In this example, the DP2 string would be used if the user leaves the field empty:
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Sname

Allows you to specify the name of a value that is shown in the form. If this value is not set, the pillar
name is used and capitalized without underscores and dashes. Reference it in the same section with

${name}.

Shelp and $placeholder

These attributes are used to give a user a better understanding of what the value should be. The
$help type defines the message a user sees when hovering over a field The $placeholder type
displays a gray placeholder text in the field

Use $placeholder only with text fields like text, password, email or date fields. Do not add a placeholder
if you also use $default, as it will hide the placeholder.

Skey

Applicable only if the edit-group has the shape of a dictionary. When the pillar data is a dictionary,
the $key attribute determines the key of an entry in the dictionary.

For example:

Sminltems and $SmaxItems

In an edit-group, $minItems and $maxItems specifies the lowest and highest numbers for the group.

SitemName

In an edit-group, $itemName defines a template for the name to be used for the members of the
group.

_| Salt Formulas 85/159



$prototype

In an edit-group, $prototype is mandatory and defines the default pre-filled values for newly added
members in the group.

$scope

Specifies a hierarchy level at which a value may be edited. Possible values are system, group, and
readonly.

The default value is $scope: system, allows values to be edited at group and system levels. A value
can be entered for each system but if no value is entered the system will fall back to the group
default.

The $scope: group option makes a value editable only for a group. On the system level you will be
able to see the value, but not edit it.

The $scope: readonly option makes a field read-only. It can be used to show data to the user, but will
not allow them to edit it. This option should be used in combination with the §default attribute.

Svisiblelf

o Deprecated in favor of $visible.
Allows you to show a field or group if a simple condition is met. An example condition is:
some_group#another_group#my_checkbox ==true

The left part of the condition is the path to another value, and groups are separated by # signs. The
middle section of the condition should be either == for a value to be equal or != for values that
should be not equal. The last field in the statement can be any value which a field should have or not
have.

The field with this attribute associated with it will be shown only when the condition is met. In this
example the field will be shown only if my_checkbox is checked. The ability to use conditional
statements is not limited to check boxes. It may also be used to check values of select-fields, text-
fields, and similar.

A check box should be structured like this:

some_group:
Stype: group

another_group:
Stype: group

my_checkbox:
Stype: boolean

Relative paths can be specified using prefix dots. One dot indicates a sibling, two dots indicate a
parent, and so on. This is mostly useful for edit-group.
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If you use multiple groups with the attribute, you can allow a users to select an option and show a
completely different form, dependent upon the selected value.

Values from hidden fields can be merged into the pillar data and sent to the client. A formula must
check the condition again and use the appropriate data. For example:

Svalues

Can only be used together with §type Use to specify the different options in the select-field. $values
must be a list of possible values to select. For example:

o

r:

Svisible

Allows you to show a field or group if a condition is met. You must use the jex| expression language
to write the condition.

Example structure:
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some_group:
Stype: group

another_group:
Stype: group

my_checkbox:
Stype: boolean
An example condition is:

formValues.some_group.another_group.my_checkbox == true

The field with this attribute will only show if the condition is met. In this example, the field will show
only if my_checkbox is checked. You can also choose other elements for the conditional statement,
such as select fields or text fields.

If you use multiple groups with the attribute, users can select an option that will show a completely
different form, depending on the selected value.

Values from hidden fields can be merged into the pillar data and sent to the client. A formula must
check the condition again and use the appropriate data. For example:

show_option:
Stype: checkbox
some_text:
Svisible: this.parent.value.show_option == true

{% if pillar.show_option %]}
do_something:

with: {{ pillar.some_text }}
{% endif %}

Sdisabled

Allows you to disable a field or group if a condition is met. You must use the jex| expression language
to write the condition.

If specified at group level it will disable all fields in that group.

$required

Fields with this attribute are mandatory. Supports using the jex| expresion language.

Smatch

Allows using a regular expression to validate the content of a text field.

It supports the regular expression features existing in JavaScript.

Example:
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Expression language

You must use the jex| expression language to write conditions.

Given a structure like this:

An example condition is:

Absolute paths must begin with formValues.
Specify relative paths using this.parent.value to define the value of the parent.

You can also refer to the parent of the parent, with this.parent.parent.value. This is mostly useful for
edit-group elements.

Example for relative paths:
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=& 7. Example: Basic edit-group

Click [Add ] to fill the form with the default values.

The formula is called hd-partitions and will appear as Hd Partitions inthe Web UL.

& suma-refhead-min-sles12sp3.mgr.suse.de @ & Dekte System
Details Sof Confi Py Groups Virtualization Audit States Formulas Events
Formulas Hd Partitions Joe
’ This is a feature preview: On this page you can configure Salt formulas to automatically install and configure software. We would be glad to receive your feedback via the forum. @ \
e P Nem s |
Hd Partitions
Hard Disk Partitions
Partition Boot -
Name: [ Boot ]
Mountpoint: [ /oot l
Size in GB: [ @ l
Partition Root =
HName: [ Root ]
Mountpaint: [ i ]
Size in GB: [ 5000 @ l
Partition Mew partitian -
Mame: [ New partition ]
Mountpoint: [ fvar l
Size in GB: [ @ l
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To remove the definition of a partition click the minus symbol in the title line of an inner group.

When you are finished, click [ Save Formula].

£E 8. Example: Nested edit-group

Writing Salt Formulas

Salt formulas are pre-written Salt states. You can use Jinja to configure formulas with pillar data.

Basic Jinja syntax is:

When you are sure a pillar exists, use this syntax:

You can also replace the pillar value with grains. For example, grains.some.value.

Using data this way makes the formula configurable. In this example, a specified package is installed in
the package_name pillar:

You can also use more complex constructs such as if/else and for-loops to provide greater
functionality:
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Another example:

Jinja also provides other helpful functions. For example, you can iterate over a dictionary:

You can have Salt manage your files (for example, configuration files for a program), and change them
with pillar data.

In this example, Salt copies the file salt-file_roots/my_state/files/my_program.conf on the server to
/etc/my_program/my_program.conf on the client and template it with Jinja:

This example allows you to use Jinja in the file, like the previous example for states:

Separate Data

Separating data from a state can increase flexibility and make it easier to re-use. You can do this by
writing values into a separate file named map.jinja. This file must be within the same directory as the
state files.

This example sets data to a dictionary with different values, depending on which system the state runs
on. It will also merge data with the pillar using the some.pillar.data value so you can access
some.pillar.data.value by using data.value.

You can choose to override defined values from pillars. For example, by overriding
some.pillar.data.package in this example:
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When you have created a map file, you can maintain compatibility with multiple system types while
accessing deep pillar data in a simpler way.

Now you can import and use data in any file. For example:

You can define multiple variables by copying the {% set ---%} statement with different values and then
merge it with other pillars. For example:

To import multiple variables, separate them with a comma. For example:

For more information about conventions to use when writing formulas, see
https://docs.saltstack.com/en/latest/topics/development/conventions/formulas.html.
Generated Pillar Data

Pillar data is generated by SUSE Manager when events occur like generating the highstate. You can use
an external pillar script to generate pillar data for packages and group IDs, and include all pillar data for

oY)
w0n
<
w0n
—+
0]
| .3-

The process is executed like this:
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1. The suma_minion.py script starts and finds all formulas for a system by checking the
group_formulas.json and server_formulas.json files.

2. The script loads the values for each formula (groups and from the system) and merges them with the
highstate. By default, if no values are found, a group overrides a system if $scope: group.

3. The script also includes a list of formulas applied to the system in a pillar named formulas.

This structure makes it possible to include states. In this example, the top file is specifically generated by
the mgr_master_tops.py script. The top file includes a state called formulas for each system. This includes
the formulas.sls file located in /usr/share/susemanager/formulas/states or /usr/share/salt-
formulas/states/. The content looks similar to this:

include: {{ pillar["formulas"] }}

This pillar includes all formulas that are specified in the pillar data generated from the external pillar
script.

Formulas should be created directly after SUSE Manager is installed. If you encounter any problems with
formulas check these things first:

e The external pillar script (suma_minion.py) must include formula data.

o Data is saved to /srv/susemanager/formula_data and the pillar and group_pillar sub-directories.
These directories should be automatically generated by the server.

e Formulas must be included for every client listed in the top file. Currently this process is initiated by
the mgr_master_tops.py script which includes the formulas.sls file located in
/usr/share/susemanager/formulas/states/ or /usr/share/salt-formulas/states/. This directory must
be a salt file root. File roots are configured on the salt-master (SUSE Manager) located at
/etc/salt/master.d/susemanager.conf.

Salt SSH

Salt SSH allows Salt commands and states to be issued directly over SSH. SSH connections are created
on demand, when the server executes an action on a client.

For more information about Salt SSH, see https://docs.saltstack.com/en/latest/topics/ssh/.

SSH Connection Methods

In SUSE Manager there are two SSH connection methods, ssh-push and ssh-push-tunnel. In both
methods the server initiates an SSH connection to the client to execute a Salt call.

In the ssh-push method, the package manager works as normal, and the HTTP or HTTPS connection is
directly created.

In the ssh-push-tunnel method, the server creates an HTTP or HTTPS connection through an SSH tunnel.
The HTTP connection initiated by the package manager is redirected through the tunnel using
/etc/hosts aliasing. Use this method for in-place firewall environments that block HTTP or HTTPS
connections between server and client.
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Salt SSH Integration

As with all Salt calls, SUSE Manager invokes salt-ssh via the salt-api.

Salt SSH relies on a roster to obtain details such as hostname, ports, and the SSH parameters of a client.
SUSE Manager keeps these details in the database and makes them available to Salt SSH by using the
uyuni roster module, or by generating a temporary roster file on bootstrapping new clients with the
Web Ul. The location of the temporary roster file is supplied to Salt SSH using the roster-file option. For
the registered clients roster set to uyuni is used instead to get the roster from the database with uyuni
salt roster module.

It is not recommended to run salt-ssh as root user. This can cause permission issues
the next time SUSE Manager tries to use Salt SSH. Use mgr-salt-ssh, which changes

o the effective user to salt and avoids file permission issues. If you want to use mgr-
salt-ssh with a user other than root, the user should have the permission to change
effective user to salt.

mgr-salt-ssh uses roster set to uyuni by default, if neither roster nor roster-file specified in the
command line. It helps to call Salt commands to the registered Salt SSH clients with no roster file
generation.

Authentication

Salt SSH supports both password and key authentication. SUSE Manager uses both methods:

Password authentication is used only when bootstrapping. During the bootstrap step the key of the
server is not authorized on the client and therefore a password must be used for a connection to be
made. The password is used transiently in a temporary roster file used for bootstrapping and the roster
file is removed on finishing processing the event. This password is not stored.

All other common Salt calls use key authentication. During the bootstrap step the SSH key of the server
is authorized on the client and added to the client /.ssh/authorized_keys file. Subsequent calls no longer
require a password.

User Account

The user for Salt SSH calls made by SUSE Manager is taken from the ssh_push_sudo_user setting. By
default, the user is root.

o If bootstrapping with default settings fail, check whether the client allows root login
with ssh.

If the value of ssh_push_sudo_user is not root, then the --sudo options of salt-ssh are used. For this user
you must configure the NOPASSWD option in the sudoers file. At least, set the python binary with the
version number; for example:

<USER> ALL=(ALL) NOPASSWD:/usr/bin/python3.6



HTTP Redirection

The ssh-push-tunnel method requires traffic to be redirected through an SSH tunnel. This allows traffic
to bypass firewalls blocking a direct connection between the client and the server.

This is achieved by using port 1233 in the repository URL:
https://suma-server:1233/repourl...

You can alias the suma-server hostname to localhost in /etc/hosts:
127.0.0.1  localhost suma-server

The server creates a reverse SSH tunnel that connects localhost: 1233 on the client to suma-server:443:
ssh ... -R 1233:suma-server:443

This means that the package manager will actually connect to localhost:1233, which is then forwarded
to suma-server:443 by the SSH tunnel.

The package manager can contact the server only if the tunnel is open, which occurs only when the
server executes an action on the client.

Manual package manager operations that require server connectivity are not possible in this case.

Call Sequence

Salt SSH calls run in this sequence:
1. Set roster parameter to uyuni for registered clients or prepare the Salt roster on bootstrapping for
the call

a. Create remote port forwarding option if the contact method is ssh-push-tunnel
b. Compute the ProxyCommand if the client is connected through a proxy
c. Create Roster content

2. Create a temporary roster file (only in case of bootstrapping new client)

3. Execute a synchronous salt-ssh call using the API

4. Remove the temporary roster file (only in case of bootstrapping new client)
The roster content contains:

o hostname
e user
e port

remote_port_forwards: The remote port forwarding SSH option



g ssh_options: Other ssh options:
©  ProxyCommand: If the client connects through a proxy
o timeout: defaults to 180 seconds
e minion_opts:
O master: Set to the minion ID if the contact method is ssh-push-tunnel
e ssh_pre_flight: The path to the shell script executed on the client before running any Salt command

e ssh_pre_flight_args: The list of arguments to call the pre flight script on the client

Bootstrap Sequence

This section describes the sequence of events when clients are registered to a Salt master. While
bootstrapping is a type of Salt SSH call, the sequence differs slightly from regular SSH calls.

Bootstrapping uses Salt SSH for communication between the master and the client. This happens for
both regular and SSH clients.
1. For aregular Salt client, generate and pre-authorize the Salt key of the client.

2. For an SSH client, if a proxy was selected, retrieve the SSH public key of the proxy using the
mgrutil.chain_ssh_cmd runner. The runner copies the public key of the proxy to the server using SSH.
If needed, it can chain multiple SSH commands to reach the proxy across multiple hops.

3. Generate pillar data for bootstrap. The pillar data is compiled and stored on the Salt master, and
retrieved by the client.

4. Generate the roster for bootstrapping into a temporary file on the client. You can use the roster by
passing it to the Salt API, with this command:

mgr-salt-ssh --roster-file=<temporary_bootstrap_roster> minion state.apply
certs,<bootstrap_state>

For bootstrap_state, use bootstrap for regular clients or ssh_bootstrap for SSH clients.

The way the client retrieves the pillar data depends on the contact method you have chosen for your
client:

o If you are using the ssh-push-tunnel contact method, ensure you have completed the remote port
forwarding option.

o If the client connects through a proxy, ensure you have completed the ProxyCommand option. This
depends on your proxy configuration, including how many proxies you need to connect through.

Pillar data contains:

e mgr_server: The hostname of the Salt master
e mgr_origin_server: The hostname of the SUSE Manager Server

e Mminion_id: The hostname of the client to bootstrap



contact_method: The connection type
mgr_sudo_user: The user for salt-ssh
activation_key: If selected

minion_pub: The pre-authorized public client key
minion_pem: The pre-authorized private client key

proxy_pub_key: The public SSH key that was retrieved from the proxy if the target is an SSH client
and a proxy was selected

The roster content contains:

hostname

user

password

port

remote_port_forwards: the remote port forwarding SSH option
ssh_options: other SSH options:

O ProxyCommand if the client connects through a proxy
timeout: defaults to 180 seconds

ssh_pre_flight: The path to the pre flight shell script (default: /usr/share/susemanager/salt-
ssh/preflight.sh)

ssh_pre_flight_args: The list of arguments to call the pre flight script on the client

This image provides an overview of the Salt SSH bootstrap process.
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Proxy Support

Salt SSH works with SUSE Manager Proxy by chaining the SSH connection from one server or proxy to
the next. This is also known as a multi-hop or multi-gateway SSH connection.

<N B

Proxy 2
Proxy 1 Minion
SUSE Manager

SUSE Manager uses ProxyCommand to redirect SSH connections through proxies. This options invokes an
arbitrary command that is expected to connect to the SSH port on the target host. The SSH process uses
standard input and output of the command to communicate with the remote SSH daemon.

ProxyCommand replaces a TCP/IP connection. It does not perform any authorization or encryption. Its role
is simply to create a byte stream to the remote SSH daemon port.

This image depicts a client connecting to a server that is behind a gateway. In this example netcat is
used to pipe port 22 of the target host into the SSH standard input/output:



ssh -o ProxyCommand=<stdio/stdout to remote port> ...

ssh -o ProxyCommand=’ssh gateway nc foo.com 22’ root@foo.com

______________ ssh o ..he 22 o
client gateway foo.com
ssh/stdin nc/stdin
ssh ProxyCommand :22 sshd
ssh/stdout nc/stdout

The Salt SSH calls run in this sequence when a proxy is in use:

1. SUSE Manager initiates the SSH connection.

2. ProxyCommand uses SSH to create a connection from the server to the client through the proxies.

This example uses ProxyCommand with two proxies and the ssh-push method:

# Connect the server to the first proxy:
/usr/bin/ssh -i /srv/susemanager/salt/salt_ssh/mgr_ssh_id -o StrictHostKeyChecking=no -o
User=mgrsshtunnel proxyl

# Connect the first proxy to the second, and forward standard input/output on the client to
client:22 using the " -W" option:

/usr/bin/ssh -I /var/lib/spacewalk/mgrsshtunnel/.ssh/id_susemanager_ssh_push -o
StrictHostKeyChecking=no -o User=mgrsshtunnel -W client:22 proxy2



ssh -i salt_ssh_id -o ProxyCommand='ssh -i ssh_push_id proxyOne ssh -i
ssh_push_id proxyTwo -W minion:22' root@minion <cmd>

@

SUSE Manager ‘ @

ssh -1 ssh_push_id proxyOne proxyone

@

ssh -1 ssh_push_id -W minion:22 proxyTwo proxy Two

-W minion:22
minion
This example uses ProxyCommand with two proxies and the ssh-push-tunnel method:

# Connect the server to the first proxy:
/usr/bin/ssh -i /srv/susemanager/salt/salt_ssh/mgr_ssh_id -o User=mgrsshtunnel proxyl

# Connect the first proxy to the second:
/usr/bin/ssh -i /home/mgrsshtunnel/.ssh/id_susemanager_ssh_push -o User=mgrsshtunnel

proxy2

# Connect the second proxy to the client and open an reverse tunnel (-R 1233:proxy2:443) from
the client to the HTTPS port on the second proxy:

/usr/bin/ssh -i /home/mgrsshtunnel/.ssh/id_susemanager_ssh_push -o User=root -R
1233:proxy2:443 client

# Connect the client to itself and forward the standard input/output of the server to the SSH port
of the client (-W client:22). .

This is equivalent to “ssh ... proxy2 netcat client 22" * and is needed because SSH does not allow
both the reverse tunnel (-R 1233:proxy2:443) and the standard input/output forward (-W
client:22} in the same command.

/usr/bin/ssh -i /root/.ssh/mgr_own_id -W client:22 -o User=root client



ssh -1 salt_ssh_id -o ProxyCommand='ssh -1 ssh_push_id proxyOne ssh -i
ssh_push_id proxyTwo ssh -1 ssh_push_id -R 1233:proxyTwo:443 minion ssh -i

ssh_own_id -W minion:22 minion' root@minionl <cmd>

proxxTwo

e

SUSE Manager ‘
ssh -1 ssh_push_id proxyOne proxyone
ssh -1 ssh_push_id proxyTwo

ssh -1 ssh_push_id -R 1233:proxyTwo:443 minion
minion

minion ssh —-i ssh_own_id -W minion:22 minion

Users and SSH Key Management

To connect to a proxy, the parent server or proxy uses a specific user called mgrsshtunnel. When
mgrsshtunnel connects, the SSH configuration of the proxy will force the execution of /usr/sbin/mgr-
proxy-ssh-force-cmd. This is a simple shell script that allows only the execution of scp, ssh, or cat

commands.

The connection to the proxy or client is authorized using SSH keys in this sequence:

1. The server connects to the client and to the first proxy using the key in
‘/srv/susemanager/salt/salt_ssh/mgr_ssh_id.
2. Each proxy has its own key pairin */home/mgrsshtunnel/.ssh/id_susemanager_ssh_push.
3. Each proxy authorizes the key of the parent proxy or server.
4. The client authorizes its own key.
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server key
proxyOne_key
proxyTwo_key

mgrsshtunnel ' mgrsshtunnel '

—|—> —

SUSE Manager proxyone Proxy Two

server_key v proxyOne_key v
own_key

>

ssh_push_sudo_user/root

A

= F proxyTwo_key v
minion server_key v
own_key v

Repository Access with a Proxy

When SUSE Manager connects to a repository using a proxy, it can use either ssh-push or ssh-push-
tunnel.

In both methods the client connects to the proxy to retrieve package and repository information.
In the ssh-push method, the package manager connects directly to the proxy using HTTP or HTTPS. This

works in cases where there is no firewall between the client and the proxy that blocks HTTP connections
initiated by the client.

SUSE Manager ‘
proxyOne

proxyTwo
u https://proxy2:443 /rhn/...

-

ssh .. =W minion:22

minion

In the ssh-push-tunnel method, the HTTP connection to the proxy is redirected through a reverse SSH
tunnel.

] s+ 103 /159



Salt SSH

L

SUSE Manager
proxyOne '

proxyTwo
https://proxy2:1233/rhn

ssh -i ssh_push_id -R 1233:proxyTwo:443 minion
minion

Proxy Setup

When the spacewalk-proxy package is installed on the proxy, the mgrsshtunnel user is created.
The initial configuration with configure-proxy.sh occurs using this sequence:

1. An SSH key pair is generated, or an existing keypair is imported.
2. The SSH key of the parent server or proxy is retrieved to authorize it on the proxy.

3. The ssh daemon on the proxy is configured to restrict the mgrsshtunnel user. This is done by the mgr-
proxy-ssh-push-init script, which is called from configure-proxy.sh. It does not have to be manually
invoked.

The parent key is retrieved by calling an HTTPS endpoint on the parent server or proxy. The first
endpoint tried is https://SPARENT/pub/id_susemanager_ssh_push.pub. If the parent is a proxy then
this will return the public SSH key of the proxy.

If a 404 error is received from that endpoint, then the parent is assumed to be a server not a proxy, and
https://SPARENT/rhn/manager/download/saltssh/pubkey is tried instead.

If an SSH key exists at /srv/susemanager/salt/salt_ssh/mgr_ssh_id.pub on the server itis returned.

If the public key does not exist because salt-ssh has not been invoked yet, a key will be generates by
calling the mgrutil.ssh_keygen runner.

Salt SSH generates a keypair the first time it is invoked with
o /srv/susemanager/salt/salt_ssh/mgr_ssh_id. The sequence in this section is needed
if a proxy is configured before Salt SSH was invoked for the first time.

Rotate SSH keys

The SSH key is used on salt-ssh managed systems. Additionally, it is used on SUSE Manager Proxies for
the user mgrsshtunnel. Normal systems managed with the Salt default method are not affected and do
not have this key configured.
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Procedure: Rotating SSH keys

1. On the SUSE Manager Server, as user root, change to user salt:
su -s /bin/bash - salt
2. Create a new SSH key:
ssh-keygen -N "" -t rsa -q -f /var/lib/salt/.ssh/new_mgr_ssh_id
3. Copy the public key into the Salt filesystem to make it usable in a Salt state:
cp /var/lib/salt/.ssh/new_mgr_ssh_id.pub /srv/susemanager/salt/salt_ssh/
4. Change back to user root again:
exit

5. Rollout the new key to all systems that need it. Applying the util.mgr_rotate_saltssh_key state will
limit the changes to salt-ssh managed systems and proxies:

salt "' state.apply util.m%r_rotate_saltssh_key
mgr-salt-ssh "*" state.apply util.mgr_rotate_saltssh_key

6. Move the old key away and make the new key the standard key. Rename mgr_ssh_id key to
disabled_mgr_ssh_id and new_mgr_ssh_id key to mgr_ssh_id in the SSH keystore of the user salt as
well as in the Salt filesystem for the public keys:

su -s /bin/bash - salt

cd .ssh

mv mgr_ssh_id disabled_mgr_ssh_id
mv mgr_ssh_id.pub disabled_ fr_ssh_id.pub
mv new_mgr_ssh_id mgr_ssh_i

mv new_mgr_ssh_id.pu mglr_ssh_id.pub

cd /srv/susemana er}?salt/sa t_ssh/

mv mgr_ssh_id.pub disabled_mgr_ssh_id.pub
mv new_mgr_ssh_id.pub mgr_ssh_id.pub

7. OPTIONAL: When containerized proxies exist, re-create the configuration to get the new SSH key into
the proxy configuration. Restart the containers with the new configuration. It is also possible to
change the existing configuration on the podman host (ssh.yaml). Change the value of
server_ssh_key_pub with the content of the current mgr_ssh_id. pub.

8. To remove the disabled keys from the authorized_keys' files of the [literal]salt-ssh®* managed
systems and the proxies, apply the state a second time:

%1

salt state.apply util.m%r_rotate_saltssh_key
mgr-salt-ssh """ state.apply util.mgr_rotate_saltssh_key



Salt Rate Limiting

Salt is able to run commands in parallel on a large number of clients. This can potentially create large
amounts of load on your infrastructure. You can use these rate-limiting parameters to control the load in
your environment.

These parameters are all configured in the /etc/rhn/rhn.conf configuration file.

o Salt commands that are executed from the command line are not subject to these
parameters.

Batching

There are two parameters that control how actions are sent to clients, one for the batch size, and one for
the delay.

When the SUSE Manager Server sends a batch of actions to the target clients, it will send it to the
number of clients determined in the batch size parameter. After the specified delay period, commands
will be sent to the next batch of clients. The number of clients in each subsequent batch is equal to the
number of clients that have completed in the previous batch.

Choosing a lower batch size will reduce system load and parallelism, but might reduce overall
performance for processing actions.

The batch size parameter sets the maximum number of clients that can execute a single action at the
same time. Adjust the java.salt_batch_size parameter. Defaults to 200.

Increasing the delay increases the chance that multiple clients will have completed before the next
action is issued (more clients are grouped together in subsequent batches), resulting in fewer overall
commands, and reducing load.

The batch delay parameter sets the amount of time, in seconds, to wait after a command from the
previous batch is processed before beginning to process the command on the next client. Adjust the
java.salt_batch_delay parameter. Defaults to 1.0 seconds.

Disabling the Salt Mine

In older versions, SUSE Manager used a tool called Salt mine to check client availability. The Salt mine
would cause clients to contact the server every hour, which created significant load. With the
introduction of a more efficient mechanism in SUSE Manager 3.2, the Salt mine is no longer required.
Instead, the SUSE Manager Server uses Taskomatic to ping only the clients that appear to have been
offline for twelve hours or more, with all clients being contacted at least once in every twenty four hour
period by default. You can adjust this by changing the web.system_checkin_threshold parameter in
rhn.conf. The value is expressed in days, and the default value is 1.

Newly registered Salt clients will have the Salt mine disabled by default. If the Salt mine is running on

your system, you can reduce load by disabling it. This is especially effective if you have a large number of
clients.
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Disable the Salt mine by running this command on the server:
salt "' state.sls util.mgr_mine_config_clean_up

This will restart the clients and generate some Salt events to be processed by the server. If you have a
large number of clients, handling these events could create excessive load. To avoid this, you can
execute the command in batch mode with this command:

salt --batch-size 50 '*' state.sls util.mgr_mine_config_clean_up

You will need to wait for this command to finish executing. Do not end the process with Ctr1 X+ C.

Scaling Minions (Large Scale Deployments)

SUSE Manager is designed by default to work on small and medium scale installations. For installations
with more than 1000 clients per SUSE Manager Server, adequate hardware sizing and parameter tuning
must be performed.

For more information on managing large scale deployments, see Specialized-guides > Large-
deployments.

Salt Connectivity

Depending on the size and spreadness of the environment where SUSE Manager is used some
connectivity issues are possible. There are no common recommendations for all the possible use cases
as the environments could be very different expecially if public clouds instances are involved.

Minions Connectivity

In case clients are losing the connection to the SUSE Manager Server (or SUSE Manager Proxy if
involved), they are unreachable from the SUSE Manager Server Web Ul or with command line tools. To
understand such a connection issue check if the client is not reachable from the SUSE Manager Server
with salt MINION_ID test.ping, while venv-salt-call test.ping or (salt-call test.ping in case if non-
bundle salt is used on the client) is working fine on the client side. If this is the case, it is recommended
to set tcp_keepalive parameters.

The parameters with the values from the example below could be used as a starting point to look for the
better combination, which could prevent cases of connection loss without restoring for some
environments. It is recommended to put the parameters in the separate drop-in configuration file like
/etc/venv-salt-minion/minion.d/tuning-keepalives.conf or /etc/salt/minion.d/tuning-
keepalives.conf, depending on the minion type used on the client side.
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=& 9. Example: Keepalive parameters example values

#i##H##  Keepalive settings  #i#HH###

HHHHHHH R R R R R R R R

# ZeroMQ now includes support for configuring SO_KEEPALIVE if supported by
# the OS. If connections between the minion and the master pass through

# a state tracking device such as a firewall or VPN gateway, there is

# the risk that it could tear down the connection the master and minion

# without informing either party that their connection has been taken away.

# Enabling TCP Keepalives prevents this from happening.

# Overall state of TCP Kee[)alives, enable (1 or True), disable (0 or False)
# or leave to the OS defaults (-1), on Linux, typically disabled. Default True, enabled.
tcp_keepalive: True

# How long before the first keepalive should be sent in seconds. Default 300

# to send the first keepalive after 5 minutes, OS default (-1) is typically 7200 seconds
#on Linux see /proc/sys/net/ipv4/tcp_keepalive_time.

tcp_keepalive_idle: 10

# How many lost probes are needed to consider the connection lost. Default -1
# to use OS defaults, typically 9 on Linux, see /proc/sys/net/ipv4/tcp_keepalive_probes.
tcp_keepalive_cnt: 3

# How often, in seconds, to send keepalives after the first one. Default -1 to
# use OS defaults, typically 75 seconds on Linux, see

# /proc/sys/net/ipv4/tcp_keepalive_intvl.

tcp_keepalive_intvl: 10

Proxies Connectivity

salt-broker service is used on SUSE Manager Proxies to forward salt traffic between the SUSE Manager
Server and salt-minion service used on the client side. It is possible that salt-broker and all the clients
behind it could be affected with the same issue as the clients directly connected to the SUSE Manager
Server. The issue could be fixed with the same parameters as recommended for the minions, but
specified in /ete/salt/broker on each SUSE Manager Proxy.

The other possible issue which SUSE Manager Proxy can be affected with is the case when the
connectivity to the SUSE Manager Server is lost for quite long interval, so the clients behind it started to
retry the authentication to the salt-master service on the SUSE Manager Server. This situation could be
potentially dangerous as it could lead to collecting large amount of ZeroMQ messages with
authentication attemps in the interal buffer of ZeroMQ sockets used inside the salt-broker service, so
that on restoring the connection to the salt-master all of the messages will be pushed to it. It could lead
to the issues on SUSE Manager Server side with salt-master service, as it could be impossible to serve all
the cached requests in apropriate time or even to the complete denial of the service.

To avoid such situation a set of extra parameters was introduced. The most important one is
wait_for_backend, which should be set to True. This prevents opening the sockets for the clients behind
the proxy while the connectivity to the salt-master service is not established. In this case the messages
from the clients are not collected in the internal buffers. drop_after_retries is setting the number of
retries before closing the sockets to drop the cached messages. The other parameters could help to fine
tune the behaviour for the environment.
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Setting timeouts, intervals and drop_after_retries to lower values are making salt-
broker service more aggressive on detecting the connection loss to the salt-master,
so that it puts the clients behind the proxy to the conditions closer as they are

o connected directly to the SUSE Manager Server. On the other hand increasing the
values could provide some benefits in case if the network channel between the SUSE
Manager Proxy and SUSE Manager Server is not stable enough, the message
buffering can provide some flexibility while re-establishing the connection.
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= £ 10. Example: Keepalive parameters example values

###### ZeroMQ connection options  ######
HAHHHHHH B R R R R R R R

# For more details about the following parameters check ZeroMQ documentation:

# http://api.zeromq.org/4—2:zmq-setsocko t
# All of these parameters will be set to the backend sockets
# (from the salt-broker to the salt-master)

# connect_timeout (sets ZMQ_CONNECT_TIMEOUT)

# default: 0

# value unit: milliseconds

# Sets how long to wait before timing-out a connect to the remote socket.
# 0 could take much time, so it could be better to set to more strict value
# for particular environment depending on the network conditions.

# The value equal to 10000 is setting 10 seconds connect timeout.
connect_timeout: 3000

# reconnect_ivl (sets ZMQ_RECONNECT_IVL)
# default: 100
# value unit: milliseconds

# Sets the interval of time before reconnection attempt on connection drop.

reconnect_ivl: 1000

# heartbeat_ivl (sets ZMQ_HEARTBEAT_IVL)

# default: 0

# value unit: milliseconds

# This parameter is important for detection of loosing the connection.

# In case of value equal to 0 it is not sending heartbits.

# It's better to set to more relevant value for the particular environment,
# depending on possible network issues.

# The value equal to 20000 (20 seconds) works good for most cases.
heartbeat_ivl: 5000

# heartbeat_timeout (sets ZMQ_HEARTBEAT_TIMEOUT)

# default: 0

# value unit: milliseconds

# Sets the interval of time to consider that the connection is timed out

# after sending the heartbeat and not getting the response on it.

# The value equal to 60000 (1 minute) is considering the connection is down
# after 1 minute of no response to the heartbeat.

heartbeat_timeout: 10000

#i#### Other connection options  ######

# The following parameters are not related to ZeroMQ,

# but the internal parameters of the salt-broker.

# drop_after_retries

# default: -1

# value unit: number of retries

# Drop the frontend sockets of the salt-broker in case if it reaches
# the number of retries to reconnect to the backend socket.

# -1 means not drop the frontend sockets

# It's better to choose more relevant value for the particular environment.
# 10 can be a good choise for most of the cases.
drop_after_retries: 5

# wait_for_backend

# default: False

# The main aim of this parameter is to prevent collecting the messages

# with the open frontend socket and prevent pushing them on connecting
# the backend socket to prevent large number of messages to be pushed
# at once to salt-master.

#1t's better to set it to True if there is significant numer of minions

# behind the salt-broker.

wait_for_backend: True
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Large Deployments Guide Overview

Updated: 2024-11-18

SUSE Manager is designed by default to work on small and medium scale installations. For installations
with more than 1000 clients per SUSE Manager Server, adequate hardware sizing and parameter tuning
must be performed.

There is no hard maximum number of supported systems. Many factors can affect how many clients can
reliably be used in a particular installation. Factors can include which features are used, and how the
hardware and systems are configured.

There are two main ways to manage large scale deployments. You can manage them with a single SUSE
Manager Server, or you can use multiple servers in a hub. Both methods are described in this book.

With large scale environments one should also consider the usage of SUSE Manager Proxies. Sizing and
location of the Proxies will dependent on the deployment topology. For more information see

Installation-and-upgrade > Install-proxy.

Additionally, if you are operating within a Retail environment, you can use SUSE Manager for Retail to
manage large deployments of point-of-service terminals. There is an introduction to SUSE Manager for
Retail in this book.

Tuning and monitoring large scale deployments can differ from smaller installations. This book contains
guidance for both tuning and monitoring within larger installations.

Hardware Requirements

Not all problems can be solved with better hardware, but choosing the right hardware is an absolute
necessity for large scale deployments.

The minimum requirements for the SUSE Manager Server are:

e Eight or more recent x86-64 CPU cores.
e 32 GiB RAM. For installations with thousands of clients, use 64 GB or more.
o Fast 1/O storage devices, such as locally attached SSDs. For PostgreSQL data directories, we

recommend locally attached RAID-0 SSDs.

If the SUSE Manager Server is virtualized, enable the elevator=none kernel command line option, for the
best input/output performance. You can check the current status with cat
/sys/block/<DEVICE>/queue/scheduler. This command will display a list of available schedulers with the
currently active one in brackets. To change the scheduler before a reboot, use echo none >
/sys/block/<DEVICE>/queue/scheduler.

The minimum requirements for the SUSE Manager Proxy are:

e One SUSE Manager Proxy per 500-1000 clients, depending on available network bandwidth.

e Two or more recent x86-64 CPU cores.
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e 16 GB RAM, and sufficient storage for caching.
Clients should never be directly attached to the SUSE Manager Server in production systems.
In large scale installations, the SUSE Manager Proxy is used primarily as a local cache for content
between the server and clients. Using proxies in this way can substantially reduce download time for

clients, and decrease Server egress bandwidth use.

The number of clients per proxy will affect the download time. Always take network structure and
available bandwidth into account.

We recommend you estimate the download time of typical usage to determine how many clients to

connnect to each proxy. To do this, you will need to estimate the number of package upgrades required
in every patch cycle. You can use this formula to calculate the download time:

Size of updates * Number of clients / Theoretical download speed / 60

For example, the total time needed to transfer 400 MB of upgrades through a physical link speed of
1 GB/s to 3000 clients:

400 MB * 3000/ 119 MB/s /60 =169 min

Using a Single Server to Manage Large Scale Deployments

This section discusses how to set up a single SUSE Manager Server to manage a large number of clients.
It contains some recommendations for hardware and networking, and an overview of the tuning
parameters that you need to consider in a large scale deployment.

Operation Recommendations

This section contains a range of recommendations for large scale deployments.

o Always start small and scale up gradually. Monitor the server as you scale to identify
problems early.

Client Onboarding Rate

The rate at which SUSE Manager can onboard clients is limited and depends on hardware resources.
Onboarding clients at a faster rate than SUSE Manager is configured for will build up a backlog of
unprocessed keys. This slows down the process and can potentially exhaust resources. We recommend
that you limit the acceptance key rate programmatically. A safe starting point would be to onboard a
client every 15 seconds. You can do that with this command:

for kin $(salt-key -l un|grep -v Unaccepted); do salt-key -y -a $k; sleep 15; done
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Clients and the RNG

All communication to and from clients is encrypted. During client onboarding, Salt uses asymmetric
cryptography, which requires available entropy from the Random Number Generator (RNG) facility in the
kernel. If sufficient entropy is not available from the RNG, it will significantly slow down
communications. This is especially true in virtualized environments. Ensure enough entropy is present,
or change the virtualization host options.

You can check the amount of available entropy with the cat /proc/sys/kernel/random/entropy_avail. It
should never be below 100-200.

Clients Running with Unaccepted Salt Keys

Idle clients which have not been onboarded, that is clients running with unaccepted Salt keys, consume
more resources than idle clients that have been onboarded. Generally, this consumes about an extra
2.5Kb/s of inbound network bandwidth per client. For example, 1000 idle clients will consume about
2.5 Mb/s extra. This consumption will reduce almost to zero when onboarding has been completed for
all clients. Limit the number of non-onboarded clients for optimal performance.

Disabling the Salt Mine

In older versions, SUSE Manager used a tool called Salt Mine to check client availability. The Salt Mine
would cause clients to contact the server every hour, which created significant load. Since the
introduction of a more efficient mechanism in SUSE Manager 3.2, the Salt Mine is no longer required.
Instead, the SUSE Manager Server uses Taskomatic to ping only the clients that appear to have been
offline for twelve hours or more, with all clients being contacted at least once in every twenty four hour
period by default. You can adjust this by changing the web.system_checkin_threshold parameter in
rhn.conf. The value is expressed in days, and the default value is 1.

Newly registered clients will have the Salt Mine disabled by default. If the Salt Mine is running on your
system, you can reduce load by disabling it. This is especially effective if you have a large number of
clients.

Disable the Salt Mine by running this command on the server:

%1

salt "' state.sls util.mgr_mine_config_clean_up

This will restart the clients and generate some Salt events to be processed by the server. If you have a
large number of clients, handling these events could create excessive load. To avoid this, you can
execute the command in batch mode with this command:

salt --batch-size 50 "*' state.sls util.mgr_mine_config_clean_up

You will need to wait for this command to finish executing. Do not end the process with Ctr1 X+ C.

Disable Unnecessary Taskomatic Jobs

To minimize wasted resources, you can disable non-essential or unused Taskomatic jobs.
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You can see the list of Taskomatic jobs in the SUSE Manager Web Ul, at Admin » Task Schedules.

To disable a job, click the name of the job you want to disable, select Disable Schedule, and click [
Update Schedule].

To delete a job, click the name of the job you want to delete, and click [ Delete Schedule ].
We recommend disabling these jobs:

o Daily comparison of configuration files: compare-configs-default
e Hourly synchronization of Cobbler files: cobbler-sync-default

o Daily gatherer and subscription matcher: gatherer-matcher-default

Do not attempt to disable any other jobs, as it could prevent SUSE Manager from functioning correctly.

Swap and Monitoring

It is especially important in large scale deployments that you keep your SUSE Manager Server constantly
monitored and backed up.

Swap space use can have significant impacts on performance. If significant non-transient swap usage is
detected, you can increase the available hardware RAM.

You can also consider tuning the Server to consume less memory. For more information on tuning, see
Specialized-guides » Salt.

AES Key Rotation

Communications from the Salt Master to clients is encrypted with a single AES key. The key is rotated
when:

e Thesalt-master process is restarted, or

o Any minion key is deleted (for example, when a client is deleted from SUSE Manager)
After the AES key has been rotated, all clients must re-authenticate to the master. By default, this
happens next time a client receives a message. If you have a large number of clients (several thousands),

this can cause a high CPU load on the SUSE Manager Server. If the CPU load is excessive, we recommend
that you delete keys in batches, and in off-peak hours if possible, to avoid overloading the server.

For more information, see:

e https://docs.saltstack.com/en/latest/topics/tutorials/intro_scale.html#too-many-minions-re-
authing

e https://docs.saltstack.com/en/getstarted/system/communication.html
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Multiple Servers with Hub to Manage Large Scale
Deployments

If you need to manage a large number of clients, in most cases you can do so with a single SUSE Manager
Server, tuned appropriately. However, if you need to manage tens of thousands of clients, you might find
it easier to use multiple SUSE Manager Servers, in a hub, to manage them.

SUSE Manager Hub helps you manage very large deployments. The typical Hub topology looks like this:

Hub
» |

Proxy1 Proxy2

Client_1001 Client_1002 Client_1999 Client_2001 Client_2002 Client_2999

To copy contents between servers, you can use Inter-Server Synchronization (ISS). ISS allows you to
export data from one server (source) and import it on another (target) server. For more information, see

Administration > Iss_intro.

Hub Requirements

To set up a Hub installation, you require:

e One central SUSE Manager Server, which acts as the Hub Server.

e One or more additional SUSE Manager Servers, registered to the Hub. This document refers to these
additional servers as peripheral servers.

e Any number of clients registered to the peripheral servers.

e Ensurethe Hub Server and all peripheral servers are running SUSE Manager 5.0 or higher.

Hub Server

Deploy the central SUSE Manager Server, which acts as the Hub Server, with mgradm. For more
information about deploying with mgradm, see Installation-and-upgrade > Container-deployment.

0 The Hub Server must not have clients registered to it. Clients should only be
registered to the peripheral servers.

Peripheral Servers

Deploy the peripheral servers with mgradm. For more information about deploying with mgradm, see
Installation-and-upgrade > Container-deployment.

Peripheral servers must be registered to the Hub Server as foreign clients. Standard registration
methods cannot be used. Use mgradm on the peripheral server host:
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mgradm hub register --api-server <HUB_FQDN> --api-user <HUB_ADMIN> --api-password
<HUB_ADMIN_PASSWORD>

The peripheral servers must be registered to the Hub Server directly, do not use a proxy.

Optionally, it is possible to register the podman container host as a standard client (Salt minion) and
manage it from SUSE Manager Server.

You need credentials to access the XMLRPC APIs on each server, including the Hub Server.

Hub XMLRPC API Deployment

Before you begin, you need to install the hub-xmlrpc-api package, and configure the Hub Server to use
the API.

Procedure: Installing and Configuring the Hub XMLRPC API

1. On the Hub Server, or on a host that has access to all peripheral servers' XMLRPC APlIs, install the
hub-xmlrpc-api package. The package is available in the SUSE Manager '5.0' repositories.

2. OPTIONAL: Set the Hub XMLRPC API service to start automatically at boot time, and start it
immediately:

sudo systemctl enable hub-xmlrpc-api.service
sudo systemctl start hub-xmlrpc-api.service

3. OPTIONAL: Check that these parameters in the /etc/hub/hub.conf configuration file are correct:

O HUB_API_URL: URL to the Hub Server XMLRPC APl endpoint. Use the default value if you are
installing hub-xmlrpc-api on the Hub Server.

O HUB_CONNECT_TIMEOUT: the maximum number of seconds to wait for a response when connecting
to a Server. Use the default value in most cases.

O HUB_REQUEST_TIMEOUT: the maximum number of seconds to wait for a response when calling a
Server method. Use the default value in most cases.

O HUB_CONNECT_USING_SSL: use HTTPS instead of HTTP for communicating with peripheral Servers.
Recommended for a secure environment.

4. Restart services to pick up configuration changes.

To use HTTPS to connect to peripheral Servers, you must set the
HUB_CONNECT _USING_SSL parameter to true, and ensure that the SSL certificates for all
the peripheral Servers are installed on the machine where the hub-xmlrpc-api service

o runs. Do this by copying the RHN-ORG-TRUSTED-SSL-CERT certificate file from each
peripheral Server’ s http://<server-url>/pub/ directory to /etc/pki/trust/anchors/,
and run update-ca-certificates.

Using the Hub XMLRPC API

Make sure the hub-xmlrpc-api service is started:
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systemctl start hub-xmlrpc-api

Once itis running, connect to the service at port 2830 using any XMLRPC-compliant client libraries.
For examples, see Specialized-guides > Large-deployments.

Logs are saved in /var/log/hub/hub-xmlrpc-api.log. Logs are rotated weekly, or when the log file size
reaches the specified limit. By default, the log file size limit is 10 MB.

Hub XMLRPC API Namespaces

The Hub XMLRPC API operates in a similar way to the SUSE Manager API. For SUSE Manager API
documentation, see https://documentation.suse.com/suma.

The Hub XMLRPC API exposes the same methods that are available from the server’ s XMLRPC API, with
a few differences in parameter and return types. Additionally, the Hub XMLRPC API supports some Hub-
specific end points which are not available in the SUSE Manager API.

The Hub XMLRPC API supports three different namespaces:

e The hub namespace is used to target the Hub XMLRPC API Server. It supports Hub-specific XMLRPC
endpoints which are primarily related to authentication.

e The unicast namespace is used to target a single server registered in the hub. It redirects any call
transparently to one specific server and returns any value as if the server’ s XMLRPC API endpoint
was used directly.

e The multicast namespace is used to target multiple peripheral servers registered in the hub. It
redirects any call transparently to all the specified servers and returns the results in the form of a
map.

o If you do not specify a namespace, all calls are transparently redirected to the underlying SUSE
Manager Server XMLRPC API of the Hub Server. This allows you to call all available methods on the
SUSE Manager Server XMLRPC API.

Methods called without specifying any of the above namespaces will be forwarded to the normal
XMLRPC API of the hub. This is the APl exposed on ports 80 and 443.

Some important considerations for hub namespaces:

e Individual server IDs can be obtained using client.hub.listServerIds(hubSessionKey).

e The unicast namespace assumes all methods receive hubSessionKey and serverID as their first two
parameters, then any other parameter as specified by the regular Server API.

client.unicast.[namespace].[methodName](hubSessionKey, serverld, param1, param2)

e The hubSessionKey can be obtained using different authentication methods. For more information,
see Specialized-guides > Large-deployments.

o Themulticast namespace assumes all methods receive hubSessionKey, a list of ServerID values, then
lists of per-server parameters as specified by the regular server XMLRPC API. The return value is a
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map, with Successful and Failed entries for each server involved in the call.

client.multicast.[namespace].[methodname](hubSessionKey, [serverldl, serverld2],
[param1_s1, paraml_s2], [param2_s1, param2_s2])

Hub XMLRPC API Authentication Modes

The Hub XMLRPC API supports three different authentication modes:

e Manual mode (default): API credentials must be explicitly provided for each server.

o Relay mode: the credentials used to authenticate with the Hub are also used to authenticate to each
server. You must provide a list of servers to connect to.

e Auto-connect mode: credentials are reused for each server, and any peripheral server you have
access to is automatically connected.

Authentication Examples

This section provides examples of each authentication method.

Example: Manual Authentication
In manual mode, credentials have to be explicitly provided for each peripheral server before you can
connecttoit.
A typical workflow for manual authentication is:
1. Credentials for the Hub are passed to the login method, and a session key for the Hub is returned
(hubSessionKey).

2. Using the session key from the previous step, SUSE Manager Server IDs are obtained for all the
peripheral servers attached to the Hub via the hub.1istServerIds method.

3. Credentials for each peripheral server are provided to the attachToServers method. This performs
authentication against each server’ s XMLRPC APl endpoint.

4. Amulticast call is performed on a set of servers. This is defined by serverIds, which contains the IDs

of the servers to target. In the background, system.list_system is called on each server’ s XMLRPC
API

5. Hub aggregates the results and returns the response in the form of a map. The map has two entries:
O Successful: list of responses for those peripheral servers where the call succeeded.

O Failed: list of responses for those peripheral servers where the call failed.

If you want to call a method on just one SUSE Manager Server, then Hub API also
provides a unicast namespace. In this case, the response will be a single value and
not a map, in the same way as if you called that SUSE Manager server’ s API directly.
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= £ 11. Example Python Script for Manual Authentication:

#!/usr/bin/python3
import xmlrpc.client

HUB_XMLRPC_API_URL ="<HUB_XMLRPC_API_URL>"
HUB_USERNAME = "<USERNAME>"
HUB_PASSWORD = "<PASSWORD>"

client = xmlrpc.client.ServerProxy(HUB_XMLRPC_API_URL, verbose=0)
hubSessionKey = client.hub.login(HUB_USERNAME, HUB_PASSWORD)

# Get the server IDs
serverlds = client.hub.listServerlds(hubSessionKey)

# For simplicity, this example assumes you are using the same username and password here, as
on the hub server.

# However, in most cases, every server has its own individual credentials.

usernames = [HUB_USERNAME for s in serverlds]

passwords = [HUB_PASSWORD for s in serverlds]

# Each server uses the credentials set above, client.hub.attachToServers needs
# them passed as lists with as many elements as there are servers.
client.hub.attachToServers(hubSessionKey, serverlds, usernames, passwords)

# Perform the operation

systemsPerServer = client. multicast.system.list_systems(hubSessionKey, serverlds)
successfulResponses = systemsPerServer["Successful"]["Responses"]
failedResponses = systemsPerServer["Failed"]["Responses"]

for system in successfulResponses:
print(system)

# Log out
client.hub.logout(hubSessionKey)

Example: Relay Authentication

In relay authentication mode, the credentials used to sign in to the Hub API are also used to sign in into
the APIs of the peripheral servers the user wants to work with. In this authentication mode, it is assumed
that the same credentials are valid for every server, and that they correspond to a user with appropriate
permissions.

After signing in, you must call the attachToServers method. This method defines the servers to target in
all subsequent calls.

A typical workflow for relay authentication is:

1. Credentials for the Hub are passed to the loginWithAuthRelayMode method, and a session key for the
Hub is returned (hubSessionKey).

2. Using the session key from the previous step, SUSE Manager Server IDs are obtained for all the
peripheral servers attached to the Hub via the hub.1istServerIds method

3. Acall to attachToServers is made, and the same credentials used to sign in to the Hub are passed to
each server. This performs authentication against each server’ s XMLRPC AP| endpoint.

4. Amulticast callis performed on a set of servers. This is defined by serverIds, which contains the IDs
of the servers to target. In the background, system.list_system is called on each server’ s XMLRPC
API.
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5. Hub aggregates the results and returns the response in the form of a map. The map has two entries:
O Successful: list of responses for those peripheral servers where the call succeeded.

O Failed: list of responses for those peripheral servers the call failed.

=& 12. Example Python Script for Relay Authentication:

#!/usr/bin/python3
import xmlrpc.client

HUB_XMLRPC_API_URL ="<HUB_XMLRPC_API_URL>"

HUB_USERNAME ="<USERNAME>"

HUB_PASSWORD ="<PASSWORD>"

client = xmlrpc.client.ServerProxy(HUB_XMLRPC_API_URL, verbose=0)

hubSessionKey = client.hub.loginWithAuthRelayMode(HUB_USERNAME, HUB_PASSWORD)

# Get the server IDs
serverlds = client.hub.listServerlds(hubSessionKey)

# Authenticate those servers(same credentials will be used as of hub to authenticate)
client.hub.attachToServers(hubSessionKey, serverlds)

# Perform the needed operation

systemsPerServer = client. multicast.system.list_systems(hubSessionKey, serverlds)
successfulResponses = systemsPerServer["Successful"]["Responses"]
failedResponses = systemsPerServer|["Failed"]["Responses"]

for system in successfulResponses:
print(system)

# Log out
client.hub.logout(hubSessionKey)

Example: Auto-Connect Authentication

Auto-connect mode is similar to relay mode, it uses the Hub credentials to sign in in to all peripheral
servers. However, there is no need to use the attachToServers method, as auto-connect mode connects
to all available peripheral servers. This occurs at the same time as you sign in to the Hub.

A typical workflow for auto-connect authentication is:

1. Credentials for the Hub are passed to the loginWithAutoconnectMode method, and a session key for
the Hub is returned (hubSessionKey).

2. Amulticast call is performed on a set of servers. This is defined by serverIds, which contains the IDs
of the servers to target. In the background, system.list_system is called on each server’ s XMLRPC
API.

3. Hub aggregates the results and returns the response in the form of a map. The map has two entries:
O Successful: list of responses for those peripheral servers where the call succeeded.

O Failed: list of responses for those peripheral servers where the call failed.
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= £ 13. Example Python Script for Auto-Connect Authentication:

#!/usr/bin/python3
import xmlrpc.client

HUB_XMLRPC_API_URL ="<HUB_XMLRPC_API_URL>"
HUB_USERNAME ="<USERNAME>"

HUB_PASSWORD = "<PASSWORD>"

client = xmlrpc.client.ServerProxy(HUB_XMLRPC_API_URL, verbose=0)

lo%:i)n Response = client.hub.loginWithAutoconnectMode(HUB_USERNAME, HUB_PASSWORD)
hubSessionKey = loginResponse["SessionKey"]

# Get the server IDs
serverlds = client.hub.listServerlds(hubSessionKey)

# Perform the needed operation

systemsPerServer = client. multicast.system.list_systems(hubSessionKey, serverlds)
successfulResponses = systemsPerServer["Successful"]["Responses"]
failedResponses = systemsPerServer["Failed"]["Responses"]

for system in successfulResponses:
print(system)

# Log out
client.hub.logout(hubSessionKey)

Hub Reporting

The Hub prepares and provides content for multiple peripheral SUSE Manager Servers. The goal of the
reporting feature is to get data from these Servers back and have combined reporting data available on
the Hub. The data is made available for external Reporting Tools.

Architecture

The main database is a PostgreSQL database in the SUSE Manager Hub system. It stores all the
information collected from all the servers, and aggregates them. Every peripheral Server has its own
reporting database where the information is collected for that system. In summary:

e the DB in SUSE Manager Hub stores, collects and aggregates data coming from all the DBs of the
peripheral Servers,

o the DB in SUSE Manager Hub stores also its own data from the systems directly connected and
managed by the Hub,

o the DB in peripheral SUSE Manager Server stores its own data,

e thereporting tool can be connected either to the Hub or to any SUSE Manager Server.

Setup

The reporting database and schema are set up by default using the local PostgreSQL server. The
reporting database is a separate database accessible via the network.
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As a requirement we expect all server certificates are signed by the same Root
o Certificate Authority (CA). The whole SUSE Manager Hub environment should be
using only one Root CA.

Create a DB user for the reporting

Before connecting an external Reporting Tools to the Database, a user with read-only permission should
be created. For doing that, it is possible to use uyuni-setup-reportdb-user.

usage: uyuni-setup-reportdb-user [options]

options:
--hel
show this help message and exit
--non-interactive
Switches to non-interactive mode
--dbuser=DBUSER
Report DB User
--dbpassword=DBPASSWORD
Report DB Password
--add
Add the new user
--delete
Delete the user
--modify
Set a new password

Database Schema

The schema exports the most important tables from the main SUSE Manager Database as a de-
normalized variant containing only data which are relevant for a report.

Ready-to-use reports are provided as views, aggregating data over multiple tables.

Every table gets an extra id column (mgm_id) specifying the SUSE Manager server which provided the
data. On a single SUSE Manager Server this column has the standard value 1 which represent localhost.
On the SUSE Manager Hub it is replaced with the real server id the managed server has in the hub

database.

Another common additional field is synced_date, which represents the time when the data were
exported from the main SUSE Manager Server database.

Navigate to Help » Report Database Schema to find the schema documentation.

Data Generation and Update

SUSE Manager uses taskomatic jobs to generate the data for the reporting database and to get the data
from the peripheral servers to the hub.

To generate and update the data on a peripheral server, the responsible schedule is called update-
reporting-default. Itis executed by default daily at midnight.

On the SUSE Manager Hub there is a second schedule which is important. To fetch the reporting data
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from all registered peripheral servers, the task with the name update-reporting-hub-default is executed

daily at 1:30 AM.

All times are in the local timezone of the server. If the peripheral servers are in different timezones, it is
recommended to align all the schedules. Make sure that all reporting data are gathered at a specific
point in time, and update-reporting-hub-default is running when all peripheral servers have actually

finished their local jobs.

Tuning Reporting Jobs

report_db_batch_size

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

report_db_hub_workers

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

The maximum number of rows fetched and written
from one database to the other in one shot.

Out of memory errors or on processing speed
problems.

2000
500 - 5000
/etc/rhn/rhn.conf

report_db_batch_size = 4000

Check memory usage. Monitor memory usage
closely before and after the change.

The maximum number of workers requesting data
from peripheral servers on a hub at the same point
in time.

The number of peripheral servers increases
significantly (more than 100), or a faster
synchronization is required.

2
2-10
/etc/rhn/rhn.conf

report_db_hub_workers = 5

Check memory usage. Monitor memory and cpu
usage of the hub closely before and after the
change. Also monitor the load, cpu and memory
usage of the reporting database of the hub.
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Notes All the data collected from the peripheral server
must be written into the hub reporting database.
Tuning that database could increase the
performance as well.

Managing Large Scale Deployments in a Retail Environment

SUSE Manager for Retail '5.0' is an open source infrastructure management solution, optimized and
tailored specifically for the retail industry. It uses the same technology as SUSE Manager, but is
customized to address the needs of retail organizations.

SUSE Manager for Retail is designed for use in retail situations where customers can use point-of-service
terminals to purchase or exchange goods, take part in promotions, or collect loyalty points. In addition
to retail installations, it can also be used for novel purposes, such as maintaining student computers in
an educational environment, or self-service kiosks in banks or hospitals.

SUSE Manager for Retail is intended for use in installations that include servers, workstations, point-of-
service terminals, and other devices. It allows administrators to install, configure, and update the
software on their servers, and manage the deployment and provisioning of point-of-service machines.

Point-of-Service (POS) terminals can come in many different formats, such as point-of-sale terminals,
kiosks, digital scales, self-service systems, and reverse-vending systems. Every terminal, however, is
provided by a vendor, who set basic information about the device in the firmware. SUSE Manager for
Retail accesses this vendor information to determine how best to work with the terminal in use.

In most cases, different terminals will require a different operating system (OS) image to ensure they
work correctly. For example, an information kiosk has a high-resolution touchscreen, where a cashier
terminal might only have a very basic display. While both of these terminals require similar processing
and network functionality, they will require different OS images. The OS images ensure that the different
display mechanisms work correctly.

For more information about setting up and using SUSE Manager for Retail, see Retail > Retail-overview.

Tuning Large Scale Deployments

SUSE Manager is designed by default to work on small and medium scale installations. For installations
with more than 1000 clients per SUSE Manager Server, adequate hardware sizing and parameter tuning
must be performed.

The instructions in this section can have severe and catastrophic performance
impacts when improperly used. In some cases, they can cause SUSE Manager to

A completely cease functioning. Always test changes before implementing them in a
production environment. During implementation, take care when changing
parameters. Monitor performance before and after each change, and revert any steps
that do not produce the expected result.
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We strongly recommend that you contact SUSE Consulting for assistance with
tuning.

SUSE will not provide support for catastrophic failure when these advanced
parameters are modified without consultation.

n Tuning is not required on installations of fewer than 1000 clients. Do not perform
these instructions on small or medium scale installations.

The Tuning Process

Any SUSE Manager installation is subject to a number of design and infrastructure constraints that, for
the purposes of tuning, we call environmental variables. Environmental variables can include the total
number of clients, the number of different operating systems under management, and the number of
software channels.

Environmental variables influence, either directly or indirectly, the value of most configuration
parameters. During the tuning process, the configuration parameters are manipulated to improve
system performance.

Before you begin tuning, you will need to estimate the best setting for each environment variable, and
adjust the configuration parameters to suit.

To help you with the estimation process, we have provided you with a dependency graph. Locate the
environmental variables on the dependency graph to determine how they will influence other variables
and parameters.

Environmental variables are represented by graph nodes in a rectangle at the top of the dependency
graph. Each node is connected to the relevant parameters that might need tuning. Consult the relevant
sections in this document for more information about recommended values.

Tuning one parameter might require tuning other parameters, or changing hardware, or the
infrastructure. When you change a parameter, follow the arrows from that node on the graph to
determine what other parameters might need adjustment. Continue through each parameter until you
have visited all nodes on the graph.
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Key to the Dependency Graph

o 3D boxes are hardware design variables or constraints

o Oval-shaped boxes are software or system design variables or constraints

o Rectangle-shaped boxes are configurable parameters, color-coded by configuration file:
O Red: Apache httpd configuration files
O Blue: Salt configuration files
O Brown: Tomcat configuration files
O Grey: PostgreSQL configuration files
O Purple: /ete/rhn/rhn.conf

o Dashed connecting lines indicate a variable or constraint that might require a change to another
parameter

o Solid connecting lines indicate that changing a configuration parameter requires checking another
one to prevent issues

After the initial tuning has been completed, you will need to consider tuning again in these cases:

o If yourtuninginputs change significantly

o If special conditions arise that require a certain parameter to be changed. For example, if specific
warnings appear in a log file.

o If performance is not satisfactory

To re-tune your installation, you will need to use the dependency graph again. Start from the node
where significant change has happened.
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Environmental Variables

This section contains information about environmental variables (inputs to the tuning process).

Network Bandwidth

A measure of the typically available egress bandwith from the SUSE Manager Server host to the
clients or SUSE Manager Proxy hosts. This should take into account network hardware and topology
as well as possible capacity limits on switches, routers, and other network equipment between the
server and clients.

Channel count

The number of expected channels to manage. Includes any vendor-provided, third-party, and cloned
or staged channels.

Client count

The total number of actual or expected clients. It is important to tune any parameters in advance of
a client count increase, whenever possible.

0S mix

The number of distinct operating system versions that managed clients have installed. This is
ordered by family (SUSE Linux Enterprise, openSUSE, Red Hat Enterprise Linux, or Ubuntu based).
Storage and computing requirements are different in each case.

User count

The expected maximum amount of concurrent users interacting with the Web Ul plus the number of
programs simultaneously using the XMLRPC API. Includes spacecmd, spacewalk-clone-by-date, and
similar.

Parameters

This section contains information about the available parameters.

MaxClients

Description The maximum number of HTTP requests served
simultaneously by Apache httpd. Proxies, Web Ul,
and XMLRPC API clients each consume one.
Requests exceeding the parameter will be queued
and might result in timeouts.

Tune when User count and proxy count increase significantly
and this line appears in
/var/log/apache2/error_log: [---]
[mpm_prefork:error] [pid ---] AHO0161: server
reached MaxRequestWorkers setting, consider
raising the MaxRequestWorkers setting.

Value default 150
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Value recommendation 150-500

Location /etc/apache2/server-tuning.conf, in the prefork.c
section
Example MaxClients = 200

After changing Immediately change ServerLimit and check

maxThreads for possible adjustment.

Notes This parameter was renamed to
MaxRequestWorkers, both names are valid.

More information https://httpd.apache.org/docs/2.4/en/mod/

mpm_common.html#maxrequestworkers

ServerLimit

Description The number of Apache httpd processes serving
HTTP requests simultaneously. The number must
equal Max(Clients.

Tune when MaxClients changes

Value default 150

Value recommendation The same value as MaxClients

Location /etc/apache2/server-tuning.conf, in the prefork.c
section
Example ServerlLimit = 200

More information https://httpd.apache.org/docs/2.4/en/mod/

mpm_common.html#serverlimit

maxThreads

Description The number of Tomcat threads dedicated to
serving HTTP requests

Tune when MaxClients changes. maxThreads must always be
equal or greater than Max(Clients

Value default 150

Value recommendation

Location
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The same value as MaxClients

/etc/tomcat/server.xml
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Example

More information

connectionTimeout

Description

Tune when

Value default
Value recommendation
Location

Example

More information

keepAliveTimeout

Description

Tune when

Value default
Value recommendation

Location
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<Connector port="8009" protocol="AJP/1.3"
redirectPort="8443" URIEncoding="UTF-8"
address="127.0.0.1" maxThreads="200"
connectionTimeout="20000"/>

https://tomcat.apache.org/tomcat-9.0-doc/
config/http.html

The number of milliseconds before a non-
responding AJP connection is forcibly closed.

Client count increases significantly and AH00992,
AH00877, and AHB1030 errors appear in Apache error
logs during a load peak.

900000
20000-3600000
/etc/tomcat/server.xml

<Connector port="8009" protocol="AJP/1.3"
redirectPort="8443" URIEncoding="UTF-8"
address="127.0.0.1" maxThreads="200"
connectionTimeout="1000000"
keepAliveTimeout="300000"/>

https://tomcat.apache.org/tomcat-9.0-doc/
config/http.html

The number of milliseconds without data
exchange from the JVM before a non-responding
AJP connection is forcibly closed.

Client count increases significantly and AH00992,
AH00877, and AH01030 errors appear in Apache error
logs during a load peak.

300000
20000-600000

/etc/tomcat/server.xml
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Example

More information

Tomcat’ s -Xmx

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

More information

java.disable_list_update_status

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

Notes

More information
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<Connector port="8009" protocol="AJP/1.3"
redirectPort="8443" URIEncoding="UTF-8"
address="127.0.0.1" maxThreads="200"
connectionTimeout="1000000"
keepAliveTimeout="400000"/>

https://tomcat.apache.org/tomcat-9.0-doc/
config/http.html

The maximum amount of memory Tomcat can use

java.message_queue_thread_pool_sizeis
increased or QutOfMemoryException errors appearin
/var/log/rhn/rhn_web_ui.log

1GiB

4-8 GiB
/etc/tomcat/conf.d/tomcat_java_opts.conf
JAVA_OPTS="+-- -Xmx8G ---"

Check memory usage

https://docs.oracle.com/javase/8/docs/
technotes/tools/windows/java.html

Disable displaying the update status for clients of a
system group

displaying the update status causes timeouts

false

/etc/rhn/rhn.conf

java.disable_list_update_status = true

?

man rhn.conf
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java.message_queue_thread_pool_size

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

Notes

More information

java.salt_batch_size

Description
Tune when

Value default

Value recommendation
Location

Example

After changing

More information
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The maximum number of threads in Tomcat
dedicated to asynchronous operations

Client count increases significantly

5

50-150

/etc/rhn/rhn.conf
java.message_queue_thread_pool_size = 50

Check hibernate.c3p@.max_size, as each thread
consumes a PostgreSQL connection, starvation
might happen if the allocated connection pool is

insufficient. Check thread_pool, as each thread
might perform Salt API calls, starvation might
happen if the allocated Salt thread pool is
insufficient. Check Tomcat™ s -Xmx, as each

thread consumes memory, OutOfMemoryException
might be raised if insufficient.

Incoming Salt events are handled in separate
thread pool, see

java.salt_event_thread_pool_size

man rhn.conf

The maximum number of minions concurrently
executing a scheduled action.

Client count reaches several thousands and
actions are not executed quickly enough.

200
200-500
/etc/rhn/rhn.conf

java.salt_batch_size = 300

Check memory usage. Monitor memory usage
closely before and after the change.

Specialized-guides > Salt
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java.salt_event_thread_pool_size

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

More information

java.salt_presence_ping_timeout

Description

_ | Tuning Large Scale Deployments

The maximum number of threads in Tomcat
dedicated to handling of incoming Salt events.

The number of queued Salt events grows.
Typically, this can happen during onboarding of
large number of minions with higher value of
java.salt_presence_ping_timeout. The number
of events can be queried by echo "select count(*)
from susesaltevent;" | spacewalk-sql --select
-mode-direct -

8

20-100

/etc/rhn/rhn.conf
java.salt_event_thread_pool_size = 50

Check the length of Salt event queue. Check
hibernate.c3p0.max_size, as each thread
consumes a PostgreSQL connection, starvation
might happen if the allocated connection pool is
insufficient. Check thread_pool, as each thread
might perform Salt API calls, starvation might
happen if the allocated Salt thread pool is
insufficient. Check Tomcat™ s -Xmx, as each
thread consumes memory, OutOfMemoryException
might be raised if insufficient.

man rhn.conf

Before any action is executed on a client, a
presence ping is executed to make sure the client
is reachable. This parameter sets the amount of
time before a second command (in most cases
state.apply or any other Salt function) is sent to
the client to verify its presence. Having many
clients typically means some will respond faster
than others, so this timeout could be raised to
accommodate for the slower ones.

132/159



Tune when Client count increases significantly, or some
clients are responding correctly but too slowly,
and SUSE Manager excludes them from calls. This
line appearsin /var/log/rhn/rhn_web_ui.log: "Got
no result for <COMMAND> on minion <MINION_ID>
(minion did not respond in time)"

Value default 4 seconds

Value recommendation 4-20 seconds

Location /ete/rhn/rhn.conf

Example java.salt_presence_ping_timeout = 10

After changing Large java.salt_presence_ping_timeout value can

reduce overall throughput. This can be
compensated by increasing

java.salt_event_thread_pool_size

More information Specialized-guides » Salt

java.salt_presence_ping_gather_job_timeout

Description Before any action is executed on a client, a
presence ping is executed to make sure the client
is reachable. After
java.salt_presence_ping_timeout seconds have
elapsed without a response, a second command
(in most cases state.apply or any other Salt
function) is sent to the client and if there is no
response from the client for the amount of seconds
specified with this parameter one more call
(saltutil.find_job) is sent for a final check. This
parameter sets the number of seconds after the
second command after which the client is
definitely considered timeout. Having many clients
typically means some will respond faster than
others, so this timeout could be raised to
accommodate for the slower ones.

Tune when Client count increases significantly, or some
clients are responding correctly but too slowly,
and SUSE Manager excludes them from calls. This
line appearsin /var/log/rhn/rhn_web_ui.log: "Got
no result for <COMMAND> on minion <MINION_ID>
(minion did not respond in time)"

Value default 1 second

Value recommendation 1-50 seconds
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Location
Example

More information

/etc/rhn/rhn.conf
java.salt_presence_ping_gather_job_timeout = 20

Specialized-guides > Salt

java.taskomatic_channel_repodata_workers

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

More information

taskomatic.java.maxmemory

Description

_ | Tuning Large Scale Deployments

Whenever content is changed in a software
channel, its metadata needs to be recomputed
before clients can use it. Channel-altering
operations include the addition of a patch, the
removal of a package or a repository
synchronization run. This parameter specifies the
maximum number of Taskomatic threads that
SUSE Manager will use to recompute the channel
metadata. Channel metadata computation is both
CPU-bound and memory-heavy, so raising this
parameter and operating on many channels
simultaneously could cause Taskomatic to
consume significant resources, but channels will
be available to clients sooner.

Channel countincreases significantly (more than
50), or more concurrent operations on channels
are expected.

2
2-10
/etc/rhn/rhn.conf

java.taskomatic_channel_repodata_workers = 4

Check taskomatic.java.maxmemory for
adjustment, as every new thread will consume
memory

man rhn.conf

The maximum amount of memory Taskomatic can
use. Generation of metadata, especially for some
0Ss, can be memory-intensive, so this parameter
might need raising depending on the managed OS
Mmix.
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Tune when

Value default

Value recommendation
Location

Example

After changing

More information

org.quartz.threadPool.threadCount

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

More information

org.quartz.scheduler.idleWaitTime

Description

Tune when
Value default
Value recommendation

Location

_ | Tuning Large Scale Deployments

java.taskomatic_channel_repodata_workers
increases, OSs are added to SUSE Manager
(particularly Red Hat Enterprise Linux or Ubuntu),
or QutOfMemoryException errors appearin
/var/log/rhn/rhn_taskomatic_daemon.log.

4096 MiB

4096-16384 MiB
/etc/rhn/rhn.conf
taskomatic.java.maxmemory = 8192
Check memory usage.

man rhn.conf

The number of Taskomatic worker threads.
Increasing this value allows Taskomatic to serve
more clients in parallel.

Client count increases significantly
20

20-200

/ete/rhn/rhn.conf

org.quartz.threadPool.threadCount = 100

Check hibernate.c3p@.max_size and
thread_pool for adjustment

http://www.quartz-scheduler.org/
documentation/2.4.0-SNAPSHOT/
configuration.html

Cycle time for Taskomatic. Decreasing this value
lowers the latency of Taskomatic.

Client countisin the thousands.
5000 ms
1000-5000 ms

/ete/rhn/rhn.conf
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Example

More information

MinionActionExecutor.parallel_threads

Description

Tune when

Value default

Value recommendation
Location

Example

org.quartz.scheduler.idleWaitTime = 1000

http://www.quartz-scheduler.org/
documentation/2.4.0-SNAPSHOT/
configuration.html

Number of Taskomatic threads dedicated to
sending commands to Salt clients as a result of
actions being executed.

Client countisin the thousands.
1

1-10

/ete/rhn/rhn.conf

taskomatic.com.redhat.rhn.taskomatic.task.Minio
nActionExecutor.parallel_threads = 10

SSHMinionActionExecutor.parallel_threads

Description

Tune when

Value default

Value recommendation
Location

Example

hibernate.c3p0@.max_size

Description

_ | Tuning Large Scale Deployments

Number of Taskomatic threads dedicated to
sending commands to Salt SSH clients as a result
of actions being executed.

Client countisin the hundreds.
20

20-100

/ete/rhn/rhn.conf

taskomatic.com.redhat.rhn.taskomatic.task.SSHMi
nionActionExecutor.parallel_threads = 40

Maximum number of PostgreSQL connections
simultaneously available to both Tomcat and
Taskomatic. If any of those components requires
more concurrent connections, their requests will
be queued.
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Tune when

Value default

Value recommendation

Location
Example
After changing

More information

rhn-search.java.maxmemory

Description

Tune when

Value default

Value recommendation
Location

Example

After changing

shared_buffers

Description

Tune when

Value default

_ | Tuning Large Scale Deployments

java.message_queue_thread_pool_size or
maxThreads increase significantly, or when

org.quartz.threadPool.threadCount has
changed significantly. Each thread consumes one
connection in Taskomatic and Tomcat, having
more threads than connections might result in
starving.

20

100 to 200, higher than the maximum of
java.message_queue_thread_pool_size +
maxThreads and
org.quartz.threadPool.threadCount

/etc/rhn/rhn.conf
hibernate.c3p@.max_size = 100
Check max_connections for adjustment.

https://www.mchange.com/projects/c3p0/#
maxPoolSize

The maximum amount of memory that the rhn-
search service can use.

Client count increases significantly, and
OutOfMemoryException errors appearin journalctl
-u rhn-search.

512 MiB
512-4096 MiB
/etc/rhn/rhn.conf

rhn-search.java.maxmemory = 4096

Check memory usage.

The amount of memory reserved for PostgreSQL
shared buffers, which contain caches of database
tables and index data.

RAM changes

25% of total RAM
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Value recommendation
Location

Example

After changing

More information

max_connections

Description

Tune when

Value default

Value recommendation

Location
Example

After changing

More information

work_mem

Description

_ | Tuning Large Scale Deployments

25-40% of total RAM
/var/1ib/pgsql/data/postgresql.conf
shared_buffers = 8192MB

Check memory usage.

https://www.postgresql.org/docs/15/runtime-
config-resource.htm#GUC-SHARED-BUFFERS

Maximum number of PostgreSQL connections
available to applications. More connections allow
for more concurrent threads/workers in various
components (in particular Tomcat and
Taskomatic), which generally improves
performance. However, each connection
consumes resources, in particular work_mem
megabytes per sort operation per connection.

hibernate.c3p0.max_size changes significantly,
as that parameter determines the maximum
number of connections available to Tomcat and
Taskomatic

400

Depends on other settings, use
/usr/1ib/susemanager/bin/susemanager -
connection-check to obtain a recommendation.

/var/1ib/pgsql/data/postgresql.conf
max_connections = 250

Check memory usage. Monitor memory usage
closely before and after the change.

https://www.postgresqgl.org/docs/15/runtime-
config-connection.htmI#GUC-MAX-
CONNECTIONS

The amount of memory allocated by PostgreSQL
every time a connection needs to do a sort or hash
operation. Every connection (as specified by
max_connections) might make use of an amount
of memory equal to a multiple of work_mem.
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Tune when

Value recommendation
Location
Example

After changing

More information

effective_cache_size

Description

Tune when

Value recommendation

Location
Example
After changing

Notes

More information
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Database operations are slow because of excessive
temporary file disk I/0. To test if that is happening,
add log_temp_files = 5120 to
/var/1ib/pgsql/data/postgresql.conf, restart
PostgreSQL, and monitor the PostgreSQL log files.
If you see lines containing L0G: temporary file: try
raising this parameter’ s value to help reduce disk
I/0 and speed up database operations.

2-20 MB
/var/1ib/pgsql/data/postgresql.conf
work_mem = 10MB

check if the SUSE Manager Server might need
additional RAM.

https://www.postgresql.org/docs/15/runtime-
config-resource.htm#GUC-WORK-MEM

Estimation of the total memory available to
PostgreSQL for caching. It is the explicitly reserved

memory (shared_buffers) plus any memory used
by the kernel as cache/buffer.

Hardware RAM or memory usage increase
significantly

Start with 75% of total RAM. For finer settings, use

shared_buffers + free memory + buffer/cache
memory. Free and buffer/cache can be determined
viathe free -mcommand (free and buff/cache in
the output respectively)

/var/1ib/pgsql/data/postgresql.conf
effective_cache_size = 24GB
Check memory usage

This is an estimation for the query planner, not an
allocation.

https://www.postgresqgl.org/docs/15/runtime-
config-query.html#GUC-EFFECTIVE-CACHE-
SIZE
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thread_pool

Description

Tune when

Value default

Value recommendation

Location

Example
After changing

More information

worker_threads

Description

Tune when
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The number of worker threads serving Salt API
HTTP requests. A higher number can improve
parallelism of SUSE Manager Server-initiated Salt
operations, but will consume more memory.

java.message_queue_thread_pool_size or
org.quartz.threadPool.threadCount are
changed. Starvation can occur when there are
more Tomcat or Taskomatic threads making
simultaneous Salt API calls than there are Salt API
worker threads.

100

100-500, but should be higher than the sum of
java.message_queue_thread_pool_size and
org.quartz.threadPool.threadCount

/etc/salt/master.d/susemanager.conf, in the
rest_cherrypy section.

thread_pool: 100
Check worker_threads for adjustment.

https://docs.saltstack.com/en/latest/ref/
netapi/all/salt.netapi.rest_cherrypy.html#
performance-tuning

The number of salt-master worker threads that
process commands and replies from minions and
the Salt API. Increasing this value, assuming
sufficient resources are available, allows Salt to
process more data in parallel from minions
without timing out, but will consume significantly
more RAM (typically about 70 MiB per thread).
Setting this value to very high values could cause
opposite effect as the workers will compete to
each other for the CPU resources and the
performance could be dropped significantly.

Client count increases significantly, thread_pool
increases significantly, or SaltReqTimeoutError or
Message timed out errors appearin
/var/log/salt/master could be a sign of too low or
too high value of this parameter.
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Value default

Value recommendation

Location
Example

After changing

More information

auth_events

Description

Tune when

Value default

Value recommendation
Location

Example

More information

minion_data_cache_events
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8

8-32, depending on the number of the CPU cores
available for the server, it is recommended to keep
the value slightly less than the number of CPU
cores.

/ete/salt/master.d/tuning.conf

worker_threads: 16

Check memory usage. Monitor memory usage
closely before and after the change. It makes sense
to monitor the salt-master stats event by enabling
master_stats and adjusting
master_stats_event_iter to fine tune the value of
this parameter.

https://docs.saltstack.com/en/latest/ref/
configuration/master.html#worker-threads

Determines whether the master will fire
authentication events. Authentication events are
fired when a minion performs an authentication
check with the master. It helps to reduce the
number of events published with the Salt Master
Event Publisher and reduce the workload on Event
Publisher subscribers.

Large amount of salt/auth events published in the
Salt event bus, which in most cases are useless for
the subscribers.

True
False
/ete/salt/master.d/tuning.conf

auth_events: False

https://docs.saltproject.io/en/latest/ref/
configuration/master.html#auth-events
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Description

Tune when

Value default

Value recommendation
Location

Example

More information

pub_hwm

Description

Tune when

Value default

Value recommendation
Location

Example

More information

_ | Tuning Large Scale Deployments

Determines whether the master will fire minion
data cache events (minion/refresh/*). Minion data
cache events are fired when a minion requests a
minion data cache refresh. It helps to reduce the
number of events published with the Salt Master
Event Publisher and reduce the workload on Event
Publisher subscribers.

Large amount of minion/refresh/* events
published in the Salt event bus, which in most
cases are useless for the subscribers.

True
False
/ete/salt/master.d/tuning.conf

minion_data_cache_events: False

https://docs.saltproject.io/en/latest/ref/
configuration/master.html#minion-data-cache-
events

The maximum number of outstanding messages
sent by salt-master. If more than this number of
messages need to be sent concurrently,
communication with clients slows down,
potentially resulting in timeout errors during load
peaks.

Client count increases significantly and Salt
request timed out. The master is not
responding. errors appear when pinging minions
during a load peak.

1000
10000-100000
/ete/salt/master.d/tuning.conf

pub_hwm: 10000

https://docs.saltstack.com/en/latest/ref/
configuration/master.html#pub-hwm,
https://zeromq.org/socket-api/#high-water-
mark
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zmq_backlog

Description

Tune when

Value default

Value recommendation
Location

Example

More information

swappiness

Description

Tune when

Value default

Value recommendation

Location
Example

More information

_ | Tuning Large Scale Deployments

The maximum number of allowed client
connections that have started but not concluded
the opening process. If more than this number of
clients connects in a very short time frame,
connections are dropped and clients experience a
delay re-connecting.

Client count increases significantly and very many
clients reconnect in a short time frame, TCP
connections to the salt-master process get
dropped by the kernel.

1000
1000-5000
/etc/salt/master.d/tuning.conf

zmq_backlog: 2000

https://docs.saltstack.com/en/latest/ref/
configuration/master.html#zmg-backlog,
http://api.zeromq.org/3-0:zmqg-getsockopt
(ZMQ_BACKLOG)

How aggressively the kernel moves unused data
from memory to the swap partition. Setting a
lower parameter typically reduces swap usage and
results in better performance, especially when
RAM memory is abundant.

RAM increases, or swap is used when RAM memory
is sufficient.

60

1-60. For 128 GB of RAM, 10 is expected to give
good results.

/etc/sysctl.conf

vm.swappiness = 20

https://documentation.suse.com/sles/15-SP4/
html/SLES-all/cha-tuning-memory.html#cha-
tuning-memory-vm
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wait_for_backend

Description

Tune when

Value default

Value recommendation
Location

Example

More information

tep_keepalive

Description

Tune when

Value default
Value recommendation

Location

Example

After changing

More information

_ | Tuning Large Scale Deployments

Determines whether the salt-broker service
should wait for backend sockets to be connected
before opening the sockets for listening for
connections from salt-minions. When enabled, it
helps to prevent collecting ZeroMQ messages with
the internal buffers of the sockets and pushing
them to the salt-master once connection is
restored.

Unstable connectivity between the SUSE Manager
Proxy and the SUSE Manager Server.

False
True
/etc/salt/broker

wait_for_backend: True

Proxies Connectivity

The tcp keepalive interval to set on TCP ports. This
setting can be used to tune Salt connectivity issues
in messy network environments with misbehaving
firewalls.

Unstable connectivity between managed clients
and the SUSE Manager Proxy or the SUSE Manager
Server.

True
True

/etc/venv-salt-minon/minion.d/tuning.conf or
/ete/salt/minion.d/tuning.conf, depending on the
minion type.

tep_keepalive: True

Check Minions Connectivity for more details to
fine tune extra keepalive parameters.

https://docs.saltproject.io/en/latest/ref/
configuration/minion.html#tcp-keepalive,
Minions Connectivity
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Memory Usage

Adjusting some of the parameters listed in this section can result in a higher amount of RAM being used
by various components. It is important that the amount of hardware RAM is adequate after any
significant change.

To determine how RAM is being used, you will need to check each process that consumesit.

Operating system

Stop all SUSE Manager services and inspect the output of free -h.

Java-based components

This includes Taskomatic, Tomcat, and rhn-search. These services support a configurable memory
cap.

The SUSE Manager Server

Depends on many factors and can only be estimated. Measure PostgreSQL reserved memory by
checking shared_buffers, permanently. You can also multiply work_mem and max_connections, and
multiply by three for a worst case estimate of per-query RAM. You will also need to check the
operating system buffers and caches, which are used by PostgreSQL to host copies of database data.
These often automatically occupy any available RAM.

It is important that the SUSE Manager Server has sufficient RAM to accommodate all of these processes,
especially OS buffers and caches, to have reasonable PostgreSQL performance. We recommend you
keep several gigabytes available at all times, and add more as the database size on disk increases.

Whenever the expected amount of memory available for OS buffers and caches changes, update the
effective_cache_size parameter to have PostgreSQL use it correctly. You can calculate the total

available by finding the total RAM available, less the expected memory usage.

To get a live breakdown of the memory used by services on the SUSE Manager Server, use this
command:

pidstat -p ALL -r --human 1 60 | tee pidstat-memory.log

This command will save a copy of displayed data in the pidstat-memory.1log file for later analysis.

Monitoring Large Scale Deployments

You can monitor your SUSE Manager environment using Prometheus and Grafana. SUSE Manager Server
and Proxy are able to provide self-health metrics. You can also install and manage a number of
Prometheus exporters on clients.

Prometheus and Grafana packages are included in the SUSE Manager Client Tools for SUSE Linux
Enterprise 12, SUSE Linux Enterprise 15, Red Hat Enterprise Linux 7, Red Hat Enterprise Linux 8 and
openSUSE 15.x.

You need to install Prometheus and Grafana on a machine separate from the SUSE Manager Server. We
recommend you use a managed client as your monitoring server.
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Monitoring Large Scale Deployments

For more information on monitoring, see Administration > Monitoring.
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Quick Start: SAP Overview

Updated: 2024-11-18

This guide shows you how to use SUSE Manager to install and configure an SAP cluster. It guides you
through setting up a single SUSE Manager Server, preparing your client systems, and configuring the
cluster using formulas.

e For more information about SAP, see the SAP documentation at
https://documentation.suse.com/sles-sap.

e For more information about SUSE Manager, see the SUSE Manager documentation at
https://documentation.suse.com/suma.

Prepare Server

Before you start you need to deploy the SUSE Manager Server. The method for deploying the SUSE
Manager Server varies depending on your hardware and environment.

SUSE Manager is deployed using the mgradm command. During the deployment process, when you are
prompted for which product to install, select SUSE Manager Server. For more information about

deploying the SUSE Manager Server, see Installation-and-upgrade > Container-deployment.

You need to do some configuration to set up the SUSE Manager Web Ul. In your browser, navigate to the
URL of the server, and configure your administration access to the Web UI.

Now you can use the Web Ul to prepare software channels and activation keys for your clients.

On the SUSE Manager Server, add the appropriate SAP channels: From the Web Ul, add SUSE Linux
Enterprise Server 15 for SAP.

Synchronize the SUSE Manager Server with the SUSE Customer Center. You can do this using the Web Ul.
Add the new channel to your activation key.

To check if a channel has finished synchronizing navigate to Admin > Setup Wizard and select the
Products tab. This dialog displays a completion bar for each product when they are being synchronized.

Software channels can be very large. The initial channel synchronization can
sometimes take up to several hours.
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Preparing Clients

Your SAP cluster requires several client systems. Prepare your clients on physical or virtual hardware,
and ensure you have SUSE Linux Enterprise Server 15 for SAP installation media ready. You cannot
create an SAP cluster without the SUSE Linux Enterprise Server SAP extension, as it provides tooling
specific to SAP.
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One of the key features of SAP is high availability of the cluster. Every component within an SAP cluster
has redundancy and failover protection. When you are preparing your clients, ensure you have enough
hardware and infrastructure to allow for this. For more information about hardware requirements, see

https://documentation.suse.com/sles-sap/15-SP4/html/SLES-SAP-installation/cha-plan.html#
sec-hardware

For more information about the clients you need to set up for an SAP cluster, see
https://documentation.suse.com/sbp/all.

Register Clients to the SUSE Customer Center

Each client within your SAP cluster must be registered with the SUSE Customer Center. To obtain your
registration code, navigate to https://scc.suse.com/login in your web browser. Log in to your SCC
account, or follow the prompts to create a new account. Click the [ Subscriptions] tab to see the
registration code. When you install SUSE Linux Enterprise Server 15 for SAP the Unified Installer prompts
you for the code.

For more information about registering SUSE Manager with SUSE Customer Center, see Installation-
and-upgrade > General-requirements.

Configure the Clients for Clustering

Every client system must have all the other client systems listed in their /etc/hosts file. Open the
/etc/hosts file on each client, and add the hostname for each of the other clients.

Create a Shared Storage Device

Each of the clients needs to be able to access a shared disk. The shared disk can be physical hardware
connected by ethernet, or you can set up a virtual disk and access it with iSCSI.

If you use a virtual disk, consider hosting it on a separate system. Do not use a client machine to host the
shared storage disk.

Download the SAP Installation Software

Download the SAP installation media and save a copy on each client. The software that you require
differs depending on your environment. For example, if you are using HANA, you need the SAP HANA
platform. If you are using Netweaver, you need different packages. These software packages are
provided by SAP, not by SUSE.

Ensure you have saved the installation software in the same file system location on each client.
Alternatively, save it to a shared NFS drive.

Configure Clients to Use Latest module.run

Each client needs to be configured to use the latest version of module.run. On each of the client
machines, open the /etc/salt/minion configuration file and add or edit this line:
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use_superseded:
- module.run

Restart the salt-minion process to enable the changes:

systemctl restart salt-minion

Install Additional Disks for HANA

For the clients that are going to run the HANA database, you require an additional storage device. This
device is used to store files required by HANA, which are located in the /hana/ directory.

We recommend that this storage device be at least 20 GB. For some installations, you might require
more, and it is possible to use multiple disks to provide this storage. For comprehensive hardware
requirements, see https://documentation.suse.com/sbp/all.

Register Clients to the Server

First of all, make sure you have an activation key that is associated with the SLE-Product-SLES_SAP15 base
channel. For more information about activation keys, see Client-configuration > Activation-keys.

In the SUSE Manager Web Ul, navigate to Systems > Bootstrapping. Fill in the appropriate details, and
make sure you check the Manage System Completely via SSH checkbox. In the Activation Key field, select
the SLES for SAP activation key.

For more information about registering, see Client-configuration » Registration-webui.

Configure Clients

SUSE Manager uses formulas with forms to configure your SAP clients. There are two formulas that you
need to use:

o Hana to configure the HANA database

o (luster to configure the clients into a cluster
The formulas are provided by packages that you can download with your package manager. You need to
install the formulas on the SUSE Manager Server. When you have installed the package, you can use the
SUSE Manager Web Ul to enable and configure the formulas. As you go through the formula

configuration process, provide details of the clients that contain your SAP cluster, to set them up
appropriately.

To install the formulas on the SUSE Manager Server, use your package manager to install these
packages:

e saphanabootstrap-formula

e Ssapnwbootstrap-formula
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e drbd-formula
e habootstrap-formula

e salt-shaptools

The order that you enable and configure the formulas is important. You must enable,

o configure, and apply the HANA formula first. Then you can enable, configure, and
apply the cluster formula. If you perform these steps in the wrong order, your SAP
installation fails.

Enable and Configure the HANA Formula

In the SUSE Manager Web Ul, navigate to Systems > System List and click the client to use as the
primary client in the cluster.

Navigate to the Formulas tab, locate the Sap Hana Deployment heading, and check the Saphanabootstrap
formula in the list. Click [ Save ] and apply the highstate to activate the formula.

When the formula is activated, navigate to the Formulas > Hana tab, and complete the details in the
form.

Make sure you check Install required packages to install everything you need on the client. In the Nodes

sections, type the short hostname of the client to install the HANA database or the hostname you can
retrieve on the command line with:

salt '<client-name>' grains.item host

Provide further details for the installation.

Complete the remaining details according to your environment, click [ Save ], and apply the highstate.
When the highstate is complete, you can go on to apply the cluster formula.
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Configure Clients

& test-client @

Details  Software  Configuration  Provisioning  Groups  Audit  States  Formulas  Events

[ Configuration Saphanabootstrap Formula

install and configure software.

Saphanabootstrap Formula

SAP HANA deployment formula

~ HANA

HANA
Install required packages:
~ Nodes
Nodes
Hostname ta install HANA:
HANA system identifier (SID):
HANA instance number:
SAP user password: a
HANA scenario type: performance-optimized
Install HANA:

~ Install new HANA instance

istall new HANA instance

Downloaded HANA software path:

Machine root user:

Machine root password: a

Enable and Configure the Cluster Formula

In the SUSE Manager Web Ul, navigate to Systems > System List
primary client in the cluster.

@ Delete System

2]
.
(7]
L 3
:
-

and click the client to use as the

Navigate to the Formulas tab, locate the Cluster heading, and check the Habootstrap formula in the list.

Click [ Save ] and apply the highstate to activate the formula.
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Formulas

Choose formulas:

Configure Clients

General System Configuration
Bind
Dhepd
Locale
System Lock
Trpd
Vsftpd
Clustering
Caasp Management Node
Caasp Management Settings
Security Configuration
Cpu Mitigations
Drbd Deployment
Drbd Formula
Monitoring
Grafana
Prometheus
Prametheus Exporters
Cluster
Hahoatstrap Formula
Sap Hana Deployment
Saphanaboatstrap Formula
Virtualization

Virtualization Host
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B Save | & Removeall

O Reset Changes

When the formula is activated, navigate to the Formulas > Cluster tab, and complete the details in the

form.

Make sure you check Install required packages to install everything you need on the client. Give your
cluster a name, and specify the hostname of the primary client in the cluster.

Complete the remaining details according to your environment, click [ Save ], and apply the highstate.
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& test-client @

Configure Clients

Details  Software  Configuration  Prowisioning ~ Groups  Audit  States Events
[# Configuration  Habootstrap Formula  Saphanabootstrap Formula
©n this page you can configure Salt Formul ically install and

€ Prev | Next $

SAP HANA deployment formula

~ HANA
HANA

Install required packages:

~ Nodes

Nades

Haostname to install HANA:

HANA system identifier (SID):

HANA instance number:

SAP user password:

HANA scenario type:

Install HANA:

~ Install new HANA instance

Install new HANA instance

Downloaded HANA software path:

Machine root user:

Machine root password:

Use configuration file:

SAP admin password (<sid>adm):

_| Configure Clients

performance-optimized

# Delete System

w A
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GNU Free Documentation License

Copyright © 2000, 2001, 2002 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, Boston, MA
02110-1301 USA. Everyone is permitted to copy and distribute verbatim copies of this license document,
but changing itis not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document
"free" in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with
or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for
the author and publisher a way to get credit for their work, while not being considered responsible for
modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must
themselves be free in the same sense. It complements the GNU General Public License, which is a
copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual
work, regardless of subject matter or whether it is published as a printed book. We recommend this
License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the
copyright holder saying it can be distributed under the terms of this License. Such a notice grants a
world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated
herein. The "Document", below, refers to any such manual or work. Any member of the public is a
licensee, and is addressed as "you". You accept the license if you copy, modify or distribute the work in a
way requiring permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’ s
overall subject (or to related matters) and contains nothing that could fall directly within that overall
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not
explain any mathematics.) The relationship could be a matter of historical connection with the subject
or with related matters, or of legal, commercial, philosophical, ethical or political position regarding
them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of
Invariant Sections, in the notice that says that the Document is released under this License. If a section
does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The
Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections
then there are none.
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The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document is released under this License. A Front-Cover Text may
be at most 5 words, and a Back-Cover Text may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose
specification is available to the general public, that is suitable for revising the document
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or
(for drawings) some widely available drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart or
discourage subsequent modification by readers is not Transparent. An image format is not Transparent
if used for any substantial amount of text. A copy that is not "Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML, PostScript or PDF designed for human modification. Examples of transparent image
formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be read and
edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are
not generally available, and the machine-generated HTML, PostScript or PDF produced by some word
processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats which
do not have any title page as such, "Title Page" means the text near the most prominent appearance of
the work’ stitle, preceding the beginning of the body of the text.

A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ or
contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for
a specific section name mentioned below, such as "Acknowledgements", "Dedications",
"Endorsements", or "History".) To "Preserve the Title" of such a section when you modify the Document
means that it remains a section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License
applies to the Document. These Warranty Disclaimers are considered to be included by reference in this
License, but only as regards disclaiming warranties: any other implication that these Warranty
Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to the
Document are reproduced in all copies, and that you add no other conditions whatsoever to those of
this License. You may not use technical measures to obstruct or control the reading or further copying of
the copies you make or distribute. However, you may accept compensation in exchange for copies. If
you distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY
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If you publish printed copies (or copies in media that commonly have printed covers) of the Document,
numbering more than 100, and the Document’ s license notice requires Cover Texts, you must enclose
the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front
cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as
the publisher of these copies. The front cover must present the full title with all words of the title equally
prominent and visible. You may add other material on the covers in addition. Copying with changes
limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can
be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each
Opaque copy a computer-network location from which the general network-using public has access to
download using public-standard network protocols a complete Transparent copy of the Document, free
of added material. If you use the latter option, you must take reasonably prudent steps, when you begin
distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
accessible at the stated location until at least one year after the last time you distribute an Opaque copy
(directly or through your agents or retailers) of that edition to the public.

Itis requested, but not required, that you contact the authors of the Document well before redistributing
any large number of copies, to give them a chance to provide you with an updated version of the
Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and
3 above, provided that you release the Modified Version under precisely this License, with the Modified
Version filling the role of the Document, thus licensing distribution and modification of the Modified
Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from
those of previous versions (which should, if there were any, be listed in the History section of the
Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the
modifications in the Modified Version, together with at least five of the principal authors of the
Document (all of its principal authors, if it has fewer than five), unless they release you from this
requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.
D. Preserve all the copyright notices of the Document.
E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to use
the Modified Version under the terms of this License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in
the Document’ s license notice.
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H. Include an unaltered copy of this License.

l. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least the
title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is
no section Entitled "History" in the Document, create one stating the title, year, authors, and
publisher of the Document as given on its Title Page, then add an item describing the Modified
Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy
of the Document, and likewise the network locations given in the Document for previous versions it
was based on. These may be placed in the "History" section. You may omit a network location for a
work that was published at least four years before the Document itself, or if the original publisher of
the version it refers to gives permission.

K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the section,
and preserve in the section all the substance and tone of each of the contributor acknowledgements
and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled "Endorsements". Such a section may not be included in the Modified
Version.

N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with any
Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some or
all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’ s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains nothing but endorsements of your
Modified Version by various parties—for example, statements of peer review or that the text has been
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a
Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-
Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any one
entity. If the Document already includes a cover text for the same cover, previously added by you or by
arrangement made by the same entity you are acting on behalf of, you may not add another; but you
may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their
names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of
your combined work in its license notice, and that you preserve all their Warranty Disclaimers.
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The combined work need only contain one copy of this License, and multiple identical Invariant Sections
may be replaced with a single copy. If there are multiple Invariant Sections with the same name but
different contents, make the title of each such section unique by adding at the end of it, in parentheses,
the name of the original author or publisher of that section if known, or else a unique number. Make the
same adjustment to the section titles in the list of Invariant Sections in the license notice of the
combined work.

In the combination, you must combine any sections Entitled "History" in the various original documents,
forming one section Entitled "History"; likewise combine any sections Entitled "Acknowledgements",
and any sections Entitled "Dedications". You must delete all sections Entitled "Endorsements".

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this
License, and replace the individual copies of this License in the various documents with a single copy
that is included in the collection, provided that you follow the rules of this License for verbatim copying
of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or
works, in or on a volume of a storage or distribution medium, is called an "aggregate" if the copyright
resulting from the compilation is not used to limit the legal rights of the compilation’ s users beyond
what the individual works permit. When the Document is included in an aggregate, this License does not
apply to the other works in the aggregate which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the
Document is less than one half of the entire aggregate, the Document’ s Cover Texts may be placed on
covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole
aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document
under the terms of section 4. Replacing Invariant Sections with translations requires special permission
from their copyright holders, but you may include translations of some or all Invariant Sections in
addition to the original versions of these Invariant Sections. You may include a translation of this
License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you
also include the original English version of this License and the original versions of those notices and
disclaimers. In case of a disagreement between the translation and the original version of this License or
a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", the
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.
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9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for
under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void,
and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such
parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation
License from time to time. Such new versions will be similar in spirit to the present version, but may

differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a
particular numbered version of this License "or any later version" applies to it, you have the option of
following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

ADDENDUM: How to use this License for your documents

Copyright (c) YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.2
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".
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